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Tutorial Disclaimer !

Disclaimer

All milling devices (whether or not Numerically Controlled) are dangerous
devices: when working with a milling machine it is possible to damage either
the workpiece or the machine, or even to injure yourself. So do take care, and
always check your toolpaths before sending them to the machine - in case you
are a novice user have an experienced friend or colleague check them.

Delft Spline Systems, the software distributor, the dealer or any other
intermediate party are in no way responsible for any damage or injury, direct or
consequential, relating to the use of this software.

DeskProto ® is a registered trademark of Delft Spline Systems.
Windows ® is a registered trademark of Microsoft Corporation.
MacOS ® is a registered trademark of Apple Inc.

Linux ® is a registered trademark of Linus Torvalds.

All other trademarks are owned by their respective owners.
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Licenses and Copyrights

DeskProto is protected by copyright law. Unauthorized reproduction or
distribution of this program is prohibited.
Copyright © 1995-2024, Delft Spline Systems

DeskProto uses the following external libraries:

The Boost C++ libraries.

Copyright © 1998-2005, Beman Dawes, David Abrahams,
Copyright © 2004-2007, Rene Rivera.

Used and distributed under the Boost Software License V1.0.

Www.boost.org

The Clipper library for clipping and offsetting lines and polygons
Copyright © 1995-2013, Angus Johnson

Used and distributed under the Boost Software License V1.0.
http://www.angusj.com/delphi/clipper.php

The Crypto++ library of cryptographic algorithms
Copyright © 2010-2013, Wei Dai
Used and distributed under the Boost Software License V1.0.

WWWw.Cryptopp.com

The HIDAPI library for communication with HID devices.
Copyright © 2009, Alan Ott, Signal 11 Software,

used and distributed under the HIDAPI license.
github.com/signal11/hidapi

The Minizip library for reading and writing ZIP archives.
Copyright © 2017, Nathan Moinvaziri

used and distributed under the Minizip license.
github.com/nmoinvaz/minizip

The QT cross-platform application framework.
Copyright © 2016, The QT Company Ltd. and other contributors
used and distributed under the GNU Lesser General Public License (LGPLv3).

www.at.io

The complete license texts for all these libraries can be found in the DeskProto
About box.
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Tutorial Essentials

Essentials

What does DeskProto offer

DeskProto is a CAM program (Computer Aided Manufacturing) for 3-axis, 4-
axis and 5-axis CNC milling machines, offering Desktop Prototyping.
DeskProto will allow you to machine 2D vector drawings, 3D geometries and
3D reliefs based on photos. It can be used for product design, jewelry,
woodworking, medical applications, arts, education, hobby, etc. DeskProto can
be combined with any CAD program, and with any CNC milling machine.

Four different editions of DeskProto are available: Free, Entry, Expert and
Multi-Axis, offering different (sub)sets of DeskProto’s functionality. An
edition comparison table can be found on www.deskproto.com

How does it work

The starting point for DeskProto is a CAD file (it is not possible to design in
DeskProto: CAM is about calculating toolpaths). Three types of CAD data are
supported, each with a slightly different workflow:

Vector-data: 2D drawing containing lines and arcs, stored as DXF, Al, EPS or
SVG file.

Geometry-data: 3D geometry defined as a collection of triangles (facets) that
describe its outer surface (polygon data), stored as STL, 3MF or DXF file.
Bitmap-data: 2D image containing colored pixels, stored as BMP, JPG, GIF,
PNG or TIF file.

So in fact DeskProto offers three CAM programs for the price of one !

DeskProto will load the CAD file and display its contents. It is possible to load
more than one file. At this point you can scale, translate, rotate etc. After
entering some milling parameters (cutting tool, required accuracy, etc)
DeskProto will calculate the toolpaths. Next you can check the toolpaths using
an Animation and/or a Simulation. Finally save them in an NC file. Send this
NC file to your CNC milling machine and you will have your part ready within
a short time.

What hardware/software is needed

DeskProto V8.0 is available for Microsoft Windows, for Apple MacOS and for
Linux:
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For Windows it needs the 64 bits version of Win10, Win11 or newer.
Minimum required hardware: 4 GB RAM and 100 GB free disk space:
faster/more is better. The graphics card needs to support OpenGL V2.1 or
newer.

Special builds for Win7 and for WinXP (SP3, 32 bits) are available on request.

For MacOS (Apple) it needs Catalina (10.15) or newer. DeskProto for MacOS
always is 64 bits. Here as well minimum hardware requirement is 4 GB RAM
and 100 GB free disk space: faster/more is better.

For Linux it has been developed and tested using Ubuntu 20.04 (64 bits), still
it will also work on most other popular Linux distributions. Only the 64 bits
versions are supported. Here as well minimum hardware requirement is 4 GB
RAM and 100 GB free disk space: faster/more is better.

Most screenshots in this Tutorial have been made using Windows, still for
MacOS users and for Linux users these images will be completely clear as all
screens are very similar for all three operating systems.
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Installation
Windows: Setup file

DeskProto Version 8 runs in MS Windows 10, 11 or newer. Email us to obtain
a Setup for Win 7 or for Win XP (SP3, 32 bits). Minimum required hardware is
a PC with 4 GB RAM: faster/more is better. The use of an OpenGL (V2.1 or
better) compatible 3D graphics card is required. For installation you need
about 150 Mb of free disk space, to use DeskProto you need much more for the
NC program files that you will create.

You can download the DeskProto Setup file from www.deskproto.com and
start that file. Or, in case you have a CD, insert the CD and the Install Menu
will be automatically displayed: choose “Install DeskProto” to start Setup.

DeskProto Setup Language Selection x

[d] Select the language to use for the DeskProto
installation.

After pressing Yes on the security warning (or after entering an admin
password), the Setup will first ask you which language you want to use for the
Setup. That same language will be set for DeskProto (which can later be
changed in the Preferences). After selecting a language the Setup will start:

5! Setup - DeskProto 2.0 (64 bit) 2 X

CNC machining
. for non-machinists:

gctor/Geometry/Bitmap

Delft Spline Systems

https: {fwww.deskproto.com
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Now just follow the instructions given:

»  accept the license agreement
read the welcome information
confirm the installation folder
confirm the start menu folder
select which icons you want
and Install.

A new shortcut called DeskProto will be created on the desktop (unless of
course you unchecked that option), and the necessary files will automatically
be copied to your hard disk. Also the commands DeskProto, DeskProto help-
file and DeskProto uninstall will be added to the list of Programs that can be
accessed via the Windows Start menu.

When downloading DeskProto from the DeskProto website some browsers will
start installing immediately, while other browsers will first save the Setup file
on your hard disk. The DeskProto Setup program is called “DeskProto80.exe”.
It can be started just as any other Windows program.

When you have ordered DeskProto on CD you can simply insert the CD into
your PC: a program called the DeskProto Install Menu will automatically start.
In case that does not happen you can locate the file Setup.exe on the CD and
manually start it. Note that the name of the Setup program on CD is not the
same as the name of the downloaded program.

MacOS: DMG file

DeskProto Version 8 runs in MacOS 10.15 (Catalina) or newer (for Windows
users: MacOS is the software that runs on Apple computers). DeskProto for
MacOS always is 64 bits. Minimum hardware requirement is 4 GB RAM and
100 GB free disk space: faster/more is better.

The file to download is a DMG file. This is an Apple Disk iMaGe file: a read-
only file that can be mounted as a disk. You can see it as a ‘virtual CD’. It is a
standard way to distribute MacOS apps. The file that you download is called
“DeskProto80.dmg*“.

You can mount the DMG by double-clicking it. The dialog that then will pop
up shows the license agreement for DeskProto. When you agree with the
terms of this license you can click on button Agree and proceed. Now the
DMG file will be verified and opened. It will show the DeskProto80Installer
dialog:
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[ N [") DeskProto80Installer

Applications

to install

d

Installing DeskProto can be done by simply dragging the DeskProto icon (the
file DeskProto80.app, in some MacOS versions just called DeskProto80) into
your Applications folder. That is all: you can now start DeskProto from
Launchpad, like you would any other app.

“DeskProto” is an app downloaded from the internet.

“ Are you sure you want to open it?

www.deskproto.com

? Cancel Show Web Page m

The first time that you start DeskProto a dialog will pop up that asks if you are
sure, as the app has been downloaded from the Internet. It confirms that the file
has been downloaded from www.deskproto.com, and that a valid Apple
Developer ID certificate has been found (if not a warning message would have
been shown).

"® @ DeskProto Language Selection

I), Please select your preferred language:

. ™ B
0 (This can be changed later in the Preferences.)

The next dialog will also only be shown the first time that you start DeskProto:
here you can select which language DeskProto has to use. In case you later
want to change it: you can find the language setting in the Preferences.

Linux: Applmage file

DeskProto Version 7 has been developed and tested using Ubuntu 20.04 (64
bits), still it will also work on most other popular Linux distributions. Only the
64 bits versions are supported. Here as well minimum hardware requirement is
4 GB RAM and 100 GB free disk space: faster/more is better.
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The file to download is an Applmage file. This format is widely used for
distributing Linux software as it is very easy to use: simply double-click this
file to start the application. What happens (invisible for the user) is that the
Applmage will be unpacked to a temporary location, from where the
application is started. Similar to mounting a disk. The file that you download
is called “DeskProto80.AppImage*.

DeskProto80.Appimage Properties X

Permissions
owner: Me
Access: Read and write -
Group: build -
Access: Read-only -
Others
Access: Read-only -
Execute: Allow executing file as program
Security context: unknown

Important is that starting the application is possible only after you have
changed the file’s properties (right-click the file and select “Properties” to open
a dialog like shown above). On tab Permissions of this dialog you need to
check the option to Allow executing the file as a program.

DeskProto Language Selection ()
1)] Please select your preferred language:
4 English -
Desk

_Pnim (This can be changed later in the Preferences.)
‘ .

When you first start DeskProto in Linux the Language Selection dialog, where
you can choose which language to use, will be shown next. In case you later
want to change it: you can find the language setting in the Preferences.

After selecting the license DeskProto will show the license agreement: you
need to check “I accept the agreement” before you can press OK to proceed.

Page 12



Tutorial Installation [g o)

Running DeskProto

The first time that you start DeskProto it will complete the installation by
asking you which CNC milling machine you will be using, which units and
which type of projects.

Please choose one of the machines shown below

150 plain G-codes - mm

Before you can actually use DeskProta, you should first select a default
machine. In case your machine is not in the list, press the Help button for mare
information.

Please choose a measurement unit

® mm
O inch

\Which praject type do you want as your default project?
() Vector: most of my projects will use 20 files (DXF/SVG/EPS/AT)
(®) Geometry: most of my projects will use 3D files (STL/3MF/DXF)
() Bitmap: most of my projects will use image files (BMP/IPG PNG/TIF /GIF)

Select the correct machine (the one you have) in the drop-down list: it will be
the default machine that DeskProto will use for all your projects. If needed this
setting can later be changed in the default Project parameters (Options menu).

If your machine is not listed, in most cases the machine called “ISO plain G-
codes” (-inch or -mm) will be the best choice. You may later define your own
Machine in the Library of machines (Options menu). Press the Help button for
more information on which machine to select (or read the Reference Manual).

The units that you select here will be used for the CAD-data file import and
for the user-interface. These are the units as set in the Preferences.

Units can be set on a second location as well: the units in the NC files that
DeskProto writes are set in the postprocessor for that machine (the
postprocessor is the software module that translates the output to the format
needed by your machine, so a sort of Driver). Check the Help file for more
information about the Units settings in DeskProto.
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For each type of CAD-data (\Vector, Geometry and Bitmap) different settings
are required, so DeskProto features vector operations, geometry operations and
bitmap operations. The default project type defines which operation will be
loaded when creating a new project. As you can add and delete operations any
time this is not a critical decision. If needed this setting can later be changed in
the default Part parameters (Options menu).

Yesk Progos

Select the edition you want to start
@ Free Edition
offers basic functionality, for 1 part and 1 operation
O Entry Edition - in trial mode
mukiple pars and operations, seughing, pocketing, drilling, v-carving
O Expert Edition - in trial mode
offers all 3-axs options, inchuding many strategies
(0 Multi-Axis Edition - in trial mode
also offers support for 4-mo0s and S-mws machines

‘fou may start the Free Edition, or start one of the paid editions in
trial mode (a cross will then be visible as watermark).

By T

The trial cross watermark
can be removed by buying a license.

‘fou will then receive a key that
you can enter in the activation dialog.

After these initial settings you will have DeskProto running on your PC. In the
Edition select dialog (shown above) you can choose which edition you want to
start. You can immediately start using the Free Edition, which offers basic
CAM functionality, without having to buy a license.

More functionality is available in the other three editions, for which a paid
license is required. On the DeskProto website you can find a Comparison table
that shows the exact capabilities of each Edition. For users without a license
these higher editions are available in Trial mode: this means that both on the
screen and in the NC toolpaths the Trial cross watermark will be visible.

When you have bought a DeskProto license you will have an unlocking code
that you can use to remove this trial cross. In the dialog Activate License
(Windows and Linux: Help menu, MacOS: DeskProto menu) you need to enter
the Name and the Key on the license. Exactly as specified: enter the Name
with capitals, spaces and comma exactly as shown on the license.
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Files and Folders (Windows)

Long time ago DeskProto used to store all files within one directory structure,
clearly sorted in sub-folders. Unfortunately in current versions of Windows
that is no longer possible, due to the severe security rules by the Windows
‘User Account Control” (UAC). Drivers and user data no longer may be stored
on the same file-location as the program file.

& Windows (C:)
Intel
Program Files
Commen Files

v DeskProto 8.0

Licenses
SpaceMouse

I assistant.exe

[ D3Dcompiler_47.dll

12 DeskProto.exe

[T b ennf

5] msvep140.di

e 1] msvep140_1.dil Application exten
HelpLanguage 4] msvep140_2.di Application exten...
Language [] openglz2sw.di Application exten...

CONE

[4] [} = | DeskProto 8.0 - O *
Home  Share  View (7]
4 N cut e s ) - Y Oper [H setect an
=] Moveto~ ¥ Delete = v
- = £ Select none
PintoQuick Copy Paste Copyto Properties =
ma:;gsn:wc py  Pa: i Copy to L History G invert selection
Clipboard Organise New Open Select
& ~ 4 | » Windows(C) > ProgramFiles > DeskProto 80 > @ Search DeskProto 8.0
A o Size A
B This PC Name Date modified Size
[ Desktop Bin
5] Documents Helplanguage
¥ Downloads Langliage

42 items

By default DeskProto V8.0 stores its files in the these directories (folders):
\Program Files\

\Program Files\DeskProto 8.0

This folder contains the file of DeskProto.exe, a large humber of DLL files
(program components) and other files that are used by DeskProto: see the
image above.

\Program Files\DeskProto 8.0\Bin

More program components that DeskProto needs

\Program Files\DeskProto 8.0\HelpLanguage

Files that are needed for a translated Help system (assistant.exe)

\Program Files\DeskProto 8.0\Language

This folder is used for all elements in the user interface that can be translated
(resources, help, license, readme, etc — except the Help system), and thus
contains a sub-folder for each language.

Each language needs one main resource file to be present in this folder, after
which in the DeskProto Preferences the new language can be selected. For
instance for German a folder de is needed with resource file file
DeskProto_de.qm (a gm file is a Qt resource file). All other files in this folder
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are optional, as for these DeskProto will default to English in case not found.
\Program Files\DeskProto 8.0\Licenses

This folder contains the licenses for all external libraries that DeskProto uses.
\Program Files\DeskProto 8.0\SpaceMouse

Files needed for the 3Dconnexion SpaceMouse.

\ProgramDatal\

\ProgramData\DeskProto 8.0\CustomWizards

This folder contains all files for the Custom Wizards, see the Reference manual
(on your CD and on the DeskProto website) for more information. The
‘normal’ wizards are included in the main program.

\ProgramData\DeskProto 8.0\Drivers

For making an NC program that is suitable for your milling machine,
DeskProto needs information about the correct machine, the postprocessor and
the available cutters. This information is present in the driver files (*.MCH for
the machines, *.PPR for the postprocessors and *.CTR for the cutters), stored
in this drivers folder.

\ProgramData\DeskProto 8.0\Samples

For novice users each DeskProto comes with a number of sample files, also
used for the lessons in this Tutorial. This concerns DeskProto Project files
(*.DPJ), 3D Geometry files (*.STL), 2D and 3D Vector files (*.DXF) and a
few sample bitmap files.

\ProgramData\DeskProto 8.0\Scripts

This folder contains all Scripts, see the Reference manual (on your CD and on
the DeskProto website) for more information.

\ProgramData\DeskProto 8.0\Supports

This folder contains STL files for the Geometry support tabs, see the Reference
manual (on your CD and on the DeskProto website) for more information.

The folder \ProgramData\ also is located in the root (so as C:\ProgramData\).
Strangely this folder is invisible as default. To make the folder visible you need
to select an option in File Explorer:

Win8, 10, 11: in the View ribbon, section Show/hide, check “Hidden items”
Win7: button Organize >> Folder and search options >> tab View >> select
“Show hidden files, folders and drives”.

WinXP: Tools >> Folder options >> tab View >> select “Show hidden files
and directories”. In WinXP the folder has a different name and location:
C:\Documents and Settings\All Users\Application Data\

Documents

This is the default DeskProto Data folder: it will be used for all CAD-data
Load and Save commands and also for project files and the NC program files
that you produce (in WinXP this folder is called My Documents). It is advised
to create a folder structure here, for instance with a new folder for each new
client or for each new project.
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Some of the file locations are user-configurable:

"
DP preferences *

General Units Colors NC Output Wizard Advanced

File locations

Data |C:\J..lsers\XX>Ot.\Documenis | Browse...

[ Fill with last used folder on exit

Drivers |C:\Pr0gramDaiB\.DeskProho 8.0'Drivers | Browse...

Use DeskProto Defaults

Available languages

English ~

Updates
Chedk for updates when exiting the program

cons | [ e

The file locations for Data and for Drivers can be defined in the DeskProto
Preferences (Options menu), see the illustration above. The button “Use
DeskProto Defaults” can be used to reset these locations.

Following Microsoft's guidelines DeskProto stores all Preferences in the
Registry.

Files and Folders (MacOS)

The file DeskProto.app that you have dragged to your Applications folder is in
fact a folder structure, containing both the program and a number of folders
(for drivers, samples and much more). As application files are read-only it is
needed to copy a number of these folders to a different location: DeskProto
will do this automatically for you.

DeskProto V8.0 stores its files in the these folders:

~/Library/Application Support/Delft Spline Systems/DeskProto/8.0/

Here you can find the folders Drivers, Languages, Licenses, Samples, Scripts
and Supports, the purpose of each folder has been explained in the Windows
section above. A folder *‘CustomWizards’ is not present as custom wizards are
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not supported in the MacOS version.

The DeskProto Preferences are stored in file
~/Library/Preferences/com.delft-spline-systems.DeskProto.plist

Note that a file called
~/Library/Preferences/com.delft-spline-systems.DeskProto80.plist

is present as well. That is a different file, automatically created by MacOS to
remember the settings for the Open file dialog and the Save file dialog.

And the default folder for all user Data is
~/Documents/

The folder ~/Library/ (used in the first two locations just mentioned) is a
hidden folder in MacOS. So when you open Finder and show your Home
folder, the folder Library will not be present. To make it visible you need to
hold down three keyboard keys at the same time: Cmd + Shift + . (dot): then
all hidden files and folders will become visible.

The file locations for Data and for Drivers can be set in the DeskProto
Preferences (DeskProto menu), see the screenshot in the paragraph on
Windows. The button “Use DeskProto Defaults” can be used to reset these
locations.

In the above folder specifications “~/” stands for your home folder.

This is in fact folder /Users/username/ - for instance /Users/john/ for user
john. As a result changes that you make in these folders (like adding a new
cutter) can be seen only by the current user. The license activation as well
(stored in the Preferences) will only work for the current user. This is not a
problem, still it is good to know that here the MacOS version differs from the
Windows version (where the license activation and changes in the drivers are
valid for all users).

Files and Folders (Linux)

As the Applmage file that you used to start DeskProto is read-only it is needed
to copy a number of files and folders to a different location, in order to store
your settings, Preferences, cutter definitions, etc. DeskProto will do this
automatically for you.

DeskProto V8.0 stores its files in the these folders:

~/.local/share/Delft Spline Systems/DeskProto/8.0/

Here you can find the folders Drivers, Languages, Licenses, Samples, Scripts
and Supports, the purpose of each folder has been explained in the Windows
section above. A folder *CustomWizards’ is not present as custom wizards are
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not supported in the Linux version.
The DeskProto Preferences are stored in file
~/.config/Delft Spline Systems/DeskProto.conf

And the default folder for all user Data is
~/Documents/

In Linux all files and folders that start with a . (like .local and .config above)
are hidden, so will not be visible when you view your Home folder in File
manager. They can be made visible by pressing Ctrl + H on your keyboard, or
by checking “Show hidden files” in the File manager menu.

The file locations for Data and for Drivers can be set in the DeskProto
Preferences (DeskProto menu), see the screenshot in the paragraph on
Windows. The button “Use DeskProto Defaults” can be used to reset these
locations.

In the above folder specifications “~/” stands for your home folder.

This is in fact folder /home/username/ - for instance /home/john/ for user
john. As a result changes that you make in these folders (like adding a new
cutter) can be seen only by the current user. The license activation as well
(stored in the Preferences) will only work for the current user. This is not a
problem, still it is good to know that here the Linux version differs from the
Windows version (where the license activation and changes in the drivers are
valid for all users).
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Quick Start

The function of this Tutorial is to step by step introduce you to the functions
that DeskProto offers. It is recommended to read and execute at least one of
the lessons 1 to 4 before starting to make models with your own CAD-data.

However, if you are not a great manual reader and want to start exploring
DeskProto at once, at least first read this Quick Start. It is meant to explain the
basic ideas of DeskProto, and you will need this information to be able to
understand what is happening.

DO Untitled - DeskProto 8.0 - Dealer license: Not For Resale! - o x
Flle Edit View Parameters Create Options Help

I REBLEAE S0 1HE ®SPRRRBRT -
Project Tree 4
5 Untitled

v Ak Part Red arrows: start and end of toolpath
. % Geometry operation 3

< 2 ined
Grey dashed lines:_— achi

e m
4 el . area to b
rapid positioning moves Green

Workpiece zero point.
Red lines:
he toolpaths

NC Fles -

Name Date 2 g
= - Purple lines:

toolpaths at reduced d
‘ View orientator oolpaihsatreducad spes

For telp, pressF1 Cutter: Ball nose, radius 3 = demeter 6 mm Precision: 0.67/0.35

< >

The DeskProto screen contains standard items like the title bar (top line), menu
bar, toolbar (the row of buttons below the menu) and status bar (bottom line).
The center area is divided into three tiles: the large View window on the right,
and the windows Project Tree and NC files on the left. All these elements will
be explained later on in this Tutorial. You can always use the Help function for
extra information on any part of the screen.

The above screenshot shows the Windows version of DeskProto. The MacOS
version has an extra menu choice: the DeskProto menu, on the left side of File.
In MacOS the menu is visible on the top of the screen, so not in the DeskProto
window. This is conform the MacOS standard and won’t confuse any Apple
user.
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The DeskProto menu in Linux is identical to the menu in Windows. In most
cases it is part of the DeskProto window, though some Linux versions allow
the menu to be shown at the top of the screen.

For now it is important to know that in DeskProto two different user-interfaces
exist: the wizard-based interface and the dialog-based interface.

D2 What to machine? X

A AR R RN

[2] Geometry fie:

iC: \ProgramData'DeskProto 8.0Y5amples'\Bottle. st || Browse. ..
[?] scaling:

:

= (@) Scale factors

T | LU

(_) Dimensions {mm)

Z |18

Uniform
E Orientation - indicate the top surface:

% degrees ® Top

O Front
O Bottom
Apply Hext = Cancel Help

New users are advised to use the DeskProto Wizards, as these will guide them
through all the steps needed to generate an NC toolpath file using their own
CAD-data. The illustration above shows a typical wizard page.

A wizard will set the same parameters as available in the dialogs, only now
they are presented in a sequential series of screens, and only the most
important parameters are shown. You can find the wizards on the Start Screen
or via the File menu, for more information see lessons 1A, 2A and 3A.
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When using the Dialog-based interface you need to know where to find the
parameters. In DeskProto you can define parameters on three levels:

1. Project parameters include the name of the CAD-data file(s), the machine
and the number of Parts that you want to use in this project.

2. Part parameters define What will be machined. They set the size,
orientation, position and alike. Within each Part you can define one or more
milling Operations.

3. Operation parameters define How it will be machined.

These are in fact the only real 'milling parameters'. Three different types of
operation are available: Vector Operation, Geometry Operation and Bitmap
Operation, as for these three types of data different settings are needed.

The Project is the central concept of DeskProto. All information about a
project is stored in a Project file (*.dpj), which is the file to be opened when
starting and to be saved when finishing. The project file contains all milling
parameters and viewing parameters, and also contains references to the CAD-
files (so the CAD-data is not included!).

¥ Untitled - DeskProto 8.0 - Dealer license: Mot For Resale!

File Edit View Parameters Create Options Help

| IV N §ADES’

Project Tree

DeskProto sample project

v, 4} Half bottle
¥ fa Roughing

. %= Finishing

¥ o Contour (not in En...

You can imagine the tree-like structure of a project, which is displayed in the
Project Tree at the left side of the DeskProto screen: see the figure above. This
sample Project “Bottle” consists of one Part called “Half bottle” and three
Geometry Operations called “Roughing”, “Finishing” and “Contour”. Each
operation line includes a lamp icon that you can switch on and off to make the
operation (in)visible. The project will be named when saving it for the first

time, until then the tree displays the name “Untitled”.

Note 1: four different editions of DeskProto are available: Free, Entry, Expert
and Multi-axis. The editions Free, Entry and Expert contain subsets of the
available Part and Operation parameters. Free and Entry also do not offer
Custom wizards and Scripts, and the Free edition is limited to using one part
and one operation in a project.

Note 2: to open a CAD-file in DeskProto you have to use "Load Vector file..."
"Load Geometry file..." or "Load Bitmap file..." in the File menu (if needed
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start a New project first). You cannot use File>Open, as you do not yet have a
DeskProto project file for this new project. The CAD-data that you load will be
available for all Parts and for all Operations in the project.

All functions in DeskProto can be reached using the menu or using the buttons
on the toolbar. The most important menus are described below:

* The View Menu offers the opportunity to change the way you look at the
geometry. Also try changing your view by rotating the six colored thumb-
wheels on the screen, and by using your mouse inside the view window. Most
of the functions in the View menu can also be activated using the toolbar.

* In the Parameters Menu you can edit all vector/geometry/bitmap
parameters and milling parameters. For a simple part it is sufficient to edit only
a few Tab pages for both Part and Operation parameters: the other Tabs can
come later (as all parameters have suitable default values).

* The Create Menu is the most important; this is where you can start the
milling calculations and write the NC program file.

The most important buttons for the DeskProto process are:
( The first step is to Load CAD data:
&» g Vector, Geometry or Bitmap (or a combination).

After setting some parameters you can then
Calculate the toolpaths and view them on the
screen.

The Simulation offers a preview of what the
./" part will look like, the Animation shows how
the cutter will move.

Finally you Write the NC file and send it to
your machine.

I8 S e

We hope you will enjoy using this software!
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1. Beer tray (vector: basic)
Lesson One

In this first lesson the most elementary functions of DeskProto will be
explained: you will learn about the DeskProto user-interface and its main
functions. You will create toolpaths based on a 2D drawing and create an NC
file, ready to be sent to the milling machine. The lesson will be presented
twice: first using the Wizard ‘Basic Vector machining’ and next using the
Dialog-based interface.

This lesson is for all DeskProto editions (though in the Free edition the text on
the tray will be skipped). When you have bought a DeskProto license you can
also start with Lesson 4, as (just as this beer tray) the V-carving project in that
lesson is a great way to start using DeskProto.

The CAD-data for this project is a 2D drawing, so a drawing that does not
contain any Z-values. The drawing contains only lines and arcs (vector
information), saved in a DXF file. It contains the design of a Beer Tray: one
outer contour with seven round holes and (optional) a text to be engraved. The
tray can of course also be used for coffee @).

Follow this lesson either using this beer tray file or using your own drawing,
and/or replace the text in the sample DXF file by your own text. With a custom
text this tray makes a really nice personalized gift !
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Start DeskProto

After starting DeskProto will first show the Edition select dialog (only when
running the free edition or using a dealer license) and next the Start screen.
Note that the Start screen is an optional window: uncheck the check-box to
make DeskProto skip this screen.

This is a DeskProto 8.0 Multi-Axis Edition
Licensed to: Delft Spline Systems, Utrecht
Dealer license:  Not For Resale!

Start new project Open existing project Other tasks

Use wizard Open project Open sample ect
Use dialogs: Recent projects: Visit website:

Vector project (2D} C:\ProgramD. .. rotol:
Geometry project {3D) C:\ProgramDat. .. \DpBeerTray.dpi
Bitmap project {relie C:\ProgramData'Desk. .. \Bottle. dpj

Read tutorial (web)
View tutorial videos (web)
Visit user forum {web)

C:\Program. .. \DpPictureFrame.dpj
0:\Projektien. .. \BBtoken-DP8. dpj

[] Use samples folder
&

A new project (left side of the start screen) can be started in two ways: using a
wizard and using dialogs. This shows that DeskProto offers two different user-
interfaces: Wizard-based and Dialog-based.

For novice users the Wizard interface is most important, as the Wizards will
step-by-step guide you along all actions needed to create an NC file in
DeskProto. All settings offered by the Wizards are also possible in the 'normal’
dialog-based user-interface.

In this first Tutorial lesson we will explain both interfaces: the Wizard-based in
Lesson 1A and the Dialog-based in Lesson 1B.

To now start Lesson 1A, in section ‘Start new project’ of the Start Screen
check Use samples folder and then select the option Use wizard.
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Lesson 1A

The Beer tray, wizard interface

You have just selected Use Wizard, either in the DeskProto Start Screen or in
the File menu. So you can now use the DeskProto Wizard interface, making
the program very easy to use for anyone without previous experience. We will
keep the Tutorial as short as possible, as the wizard should in fact be self
explanatory...

D2 Which Wizard? b

1
l‘a i
—
[2] Machine to be used:
150 plain G-o_odgs -mm ~

[?] Type of miling:

() Basic Vector machining (20)
() Basic Geometry machining (307
() Basic Bitmap machining (relief)

The Machine to be used should already be the correct machine, as you have set
your default machine when first starting DeskProto. If not correct you can
select a different machine here (in order to change the default machine you
need to open the Default Project parameters, via the Options menu).

A series of different wizards is available, each meant for a specific type of
milling. For the Beer tray we will use the first wizard: Basic \ector
machining, that is available in all Editions of DeskProto. So please select that
wizard and press Next.

D2 What to machine? X
2
- -

1_;_. Vector data file:

|I Browse...
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As you can see above: now the second icon in the dialog becomes active
(enlarged and underlined in red): you are on the second page of this wizard.
These icons can be used as navigation tabs: you can click on any of the colored
icons (except page 1) to directly go to that wizard page. Most forward jumps
are not possible though (gray icons), as you cannot skip any of the wizard's
pages.

On this second page you first need to browse a Vector data file. As you started
with option “Use samples folder” checked, the Browse button should directly
look in the DeskProto Samples folder: select file 2D_DpBeerTray.dxf and press
Open.

Note for INCH users: The file just mentioned is in mm, for a material slab of
400x200 mm. When loaded in your inch DeskProto this will be a slab of
400x200 inches: way too large. When you work in inches you need to select the
inch version of this file, called 2D_DpBeerTray_inch.dxf.

In case you do not see the Samples folder: you can find it in folder
\ProgramData\DeskProto 8.0\Samples\ (for more information and for MacOS
and Linux see the earlier paragraph about Files and Folders).

After opening the 2D_DpBeerTray file it will be drawn on your screen, see the
image above. All vector information in gray, in orange (added on the next
wizard page) the material block, and two small cubes with axes which are
called Orientators.

This default material block is the exact bounding box of the vector-data, with a
thickness of 10 mm (or 0.5”). The green orientator shows the three axes: as you
can see the largest size of this design is along X. The blue orientator shows the
position of the workpiece zero point, more about that later.

In this lesson we will only deal the outer contour and the holes: this wizard
only offers “basic vector machining”. Engraving the text is a more advanced
step that will be explained in Lesson 1B.

This wizard page offers options to Scale and Rotate this 2D drawing. Scaling
to a smaller size may be needed when your machine is too small for this part.
Unfortunately the result probably then will also be too small to carry beer
glasses or coffee cups, so in that case you can better create your own drawing.
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Rotating can be useful if on your machine the Y-axis is the longest: then
rotating 90 degrees may make the tray fit inside the machining area. As this is
a 2D drawing you can only rotate round the Z-axis.

For more information on any of the settings that the wizard offers: position
your cursor over one of the yellow question marks to get an explanation: a
Wizard tooltip then will pop up.

Clamps

r’—‘—ZﬂL _r_ Block of material ﬂ

1
Block thickness Machining depth Working table of the machine

The last option on this page is an important one: the Z settings. Entering
incorrect Z-settings may result in damaging the working table of your machine.
By default the Z=0 is on the top of the block, and the machining depth thus
should not be more than the thickness of your material block (as illustrated
above). In case of doubt you can add an extra slab of material below the block
to protect the table: such slab is called the “wasteboard”.

The Machining depth to be set depends on the thickness of your block. We
will for instance be using a sheet of 6 mm thick plywood (1/4”), and suggest a
depth of -5.9 mm (0.24”) leaving 0.1 mm (0.01”) clearance above the working
table. In case you use a wasteboard the machining depth can be equal to the
block thickness (or even a bit more). Be aware that the depth needs to be
entered with a minus sign, as it is a Z-value below zero.

The Free movement height is the Z-level that will be used for positioning
movements (traveling from the first contour line to the second, etc). You can
imagine this milling operation as an (ancient) pen-plotter: the free movement
height being the pen-up level for positioning movements, and the machining
depth being the pen-down level, with the pen touching the paper to draw a line.

After entering these Z-values you can press the Next button to proceed to the
third page of this wizard, called Material.

The default block size as said is the bounding box of your drawing. While such
block will reduce waste to an absolute minimum, our advise is to use a bit
larger block size, as that will add room for some clamps on both sides of the
part. The bounding box of the vector data is 360 x 220 mm (14 x 9 inches), and
the actual block that we want to use is 400 x 250 mm, 6 mm thick (16 x 10
inches, 0.25” thick).

Set the Dimensions of material block to Custom, and enter the correct
dimensions for X, Y and Z. We entered 400, 250 and 6 mm (16, 10, 0.25”) for
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our sheet of plywood.

When you now press the Apply button on this wizard page you will see that the
drawing has been updated to show the new block size. The beer tray is nicely
positioned in the center of the block, leaving ample room for clamps on both
sides. Using the Apply button by the way is not needed: the Next button will
automatically apply your settings as well.

For the Workpiece zero point we used the default choice: the front-left corner
of the block (so all curves will only have positive X and Y coordinates). If you
prefer you can use one of the other options (not available in the Free edition
and the Entry edition), like the center of the block. In fact it does not matter
what you select here, as long as you use the same location to set the zero point
on the machine (more about that later). For the Z no options are available: in
vector machining the Z=0.0 always is at the top of the block.

Pressing next will take you to the fourth page of this wizard, called Milling.
Here you can set the actual milling parameters and estimate how long it will
take to machine the part.

Select a suitable Cutter from the list (drop-down menu). Suitable for this
project would be an end-mill, so a cutter with a flat tip. The size must be
logical for this job: a diameter of say between 1/3 of the material thickness and
the full thickness would be nice. This is not critical though, and will also
depend on which cutters you have available. When you cannot find your cutter
in the list you can easily create a new cutter definition: press button Cutter
library, OK on warning, button Add, enter all relevant data. Use the Help
button for Help. We have used the default cutter (Flat tip, diameter 6 mm or
1/4” for inch users).

Two different Speeds can be set:

The Feedrate is the speed with which the cutter travels through the material.
For non-metals in most cases the default speed for your machine will be OK, in
case you are not sure: set a lower feedrate for the first job and try a higher
value later.
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The Spindlespeed is the rotation speed of the cutter. For many small machines
this cannot be set from the PC and therefore will have been grayed out in
DeskProto. If your machine accepts spindlespeed commands then here as well
the default will be a good value to start with.

In general: the smaller the cutter’s diameter, the higher the spindlespeed that is
needed to achieve the same actual cutting speed (the speed at which the cutting
edge moves through the material).

‘_;_' Toolpath type and Strategy:
(@ Profiing () Pocketing V-Carving

Outsideleft ~ Iﬁ ‘T

For vector machining the wizard offers three Toolpath types:

Profiling will make the cutter follow the curves in the drawing. In the Free
edition of DeskProto only Profiling is available.

Pocketing will make the cutter remove all material inside closed contours of
the drawing (this type will be used later in this lesson, for the text).

V-Carving also removes material inside closed contours, using a V-shaped
cutter that simply dives deeper then the groove to be machined is wider. This
type can be selected only when you first select such conical cutter (also called
a V-bit).

The fourth toolpath type, Drilling, is not available via the wizard.

For this beer tray we will apply Profiling: as the cutter will cut on (almost) full
depth there is no need to cover the complete area inside each circle as the
remaining material within the circles will fall out anyway.

So for Toolpath type select Profiling, and then in the Drop down menu select
strategy Outside/left. As a result the cutter will travel on the outside of the
outer contour, as shown by the icon image on the wizard page. The distance
between the line in the original drawing (gray) and the toolpath line (red) is
called the cutter radius compensation: a name that will be self-explanatory.

DeskProto is smart enough to realize that for all closed contours inside this
outline the cutter must travel on the other side of the contour-line (the inside).
So the 7 round holes in the tray will be machined exactly on the correct size.
When you press the button Calculate (bottom of the wizard page) you can see
the resulting toolpaths, displayed as red lines. Feel free to experiment with the
various settings to see what happens.

The wizard will apply these settings to all curves in the drawing: the outer
contour, the seven holes and also to the text. So DeskProto will also try to
machine the inside of each character (at full depth), which we do not want. In
most cases this will automatically be solved: your cutter will simply be too
thick to fit inside these contour lines, and thus they will be skipped. This is true
for our 6 mm cutter and also for a 5 mm cutter. Only for a diameter of 4 mm or
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smaller unwanted toolpaths will be added.

In case this happens (if not then ignore this paragraph):

After completing the wizard, open the Vector Operation parameters
by double-clicking that line in the tree, go to tab Profiling, and under
Select Curves select Custom instead of All (as set by the wizard).
Now use the button Select to select only the outer contour and the 7
circles: first click outside the part to de-select all, then with the Shift
button pressed click on each of these 8 curves. Light gray means not
selected, dark gray means selected). After pressing OK (twice) you
will see the updated toolpaths: again save these in an NC program
file (Create menu).

Support tabs are interruptions in the toolpath. At these locations not all
material will be removed, the remaining material acting as a bridge to keep the
part connected to the rest of the material block. This will prevent the part from
being damaged when completely cut loose. After finishing all toolpaths you
can take the block off the machine and manually remove all tabs. For this
project it is OK to use the Default tabs. Default tab size is twice the cutter
diameter, and default thickness is 50% of the material height. Default distance
between tabs is 20 times the cutter diameter.

Roughing (not available in the Free edition) may be needed when the block is
too thick for the cutter to remove all material at once. The solution is to use a
number of roughing layers: machine the same paths a number of times, each
time a bit deeper, until the prescribed depth has been achieved. So check Use
layers and next a custom Layer height. We used 3 mm (0.125”), for our 6 mm
(0.25”) thick material this resulted in 2 layers.

Yi, ® i : ¥
Support s__~tab

Again you can use the Calculate button to see the result. The estimated
machining time that is shown will automatically be updated as well. The red
lines are the toolpaths, and the dashed lines the positioning movements. The
image above shows toolpaths without roughing layers, for a better visibility of
the support tabs.

When you are running the Free edition and thus have a toolpath without
roughing layers, you can solve that by running the your one-layer toolpath
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several times, starting with the zero point on the machine set too high (above
the top of the block). You then create your own layers by varying the zero
point’s Z-position.

Once more pressing the Next button will open the 5" and last page of this
wizard, called Send to machine. As you already calculated and drew the
toolpaths it is not needed to press button Show toolpaths. Pressing would in
fact make the toolpaths invisible again, as this is a “toggle button”.

Button Show simulation will make DeskProto calculate and show a
simulation: a drawing of the resulting part after machining the toolpaths. The
material block, the grooves made by the cutter and the support tabs are clearly
visible, making it easy to check if this is indeed the desired part.

For some machines a button Send to machine is shown, to directly send the
toolpaths to the machine. It is available only on a few machine that support this
feature, after configuring this in the Preferences (see the Help file).

If all is OK one more thing needs to be done on this page: pressing button
Write NC-Program file will open a standard Save-As dialog where you can
enter the file-name. The file-extension that is shown (in “Save as type:*)
depends on which machine you have selected. Every machine manufacturer
prefers some different file format: this is the format suited for the machine that
you selected. After that press the Finish button to close the wizard.

From here you can either read the next half of this lesson, about how to use the
dialog-based interface, or jump to the paragraph called “To the milling
machine” at the end of this Chapter. The second half of this lesson will include
instructions to also machine the text on the beer tray.
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Lesson 1B

The Beer tray, dialog based interface

Start DeskProto (or restart it), in the Start Screen (see page 22) again check
Use samples folder and now select the option Vector project (one of the
options in 'Start new project’). This lesson will show you how to set all
parameters in the Dialog-based interface. Any setting made by the Wizards (as
in Lesson 1A) can also be made in this way.

Load the Vector file

drawing that you want to use. In most cases this will be a DXF file. In
DeskProto you can do so using the command Load vector file
(located in the File menu), or using the Load vector file button (the 4™ button
in the toolbar). The result will be a File-Open dialog in which you can browse
the DXF file (or Al, EPS, SVG) you want to use.

I@ The first thing you need to do for a new vector project is load the

As you selected 'Vector project' in the Start Screen, DeskProto will
automatically have opened this Vector-data File-Open dialog for you. Open
sample file 2D_DpBeerTray.dxf - or in case you work in inches file
2D_DpBeerTray_inch.dxf

You now need to set all parameters for this project, without the guidance
offered by the wizard in Lesson 1A. This Tutorial lesson will explain how.

In DeskProto you can enter parameters on three levels:

1- the Project parameters are general settings for the complete project, like
the machine and the CAD data files that are used. Each project contains one or
more parts, for instance two separate model halves.

2- the Part parameters define what exactly will be machined: scaling,
orientation, partial machining, etc. Each part contains one or more operations,
for instance for roughing, finishing, and some detailing operations.

3- the Operation parameters define how the part will be machined: which
cutter, strategy, speeds, etc. In DeskProto three different operation types are
available: Vector operations, Geometry operations and Bitmap operations.

The project tree on the left of the DeskProto screen shows this tree structure:
one project, containing one or more parts, each containing one or more
operations (in the DeskProto Free edition only one part and one operation can
be used). You can open the relevant dialog with parameters by double-clicking
its line in the tree (or via the Parameters menu).

As you selected 'Vector project' in the Start Screen, DeskProto automatically
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created a part with a \ector operation.

In the project tree the first line (the project line) still is called “Untitled”. The
project will receive a name when you save the project: the name of the
DeskProto project file (.DPJ file) also is the name of the project in the tree. For
this lesson the parameters on project level do not need to be changed -
assuming that the correct machine has been selected as default machine. You
can check that by making the project line in the tree active (clicking on it
once): the name of the machine then will be shown on the status bar (bottom
border) of the DeskProto window.

The Part parameters

Open the Part parameters dialog by double-clicking its line in the project tree
(or via the Parameters menu). Only the tabs that are relevant for a Vector
project (called the Vector Settings) are shown, the number of tabs is different
for the various editions of DeskProto. Only a few changes are needed now: in
DeskProto every parameter has a suitable default value, and thus it can be
ignored unless a change is explicitly required.

Scaling or Rotating the drawing can be done on the Transform tab (in case
needed, see lesson 1A). Mirroring is possible too, panning is not useful right
now as only one DXF file has been opened.

D part Parameters - 'Onderdeel’ >

General Transform Zero-point  Simulation

Material block definition

[ Size
() Use all CAD data m_.ﬂ

ppe

@ Set custom size

]
[

() Set custom boundaries

Set graphically...

The area to be machined can also be limited per operation.

Cancel Apply Help

On the Material tab you need to define the size of the material block. Just as in
Lesson 1A we propose to use a 6 mm thick plywood sheet of 400 x 250 mm (in
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inches 16 x 10, ¥” thick). The material tab now shows “Use all CAD data”,
select Custom instead, and enter the new dimensions. The 6.00 for Z is the
thickness of the material that we want to use: enter a different value if you
have a thicker or thinner slab of material. Do not mind the warning that no
curves have been selected: we will do so below.

The Zero-point (the fourth tab of this dialog, not available in the Free edition
and the Entry edition) by default is set on the left-front corner of the material
block. The drawing clearly shows what has happened: the material block now
has the correct size, the part is nicely centered within the block and the zero
point is at the top-front-left corner of the block.

The Vector operation parameters

In the project tree you will see one vector operation, and its icon shows a red
warning sign to indicate that the settings currently are invalid. To see what
causes this problem you can open the operation parameters by double-clicking
its line in the tree and then again close it by pressing OK: an error message will
pop up telling you that “No curves have been selected”. The wizard
automatically selected all curves, in the dialog interface this needs to be done
by the user, which makes it more flexible.

This flexibility is needed right away, as in this lesson different settings will be
used for the contours and for the text. For this first operation only the contours
(outside shape and 7 holes) will be selected. Open the operation parameters
again, tab Profiling. For ‘Select curves’ choose Custom and press button
Select: the dialog “Edit curve selection” will pop up, showing a top view of the
drawing.

Click on the outer contour to select it (the color will change from gray to blue).
Next with the shift key (on your keyboard) pressed down click on each of the 7
large circles to add them to the selection. As Profiling Strategy select
Outside/Left. When you now press button “Calculate toolpaths” you can check
if these are indeed the paths that you need: outside the outer contour, inside all
seven circles, and no toolpaths for the text. Close the selection dialog with OK
to confirm your selection and press Apply to update the drawing. You will see
that the 8 curves you have selected are now drawn in a darker gray.

For this DXF file ga quicker method to select these eight curves is present: for
Select curves you can choose Layer and then select layer “CONTOURS?”, as in
the CAD system all contour lines have been placed in this layer. The second
layer (TEXT) contains all curves for the text.

Other operation parameters need to be set as well:
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On tab Profiling select to use the Default Support tabs.

On tab page General you can select the Cutter to be used and set the Speeds.
We used a Flat cutter of 6 mm (1/4”) diameter, and the default speeds.

On tab page Z settings you can set the Machining depth and the Free
movement height. We used a depth of -5.9 mm (0.24”) for our 6 mm thick
material, and the default free movement height (5 mm).

Finally on tab page Roughing (not available in the Free edition) the option Use
layers can be checked, with a Custom Layer height (we used 3 mm/0.125”).
For each of these settings a complete explanation can be found in Lesson 1A.
Leave the Operation parameters using OK.

Create menu). DeskProto will tell you the estimated machining time
(unless you switched that off), and depending on your block thickness
and layer height you will see one or more layers of toolpaths: in our case
lowering to -5.9 in steps of 3 mm means 2 layers. The current result should be
the same as shown at the end of Lesson 1A.

E/ Now you can Calculate the toolpaths using this button (or via the

show the starting point and the end point of the toolpaths. The
drawing however does not show how the cutter moves. To see how
the cutter follows the toolpath you can use the Animation option by pressing
this button.

I The toolpaths are drawn in read lines, and the two small red arrows

Toolpath Animation n

]
> MM MM E

Operation: Contours
X Y Z
302.00 46.90 -3.00

(® DeskProto units (mm) Show true cutter
() NC-program units {mm)

«
*

E

The Toolpath animation dialog can be used like a video display, using buttons
to play, to pause, to skip to a previous or next position, to play at a higher or a
lower speed. The slider bar on top can also be used, to play the animation using
manual control.

Adding the text to be engraved

The text in the drawing needs to be machined in a completely different way: a
smaller cutter, a much smaller machining depth, and all material inside each
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character needs to be removed. In order to achieve this a second operation is
used, and Pocketing type toolpaths. As multiple operations and pocketing are
not supported in the Free edition users of the Free edition can skip this
paragraph.

Easiest way to add an operation is to right-click on line Part in the tree, and
then in the context menu select Add Vector Operation. The new line will
display a red warning sign in its icon, caused by the same error as for the first
operation: no curves have been selected yet.

Open the vector operation parameters for this new operation. The settings to be
changed will be listed below, with a short comment only.

Tab General:

- Change the Name from “vector operation [#1]” to “Text”: clear naming will
make things easier later.

- Select a thinner cutter: a flat tip of 2 mm (1/16”) diameter will (just) fit inside
each character.

- For this thinner cutter set a lower feedrate and if possible a higher spindle
speed.

Tab Z settings:
- Set the machining depth on -0.5 mm (-0.02”): enough to engrave a readable
text.

Tab Pocketing:

- Removing all material within a closed contour line is called Pocketing. So on
that tab set the Curve selection method to Layer and then select layer ‘TEXT’.
Or, when your CAD data does not use layers, set the method to Custom and
press the Select button in order to manually select the curves that you want to
use for the text. See the screenshot below.
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Now in the Edit curve selection dialog select the text curves (26 curves).When
selecting you can use a ‘rubberband’ selection tool: position the cursor close to
point A (make sure that none of the curves is activated (purple), press the left
mouse button, move to point B and release the mouse button. Now only the
curves that are completely within the dashed rectangle (the rubber band) will
have been selected: 26 curves.

As Strategy select Offset, the default Stepover of 50% is OK.

Again press button Calculate toolpaths to see the result: toolpaths to remove all
material inside each of the text curves. As you can see DeskProto automatically
recognizes that curves within other curves need to be treated as islands without
toolpaths.

The dashed lines in gray are positioning movements on Free movement height.
After closing both dialogs and again pressing Calculate toolpaths the
DeskProto screen now shows the toolpaths for both operations:
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e DpBeerTray.dpj - DeskProto 8.0 - Dealer license: Not For Resale! - BETA version

File Edit View Parameters Create Options Help

| REB[BLEAHE S0 1HE &

Project Tree

#5 DpBeerTray

vy db part
, %2 Vector operation |
/22 Text A5 { ) _RiS o

The first operation has not yet been renamed, we advise to rename it now as
the use of proper names will prove to be convenient when reusing the project
later. Also the name of the project (the upper line in the tree) still is “untitled”
as you have not yet saved the project.

part. When you press this button the material block will be shown on
your screen as a solid, brown block, and a dialog called Operations to
simulate will pop up.

In this dialog all operation in this part are  gperations to Simulate x|
shown, each with a checkbox to select it.
Check the first operation (the Profile
toolpaths) and press Calculate: the #2 Contours
simulation will be updated to include the |[J " Tt
profiling toolpaths. You can include the
Text Operation by also checking that and
again pressing Calculate.

The level of detail of the simulation can
be set in the part parameters (tab = e E =
Simulation). Again pressing the Simulate g
button (or pressing the hide button in the above dialog) will hide the simulation
and make the toolpaths visible again.

|TT The next step is optional: you can show a simulation of the resulting

[®] check all f none

the button. For most machines you will see that two different NC files
are written: after the first operation DeskProto finds that a different
cutter is required and thus has to start a new NC file. Only for machines with
an Automatic ToolChanger (ATC) both operations can be saved in one NC file.

E— il Finally you can write the NC file, either via the Create menu or using
r |

It is also possible to save these files one by one. In the tree you can see a
yellow light bulb in front of each operation. Clicking on such light bulb will
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make it gray, and the operation becomes invisible. That is a very handy feature
when working with several operations. In case not all operations are visible
when you tell DeskProto to write the NC file, DeskProto will ask “Do you
want to use the visible operations only?” This makes it possible to save the
NC files one by one, giving a clear and informative name to each file.

From here you can proceed to paragraph “To the milling machine”’, which will
explain about this next step.
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To the milling machine

The NC program(s) that you created is (are) ready to be sent to the milling
machine, so you are finally ready to start cutting off chips now. As the way to
do this depends on which milling machine you use not all necessary
information can be given here: please consult the manual of your NC milling
machine as well.

First the block of material has to be prepared, for which you have just entered
the dimensions (in one of the previous two paragraphs). For our beer-tray
sample we used: 400 x 250 x 6 mm, or in inches 16 x 10 x 0.25” - of course
you may have entered a different thickness or size. For X and Y some oversize
is not a problem, the Z (material thickness) needs to be exact though.

As this block is larger than the part to be machined you can fixture the block
on the machine’s working table using clamps on all four corners: the toolpaths
will not come close to these four clamps. As an alternative you can use double-
sided adhesive tape. The image above shows the four clamps, and also an extra
slab of material below to be used as “wasteboard”: this will protect the
machine’s working table in case the cutter travels too deep. This should not
happen, still for a first project it is good to be extra careful.

Next you have to tell your machine where to find the block of material. In
other words: you have to define the WorkPiece Zero point for this NC
program A CNC milling machine typically has two zero points: the machine
zero point, in a corner of its machining area, and the workpiece zero point (WP
zero, also called Program Zero) to be freely defined. It will be clear that two
different coordinate systems are present as well: machine coordinates (used to
define the workpiece zero point), and workpiece coordinates (used for the
milling operations).

In DeskProto you have defined the left-front corner of the block to be zero
(0,0), and for vector machining Z=0 always is at the top of the block. This
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means that all X and Y positions in the NC file are positive (X=0 is the left side
of the block, and Y=0 is the front side), all Z-positions (except for positioning
moves) are negative (Z=0 is the top of the material block). On the DeskProto
screen the workpiece zero point is shown as a dark blue cube (orientator).

So now on the machine you need to set the WP zero point at the Left-Front-
Top corner of the material block that you just fixtured on the machine.

On many machines you can enter the WP zero point by manually positioning
the cutter (milling tool) exactly on the desired workpiece zero point, and then
telling the machine controller that this is position (0,0,0). Keep in mind: for X
and Y the center of the tool must be positioned, for Z the tip of the tool. Of
course it is necessary first to mount the correct tool in the machine’s spindle, as
different cutters will have different lengths. If you are also machining the text:
make sure to send the correct NC file for the cutter that is mounted.

Part Information n

Material Vector

[rmim] Min Max Delta
X 20,00 380.00 360.00
¥ 15.00 235.00 220,00
z -5.90 0.00 5.90

Use translated coordinates

-

Finally double-check if the extreme values of the toolpaths: can the machine
reach the minimum values for X and Y, and can it travel to the lowest Z-value
without causing any damage. You can find these value in DeskProto’s Part
information dialog, tab Vector: see the image above. Make sure to check “Use
translated values” to see the same coordinates as in the NC file.

Now you are ready to start the machine by sending the NC program file you
just created to the machine. Most CNC milling machines have their own
control software to do this (like Mach3, PCNC, LinuxCNC, ...). If so then
start this machine-control program and open the NC program file. If needed
first transfer this file from the DeskProto PC to the machine’s control PC. The
command to start machining can be given in the control software.

A few machines (for instance many Roland machines) can be simply started
like a printer. With these machines it is possible to send the file directly from
DeskProto by choosing one of the options 'Send to Machine..." in the Create
menu. This option is available only when the correct communications port or
printer driver has been configured (can be done via Options > Preferences, tab
NC Output). The Send to machine option is not present in the versions for
MacOS and for Linux.
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In short:

- Clamp the material on the machine’s working table

- Set the WorkPiece zero point on this block as it has been set in DeskProto
- Load the NC file from DeskProto

- check if the extreme values of the toolpaths fit

- Start the machining process.

For the second NC file, with the text, this process can be repeated.

Leave the material clamped as it was and mount the smaller cutter. The X=0
and Y=0 positions remain the same as for the first NC file. Only the Z=0 will
need to be set again, now with the tip of this new cutter touching the top of the
block. After you have done so:

- Load the second NC file from DeskProto

- check if the extreme values of the toolpaths fit

- Start the machining process.

At the end of the milling process the model will still be attached to the
remaining block of material by means of the support tabs. You can manually
remove the beer-tray from the block and clear the seven holes. Finally use
some sanding paper to remove the remains of the support tabs and smoothen
all contours.

Page 44



Tutorial Lesson 2 @

2. Picture frame (geometry: basic)
Lesson Two

In this second lesson you will learn how to machine a 3D geometry. Again
some DeskProto basics will be explained, partly repeating Lesson One. This
time a geometry file will be processed and a 3D NC file will be made, ready to
send to the milling machine. The lesson again will be presented twice:

first using the Wizard ‘Basic Geometry machining” and next using the
Dialog-based interface. This lesson is for all DeskProto editions.

The geometry is shown in the figure above: a nice picture frame with floral
decorations. Machine it in wood and add your own favorite picture: a great
gift! This part can be machined from one side, making it a splendid sample
model for this basic lesson.

The relief has been created by Todd Bailey of 4m3D Creative Design
(www.4m3d.com) as a custom model for DeskProto. You can find the file
DpPictureFrame.stl in the Samples folder that was filled during Setup.
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Start DeskProto

Start DeskProto, as explained in Lesson One, and proceed until the Start screen
is displayed. In case this screen does not pop up automatically you can open it
in the File Menu.

In this second lesson again both user-interfaces that DeskProto offers will be
explained: the Wizard-based interface in Lesson 2A and the Dialog-based
interface in Lesson 2B. Both versions of this lesson will lead to the same
result.

In order to start Lesson 2A: in the Start Screen please check Use samples
folder and then select the option Use wizard.
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Lesson 2A

The Picture Frame, wizard interface

The DeskProto Wizard interface makes the program very easy to use for
anyone without previous experience. We will keep the Tutorial as short as
possible, as the wizard should in fact be self explanatory...

D7 \Which Wizard? b

1
I:;
e
E Machine to be used:
IS0 plain G-codes - mm o
El Type of milling:
() Basic Vector machining (20}

() Basic Geometry machining {300
() Basic Bitmap machining {relief)

The Machine to be used should already be the correct machine, as you have set
the default machine when first starting DeskProto. If not correct you can select
a different machine here (changing the default machine can be done in the
Default Part parameters (Options menu).

In fact a series of different wizards is available, each meant for a specific type
of milling. For the Picture frame we will use the second wizard: Basic
Geometry machining (3D), that is available in all Editions of DeskProto. So
please select that wizard and press Next.

D2 What to machine? >

1 2
% A n 1) n = 1"
e y L 9 b “'] b " - “ e St
| | & ’ é - -9 - | |

L?| Geometry file:

| || Browse. ., I

Just as in Lesson One the second icon becomes active (enlarged and underlined
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in red): you are on the second page of this wizard. You can see that this wizard
has more pages than the wizard in Lesson One, and that the navigation icons
are different. When using the DeskProto Expert Edition or Multi-Axis Edition
you will see seven pages, as shown in the illustration. When using the Entry
Edition you will see six pages, as a Contouring operation is not possible in this
edition, while in the Free edition only five pages are present (no Roughing).
Nevertheless also in the Entry and the Free edition this lesson can be
completed, as these extra operations are not required.

On this second page you need to browse a Geometry file. As you started with
option “Use samples folder” checked, the Browse button should directly look
in the DeskProto Samples folder: select file DpPictureFrame.stl and press
Open.

Note for INCH users:

For users that work in inches, most sample geometries are also available in an
inch-version. For the picture frame geometry the inch version is called
DpPictureFrame_inch.stl. So please select that file, as the metric version will
result in a frame of 183 inches high.

In case you do not see the Samples folder: you can find it in folder \
ProgramData\DeskProto 8.0\Samples\ (for more information, also on Linux
and Mac, see the earlier paragraph on Files and Folders)

Scale when you need a different size picture frame. You can create a frame for
any size photo as DeskProto allows “non-uniform” scaling: different for X, Y
and Z. Do not change the Orientation as for this frame the Top surface needs to
remain on top.

For more information on any of these settings: move the cursor over one of the
yellow question marks to get an explanation in a “Wizard tooltip”.

% What to machine? X

= % 8 8 § § 5

[2] Geometry file:

|C:\DrugramData\DEskPrUtU 7.1\3am...\DpPictureFrame. st || Browse... I

|?J Scaling:

@ Wizard Tooltip

You can use Scaling to change the size of your part, for instance to machine
a scale model, or to correct an error in the units used. This is possible either
by entering scale Factors or by entering the required Dimensions.

lInifarm ccalina means that the asnect ratin hetween ¥V and 7 will he
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On the third page, called “Material and Support”, no changes are needed for
this project: use the geometry's bounding box as material block, do not add
supports and keep the default zero point position. These last two options
(supports and zero point) are not present for users of a DeskProto Free or Entry
Edition.

The next three wizard pages are for the three operations, as this wizard will
automatically generate three operations: Roughing (optional, not in the Free
edition), Finishing, and Contouring (optional, not in the Free and Entry
editions). The roughing operation is meant to quickly remove material, the
finishing operation to create an accurate model with a smooth surface, and the
final contouring will smoothen out most staircase steps that may have
remained along the outside contour, using the strategy “Contour Only”. On
these three pages you need to enter the actual Milling parameters like cutter,
speeds and precision.

The Free edition will create a project with just one operation (finishing), the
Entry Edition will skip contouring and create a project with two operations.

A Cutter can be selected from the list in the Combo box (the drop-down list):
the list shows all cutters in the Library. You may need to add or change a
cutter: then you can enter this Library via the button “Cutter library...”.

For finishing a freeform surface like this frame a ballnose cutter is the best
choice as it will create a smooth surface. The larger the radius the smoother,
the drawback obviously being that a large cutter cannot create small details.
You may select different cutters for each of the three operations, in which case
of course a tool change will be needed.

For Roughing select a large Distance between the toolpaths, for Finishing a
small one. In most cases the default values will be OK for this first model in a
material that is easy to machine.

For the Speeds you can also use the default values, unless you are machining
in tough material like metal.

The wizard already has selected an optimal Strategy for each of these
operations (also see the note below). In the Free/Entry edition the strategy
cannot be set as only one strategy is available: Parallel.

For the Roughing operation two extra parameters are available: Skin and
Layer height. Leaving a Skin around the model will improve the surface
quality: any damages made when roughing (for instance by cutter vibrations)
will not be visible in the result. Finishing will then move smoothly as the chip
load is constant (only removing the thin skin). The Layer height (how deep
may the cutter sink into the material in one pass) may of course never be
higher than the cutting length of the cutter that is used.

Each of these three Operation pages also shows a field for the Estimated
machining time. To see the machining time you must press the button
Calculate. Then the toolpaths for that operation will be drawn as well.
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The last page of the wizard, Send to machine, shows the resulting project tree
(you can rename any line in the tree after a slow double click). Three or four
large buttons are shown:

Button Show Toolpaths makes the toolpaths visible / invisible, and when
needed calculates the toolpaths.

Button Show Simulation does the same for the Simulation, and for a clear
view switches off the toolpaths when visible.

Button Send to machine is available only when your machine supports that
option (very few machines do) and when an NC output device has been
configured in the DeskProto preferences.

Button Write NC program file in most cases is the last step to be done in
DeskProto. This NC file then can be sent to your CNC milling machine, see the
end of this Chapter. The file extension depends on the machine that you have
selected: each machine manufacturer uses a different type of NC file.

You can end the Wizard by pressing Finish. After that you may save this new
project via File >> Save: this save will produce a DeskProto project file, with
extension DPJ.

Before you start machining please read the below Notes about this result:

1. The picture frame geometry has a large hole in the center area. Which makes
of course sense for a frame, however which is not ideal for the standard
parameters as just set by the Wizard.

The default Roughing strategy is Block and makes the cutter move in from the
outside. Perfect for most models, however not optimal for the frame as at some
point the remaining material in the center will be cut loose. That loose chunk
of material may damage your model, so here it will be safer to use strategy
Parallel for Roughing.

The default Finishing strategy is Parallel, which will also finish the empty
center area, so will take longer than needed.

2. DeskProto does offer many options to make these toolpaths more efficient,
most of these are available only via the Dialog-based interface. For more
information see lesson 2B in the next paragraph.

It is possible to first use the Wizard and then (after finishing the wizard) fine-
tune your project using the Dialog-based interface. You then of course will
need to save a new NC file for these changed settings.

3. In the DeskProto Samples folder you can find a sample project file for this
geometry, with much better settings. So easiest is to just open this file
DpPictureFrame.dpj (or DpPictureFrame_inch.dpj ).

From here you can either read the next half of this lesson, about how to use the
dialog-based interface, or jump to the paragraph called “To the milling
machine™ at the end of this Chapter.
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Lesson 2B

The Picture Frame, dialog-based interface

Start DeskProto, in the Start Screen (see Lesson One) again check Use
samples folder, and now select the option Geometry project (3D) (in group
‘Start new project’). We will now show you how to set all parameters in the
Dialog-based interface. Any settings that the Wizards make can also be made
in this way.

Load the Geometry file

) The first thing you need to do for a new project is load the geometry
&‘ that you want to use. In most cases this will be an STL file. In

DeskProto you can do so using the command Load geometry file,
located in the File menu, or using the Load geometry button. The result will be
a File-Open dialog in which you can browse the STL file you want to use. As
you selected 'Geometry project' in the Start Screen, DeskProto will have
opened this File-Open dialog for you automatically.

The file that we want to use for this lesson is called DpPictureFrame.stl and
is located in the DeskProto Samples folder. Unfortunately the location of this
folder — the Windows \ProgramData\ - is different per Windows version, so
the file may be difficult to find. No problem: you can use the checkbox in the
Start Screen mentioned above. So please go to the Samples folder and open the
file DpPictureFrame.stl

For INCH users:

For users who work in inches, most sample geometries are also available in an
inch-version. For the picture frame geometry the inch version is called
DpPictureFrame_inch.stl. So please select that file, as the metric version will
result in a frame of 183 inches high.

While reading the geometry file a progress indicator will be shown on screen,
counting the percentage that has been processed.
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The view window

HIN DD E
PaN D08

ROTATE

When the geometry file has been read, the View window will show the
geometry: a nicely decorated photo frame. The result of this lesson will be a
great product, either on your own desk or to be used as a self-made gift !

The light-brown lines around the geometry show the bounding box: the
dimensions of the material block that is needed to create this part. You can
make it more clearly visible by double-clicking on the image and in the Items
visible dialog (explained below) checking the option Translucent for Material
block. You can restore the previous image by again un-checking this option:
use the setting that you prefer.

The green cube with X, Y and Z shows the directions of these three axes, and
is called the Orientator. The small blue cube shows the position of the
WorkPiece zero point (0,0,0) for this part, more about that will follow later.

Rotate, Pan and Zoom
DeskProto offers several ways to rotate and move the object on the screen, so
to view the geometry from any side. The controls that attract most attention are

the colored thumb-wheels in the border of the view window.

The vertical and horizontal red thumb-wheels offer rotation, around a
horizontal and a vertical axis (horizontal and vertical on your display screen).
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The three-quarter-round wheel in the corner allows you to rotate around the
axis perpendicular to the screen. Position the cursor over one of these red
thumb-wheels, press the left mouse button and keep it pressed while moving
the mouse. You will see that the geometry rotates as indicated.

The two yellow thumb-wheels are for panning (moving the geometry over the
screen, horizontally and vertically). And the blue thumb-wheel is meant for
zooming (changing the viewing-distance).

While these thumb-wheels attract most attention, they are not needed as you
can also use direct mouse control to rotate, pan and zoom. Most intuitive is the
Mouse Rotation: position the cursor inside the drawing area, press the left
mouse button and move the mouse. The geometry will now appear to rotate.
Imagine a large hollow glass sphere around the geometry: the cursor grabs the
sphere and rotates it round its center point, including its contents.

The result of the mouse movement

e . = . S just described depends on the status
“ffji’ \"‘Ivﬁ’ s T @7? of the Mouse function buttons: see

the illustration left. Of these five
buttons always one is active
(depressed), enabling either mouse rotation, mouse panning, mouse zooming,
zoom window or mouse measuring. No further explanation is needed: just
press one of the four buttons and see what happens when you use the mouse
inside the View window.

It is even possible to rotate, pan and zoom without using these mouse function
buttons. Select button Mouse rotation and press the left mouse button for
rotation, press the middle mouse button (the mouse-wheel) for panning, and
rotate this wheel for zooming. When zooming the cursor position determines
the center of the zoom, so you can zoom onto any detail on the screen.
DeskProto supports the SpaceMouse ® by 3Dconnexion for rotating, panning
and zooming.

P

PR ERRTUBGE

A number of standard views can be set very quickly using the eight toolbar
buttons showing small cubes. Each colored button sets a main view (a view
along one of the main axes). The next four buttons to the right of these cubes
can be used to quickly set isometric view, default view, previous view and next
view (the latter only enabled when button previous view has been used).

Note: all these controls only influence your view of the model (the camera
position), not the actual orientation of your geometry on the milling machine.
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Items visible

This option - that will prove to be very handy - allows you to select which
items should be displayed in the View Window. You can open the Items visible
dialog by clicking this command by double-clicking inside the view window or
via the View menu.

¥ ftems Visible b
General CAD Data
@ Tite 8 Vector curves === [J Show points =gl
DeskProto sample project B Geometry, rendered r () Show downward faces 0
8 view orientator Y*x [T Geometry, wireframe @ Remove lines [Tj
8 Use fog N [] Geometry, paints )
Work f the millng machine [/
£73 Working area of the miling machine [ | | B o
Toolpaths Parts
| = =2 .
= TI] ]
| O Show peints B Material block [ 18] [ Translucent | T
-5 3D support tabs = 2 [ show as wireframe
[ show arrows .
orkpiece zero-poin ] Untranslated zero-painl
B workoi int ([ Untranslated int
| B8 show rapid movements () Simuation I_[_)
Operations
| , #- Roughing B Areas to be machined r[j (] Translucent rTj
. Finishin e
L 9 ) B Toolpaths il
" L Centour Only (not in Entry Edition) hics
. " froe
| Z-grids _—_é_ﬁ\ﬁ_;é
[] Z-grids rendered ‘:.

{ oK Cancel Help

Every displayable item is shown, with a checkbox to mark for each item
whether or not it should be displayed. When checked (V") the corresponding
item will be displayed after pressing the OK button.

When the checkbox is completely filled (showing a square instead of a V) or
shows a hyphen (horizontal line), like in the illustration above for the
Toolpaths, it means that multiple operations are selected (light gray or blue
background) having a different status for that item.

For now please look at the CAD Data items only, and play around with the
available options to see what happens. For instance 'Show downward faces' is a
great tool to find any undercuts in your geometry (area's that the cutter cannot
reach), and the option 'Translucent’ for the Material block will make it
perfectly clear whether or not the part fits inside the block.
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Check the model’s orientation and dimensions

While examining the geometry by looking from various directions, you will
have noticed that the Picture Frame is correctly positioned for milling. In
DeskProto the milling tool always comes from the positive Z-direction: X is
from left to right on the milling machine, Y is from front to back, and Z is up
and down. As the picture frame is lying flat on it's back, the freeform front side
is on top and can be machined completely.

Two features for checking the orientation have already been mentioned:

- the Orientator (green cube with three axes) shows the direction of the axes
- the option Show downward faces can be used to check for undercuts.

This geometry does not need to be rotated.

The above information is not completely correct: on the back side of the
Picture Frame geometry a recess has been modeled for the photo and the glass,
and this recess cannot be created when machining only the front side. Still the
frame also can be used without the recess, so in this lesson we will simply
ignore it. Machining from two sides will be covered in a later lesson.

What you have not yet seen are the dimensions of the geometry, which will tell
you whether or not your part will fit on your machine. DeskProto will of
course warn you if it is too large, however you will anyway need to know this
‘Part information’ to prepare the block of material that you will use.

- Part Information n
J Material Geometry

[rmim] Min Max Delta

X 0.00 132.94 132.94

¥ 0.00 182.93 182,93

z -13.97 0.00 13.97

Use translated coordinates

-

Press the Toolbar button with the yellow i or select Part Information from the
View Menu in order to display the Part Information dialog: see the images
above. This dialog gives you the dimensions both of the material block that
you defined and of the geometry that is used for this part (after scaling, rotating
and mirroring). When “Use translated coordinates” is checked the coordinates
shown will be the same as used in the NC file. For your current settings both
tab pages will show the same result.

As you can see the dimensions of the part are OK (the illustration is in mm), so
you can proceed and set the milling parameters.
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Set the milling parameters

In order to calculate the correct NC toolpath (the path that the cutting tool will
follow during the cutting process) DeskProto needs information about the
milling parameters that you want to use. For instance the diameter of the cutter
to be used, and how accurate you want to have your model. In this lesson we
will first show these basic parameters, and next teach you how to refine the
milling process by using Roughing and Finishing operations.

Obviously it is also important to select the correct machine for your project.
We will assume that you already selected the correct machine when first
starting DeskProto: then your machine is the default one so we do not need to
select it for each new project.

Cutter and accuracy need to be set for every milling operation. The cutter that
you use on the machine must of course match the cutter that you selected in
DeskProto: machining with any other cutter will result in an incorrect model.
You can find both the Cutter and the Precision in the Operation Parameters:

e Geometry Operation Parameters - 'Geometrie bewerking' X

General  Strategy FRoughing Area Borders Movement Advanced

Mame Geometrie bewerking
Cutter Ball nose, radius 3 = diameter & mm v Library...
Precision Speed

Distance between toolpaths 0.67 (dfg) ~|mm Feedrate a5 mmfsec
Stepsize along toolpath 0.67 (dfg) ~| mm 5 10000

The precision values will be rounded to:  (d=diameter of cutter) / (odd number)

espeed rpm

Cancel Apply Help

You can open the Operation Parameters dialog via the Parameters menu,
though it is easier though to just double-click the line of the operation in the
Project Tree. This project tree is visible on the left side of the DeskProto
screen, and shows all parts and operations in this project (as just explained in
the Quick start section of this Tutorial).

The Operation Parameters dialog consists of a number of Tab screens (in the
Free edition and the Entry edition less tabs are present than shown above). As
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all milling parameters have suitable default values, and as we want to start
simple: for now only look at the front Tab page (“General”) and just ignore the
hidden Tab pages. Do not ignore the most important button in the dialog: the
Help button. It will lead to a page that completely explains this one dialog.
Please try the Help, and remember this for when you have any question later.

The Operation parameters that you see now are different from the dialog that
you saw in Lesson one: then you saw the Vector operation parameters, now the
Geometry operation parameters. In addition DeskProto includes a third
operation type: the Bitmap operation, to be covered in the next lesson.

As you can see, a Cutter of 6 mm diameter with a ballnose tip has been
selected, which is the default tool in DeskProto (for inch users a 1/4” cutter).
For freeform surfaces a ballnose cutter is the best choice as it will create a
smooth surface. The larger the radius the smoother, the drawback obviously
being that a large cutter cannot machine small details. Because of the small
details in this geometry you may select a smaller cutter, depending on which
cutters you have. Nevertheless this 6 mm ballnose will produce a good result
as well: DeskProto will not damage the geometry when the cutter is too thick,
it will simply leave rest-material where it cannot reach.

You can check the data for the cutter (and add, delete and edit cutters) in the
Library of cutters, to be reached via button Library.

Two Precision values can be set: the meaning of Distance between toolpaths
will be clear, the Stepsize along toolpath will need some explaining. Each
toolpath consists of a large series of small linear movements (in CNC
terminology: G1 movements). This second setting determines the size of these
linear movements (steps). In most cases it is best to use equal values for both
Precision parameters.

Smaller precision values will lead to a smoother and more accurate result,
however also to a longer machining time. DeskProto will automatically show
you the estimated machining time after calculating the toolpaths.

For machining foam, tooling board and wood the default values for Feedrate

and Spindle speed will be OK; generally speaking these need to be changed
for harder materials only. So now press OK to close the Operation Parameters.

Calculate the Toolpaths

After having set the milling parameters you can now calculate the
E/ toolpaths: in the Create menu select Calculate Toolpaths, or (easier)

press the button “Calculate toolpaths” (the seventh button). When
calculating DeskProto shows a progress-bar to keep you informed about its
progress.
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After the calculations have finished DeskProto will display the toolpaths: the
red line is the path that will be followed by the tip of the cutting tool. First and
last point of the toolpath are indicated by a small red arrow. Some of the
toolpaths may be drawn using dashed gray lines: these are the positioning
movements of the cutter (at Free movement height, so above the block), which
will be done faster (called Rapid) than the cutting movements (done using the
Feedrate). Also the upward movement to this “Zfree level” after the last cutting
movement is done in Rapid mode.

The above picture was made after zooming in a bit, in order to actually see the
toolpaths in the illustration. You can clearly see that a distance is present
between the toolpaths and the actual geometry: this is the 3D compensation for
the Cutter radius that DeskProto has calculated.

Show an Animation

The next step is optional: you can show an Animation of the
/> toolpaths. When you press this button all toolpaths will disappear
from your screen, and a dialog called Toolpath Animation will pop
up, as explained in the previous lesson. Play the animation (like a video) to see
how the cutter will move over your part.
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Show a Simulation

part. When you press this button the material block will be shown on
your screen as a solid, brown block (in most cases hiding the CAD
data and the toolpaths), and a dialog called Operations to simulate will pop up,
as explained in the previous lesson. Check the operations that you want to
simulate and press Calculate to show the simulation, button Hide will make the
simulation invisible.

|’I." The next step is optional: you can show a simulation of the resulting

Create NC program

To send the toolpaths just calculated to your milling machine you will have to
first save them in a file, called the NC program file. You can do this in the
Create menu, with command Write NC program file, or (easier) by pressing
the button “Write NC-file™:

& ] |

Load geometry Calculate toolpaths Write NC-file

You now have seen that these buttons (nrs 4/5/6 for Load CAD data, 7 for
Calculate and 8 for Write NC) are the central buttons in the DeskProto work
flow for 3D Geometry machining.

When giving the Write NC command a 'Save-as' dialog box will appear, in
which you can enter the name of the NC program file to be written. The file
extension depends on the machine that you have selected as your default
machine: each machine manufacturer uses a different type of NC file.
Remember the file-location that is used! After pressing the Save button
DeskProto will write the NC program file to disk. As all calculations have
already been done, the process of creating an NC file will not take much time.

Note 1:

For some machines it is not needed to write an NC file, as DeskProto can
directly send the toolpaths to the machine. This can be done using command
Create menu >> Send toolpaths to machine.

This option must first be configured, via Options >> Preferences >> Tab NC
output >> select and configure the NC Output device.

Not many machines support this: we know that all machines made by Roland
do so, and some high-end industrial machines. The Send to machine option is
not present in the versions for MacOS and for Linux.
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Note 2:

What you just have done is write the toolpaths. Do not confuse this with saving
the project, which is the standard Windows File >> Save action and writes an
DeskProto project file. In the project file all parameter settings are stored, and
a link to the geometry file that is used. DeskProto project files have the
extension DPJ.

From here you can either proceed to paragraph “To the milling machine”, or
first learn about roughing and finishing in the next paragraph.

Roughing and Finishing

The toolpaths that you just made will indeed produce a picture frame: as the
part height is small it can be machined directly at full depth (only in light
materials). So you are free to skip the fine-tuning that is presented in this
paragraph. Still, applying Roughing and Finishing has a few distinct
advantages, so it will be worthwhile to bear with us for some more time. This
paragraph does not apply to the Free edition as that does not support Roughing.

You want the machining time for your part to be as low as possible, and you
also want an accurate model with a smooth surface. When using only one
operation you need to choose between quick or accurate though. As in most
cases the cutter cannot remove all material in one go (except for very low
models) it will move down in layers. For instance it will first sink 5 mm into
the material, remove all excess material above that level, next sink to minus
10, and so on. DeskProto will automatically apply this layering (which is a
roughing functionality) as it does not allow the cutter to sink deeper into the
material than its cutting length (at least: not in the first operation). When doing
so with a small Path distance (needed for a smooth surface) this will take a
long time.

When using Roughing and Finishing:

the Roughing Operation will quickly remove material (using a large
toolpath distance), after which

the Finishing operation will produce an accurate model and a smooth
surface (using a small distance).
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D Untitled - DeskProto 8.0 - Dealer license: Mot For Resale! - BETA version

File Edit View Parameters Create Options Help

| Bil-i.llﬂﬂxlﬁfPH

Project Tree 4

#5 Untitled |
v Lk Part i
Lo Geom Part Parameters... Alt+Enter

Add Vector Operation
Add Geometry Operation |
Add Bitmap Operation

o -

e Chel

In order to achieve this we need two operations in DeskProto, so you need to
add a second operation to the current part. You can do so in several ways:
shown above is a right-click in the Tree on the line of the Part, and then in the
Context menu select Add Geometry Operation. The result will be a tree with
two operations, called “Geometry operation” and “Geometry operation [#1]”.

Double-click on the first operation line in the tree and change its name to
“Roughing”. Now you can set the Operation parameters to make this a real
Roughing Operation. Go to the Roughing tab and select a Layer height (the
default value is the Cutter length which will be too much in most cases) and
the Skin thickness. For a 6 mm ballnose cutter and a soft wood you could use
say 6 mm Layer and 0.5 mm Skin (in inches: for a 1/4” cutter this is 0.25”
Layer and 0.02” Skin). You can also check the Ramping option. Use the Help
for more information about these settings.

As Strategy (2™ tab) for roughing we often use Block, as in most cases this is
most efficient. Not for this frame though, as this will result in a loose block of
material in the center halfway the process, which may cause trouble. So leave
the strategy on Parallel.

On the General Tab you can now select larger Precision values (Distance and
Stepsize). In most cases the second value in the drop-down list will do: d/3.
This means 1/3 of the Cutter diameter, so you'd expect 2 mm (0.0833”).
Instead d/3 now will say 2.33 mm (0.0967”). Reason for this difference is the
Skin that was just applied. The skin is processed by calculating with a ‘virtual
cutter' that is thicker than the real one: R 3 + skin 0.5 = R 3.5. This means a
diameter of 7, and 7.0/3.0 results in 2.33.

Close the dialog using OK.

The second operation will be the Finishing Operation: open the parameters,
and change the name to 'Finishing'. You do not want any Roughing functions
active, and you want smaller Precision values (Distance and Stepsize). For
finishing we often check the option 'Skip horiz. Ambient' in order to finish only
the geometry surface (tab Advanced). For this frame also uncheck “ignore
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enclosed ambient”), which will make DeskProto skip the large center hole.
Make sure that on tab Movement the option Sort has been checked, as
otherwise many unneeded positioning movements will result. You can leave all
other settings as they were (default values).

You can choose to use two different cutters for Roughing and for Finishing: a
thick flat cutter for quick and efficient roughing, and a small ballnose cutter for
detailed finishing. As this geometry contains many small details this will
produce a very good result. On the other hand: the alternative of using the
same cutter for both operations (inefficient roughing) has the advantage that no
tool change is needed.
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To the milling machine

The created NC program is ready to be sent to the milling machine, so you are
finally ready to start cutting off chips now. As the way to do this depends on
which milling machine you use, not all necessary information can be given
here: please consult the manuals of your NC milling machine as well.

First a block of material has to be prepared. You already know the dimensions
of the frame as you have just checked these in the Part Information dialog:

133 x 183 x 14 mm, or in inches 5.23” x 7.2” x 0.55. The values in the dialog
are in fact a tiny bit smaller, which you can ignore for this project.

< Cutter at
WP zero point
Z=0.0
__Z=-14
| —_Z=17
X=0.0

For a first test model you can use a larger block of material, leaving excess
material on all sides to clamp the block without the risk of damaging your
clamps. Make the block at least 3 mm larger in the Z-direction, as the ballnose
cutter will go R mm lower than the bottom of the frame (R being the Radius of
the cutter). This is needed in order to completely machine any vertical and
steep surfaces; see the illustration above for a ballnose cutter with R=3 mm).

You can fixture the block on the machine using clamps, a machine vise or any
other method. For light materials like PolyURethane (PUR) or PolyStyrene
(PS) foam you can use double-sided adhesive tape.

Next you will have to tell your machine where to find the block of material. In
other words: you have to enter the WorkPiece Zero point for this NC
program, taking into account the block just fixtured. A CNC milling machine
typically has two zero points: the machine zero point, in a corner of the
machining area, and a workpiece zero point (WP zero, also called Program
Zero) to be freely defined. As a result also two different coordinate systems are
present: machine coordinates (used to define the workpiece zero point), and
workpiece coordinates (used for all milling operations).
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By default DeskProto sets the Left-Front-Top corner of the material block to
be (0,0,0). This is the default translation setting. All X and Y positions of the
part then are positive (X=0 is the left side of the block, and Y=0 is the front
side), all Z-positions are negative (Z=0 is the top of the material block). So the
left-front-top corner of the block should be set as the workpiece zero point on
the machine. In most cases also will be the starting point of the toolpath.

If your block is larger than needed the XY zero may also be located near this
corner, on the inside of the block, leaving sufficient room on all sides to
complete the whole part. Or in fact even a bit more as on all four sides the
cutter has to move outside the part to machine the outer surfaces.

Make sure to double check X and Y: if you mount the block with the longest
side in the wrong direction the part will not fit inside the block.

On many machines you can enter the WP zero point by manually positioning
the cutter (milling tool) exactly on the desired workpiece zero point, and then
telling the machine controller that this is position (0,0,0). Keep in mind: for X
and Y the center of the tool must be positioned, for Z the tip of the tool. Of
course it is necessary first to mount the correct tool in the machine’s spindle, as
different cutters will have different lengths.

Now you are ready to start the machine by sending the NC program file you
just created to the machine. Most CNC milling machines have their own
control software to do this (like Mach3, PCNC, LinuxCNC, ...). If so then exit
DeskProto, start this machine-control program and open the NC program file.
If needed first transfer this file from the DeskProto PC to the machine’s control
PC.

Some machines (for instance many Roland machines) can be simply started
like a printer. With these machines it is possible to send the file directly from
DeskProto by choosing the option 'Send NC Program to Machine..." in the
Create menu. In this last case: make sure that the correct communications port
or printer driver has been configured (choose 'Preferences' in the Options
menu). The Send to machine option is not present in the versions for MacOS
and for Linux.

At the end of the milling process the model will still be attached to the
remaining block of material, as for this first test your block was larger than the
model, and as a three axes milling machine cannot machine the bottom of the
prototype. You can either leave it that way (in case you already can see all
details that you need), or remove the rest of the block using for instance a
small band saw machine.

For the definitive model, so a frame without any excess material, the block
needs to be more accurate and the fixturing more precise. Make the block some
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millimeters larger for both X and Y, to compensate for possible positioning
errors (not too large as then the chips cannot easily fall off during machining).
Make the Z (thickness of the block) as exact as you can. Setting the WP zero
point now needs to be done accurately, exactly at the Top Front Left corner of
the block. This will be easy, as the process is the same as for the test just done.

Only the fixturing will be different now, as now you cannot clamp the excess
material around the model (as no excess material is present), and as you need a
‘wasteboard’ below the part to prevent damaging the machine’s working table.

Cutter

Wasteboard

Clamps
ﬁ Block of material l ﬂ

Screws from below

The frame now needs to be fixtured from below. This can be done either via
double sides tape, or (better) using a few screws from below. The screws
method works out nicely: see the illustration above. You can safely use clamps
to securely fixture the wasteboard as the cutter will not come near these
clamps. You only need to take care to correctly position the screws: they may
not connect to a part of the block that will be milled off ! The waste-board will
be 'wasted' as the ballnose cutter will machine a groove all around the model.
See the Tutorial videos on the DeskProto website for a demonstration.

Obviously more fixturing methods are available for this job.

You can for instance also use support tabs (bridges) to keep the picture frame
connected to the rest of a (larger) block during milling. And you can machine
the frame from two sides, in order to also machine the cavity on the back side
of the frame. More about such advanced options will follow in the later
lessons.

If the frame does not fit inside your machine as it is too large: in DeskProto it
is easy to scale the model in order to make it smaller. You can do so in the Part
parameters. Scaling of course also can be used to make the frame OK for a
smaller or a larger picture.

In some cases a rotation round the Z-axis of 90 degrees may help to make the
part fit in your machine: in case the longest dimension of the frame fits within
your working area along the X-axis but not along Y.
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3. XYZ logo (bitmap: basic)
Lesson Three

XYZ

L

This third lesson you will teach you the basics of DeskProto bitmap machining.
Again some DeskProto basics will be explained, partly repeating the previous
lessons as that will allow you to start reading here. A simple bitmap file will be
converted to a 3D relief and a 3D NC file will be made, ready to send to the
milling machine. The lesson again will be presented twice:

first using the Wizard ‘Basic Bitmap machining’ and next using the Dialog-
based interface. This lesson is for all DeskProto editions.

The bitmap image and the relief are both shown in the figure above: it is the
company logo for the (imaginary) company named “XYZ”. Bitmap machining
may not be the optimal way to create this relief, still it offers a very easy way
to do so. In case you only have the graphics as bitmap and do not know how to
convert it to vector data this lesson will show you what to do to get the project
done. Note that this is a very simple project as this bitmap contains only black
and white. Bitmaps that also contain gray-values will produce a more
complicated 3D relief.
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Start DeskProto

Start DeskProto, as explained in Lesson One, and proceed until the Start screen
is displayed. In case this screen does not pop up automatically you can open it
in the File Menu.

In this third lesson again both user-interfaces that DeskProto offers will be
explained: the Wizard-based interface in Lesson 3A and the Dialog-based
interface in Lesson 3B. Both versions of this lesson will lead to the same
result.

In order to start Lesson 3A: in the Start Screen please check Use samples
folder and then select the option Use wizard.
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Lesson 3A
The XYZ logo, wizard interface

The DeskProto Wizard interface makes the program very easy to use for
anyone without previous experience. We will keep the Tutorial as short as
possible, as the wizard should in fact be self explanatory...

D7 \Which Wizard? b
1

I:ﬂr
e

E Machine to be used:

IS0 plain G-codes - mm o
|ﬂ Type of milling:

() Basic Vector machining (20}

() Basic Geometry machining {300
() Basic Bitmap machining {relief)

The Machine to be used should already be the correct machine, as you have set
the default machine when first starting DeskProto. If not correct you can select
a different machine here (changing the default machine can be done in the
Default Part parameters (Options menu).

In fact a series of different wizards is available, each meant for a specific type
of milling. For the XYZ company logo we will use the third wizard:

Basic Bitmap machining, that is available in all Editions of DeskProto. So
please select that wizard and press Next.

D2 What to machine? »
L 2 :
L? Bitmap file:
| || Browse. ., I

The second icon becomes active (enlarged and underlined in red): you are on

Page 69



Desk Proto Tutorial

the second page of this wizard. You can see that this wizard offers five pages
(in the Free edition four). This second page offers all settings to define what to
machine.

Obviously the first step is to load the bitmap file to be used: press the Browse
button to open a file. As when starting the wizard you checked ‘Use samples
folder* this is the folder that will show; it will include the sample file
XYZlogo.png that we used for this lesson. So open this file (you may of
course also use your own bitmap file).

—— -
e o

The file will be shown on the screen immediately. Do no worry about the
image being rather vague and having a blurred outline: DeskProto shows a
simplified version of the image in order to speed up the (3D) graphics. For
toolpath calculations the real image will be used. A color image will be
automatically converted to gray values by DeskProto.

The blue cube shows the position of the zero point: the left-front corner of the
bitmap, at the top of the block. You will later need to set that same zero point
on your machine.

The image size for our file XYZlogo.png is 279.4 x 101.6 mm, or for inch
users 11 x 4 inch.

For readers who want the exact information: the bitmap file is sized 3300 x
1200 pixels, at 300 DPI (Dots Per Inch). You can check this in DeskProto’s
Project parameters dialog: tab Bitmap, button File info...

The Scaling option in this wizard allows you to set the size of the relief to be
machined. Easiest is to select “Dimensions” and then enter the required size.
We want to make a small name-tag, so we enter 100 mm as X-size (that equals
about 4 inch). You will see that the Y-size automatically follows and changes to
36.36 (ca 1.45”): this happens because the checkbox “Uniform” has been
checked, so the same scaling factor is applied to both axes.

When pressing the Apply button (bottom left corner of the wizard) the image
and the Part Information dialog are updated to reflect this new size.

The thickness of the relief is set by the Z-settings: you can enter a Z-level for
(pure) black and one for (pure) white. All intermediate gray values will be
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automatically calculated. For our small name tag a relief depth of 1 mm is
sufficient. We want our logo on top of the surface (embossed characters), so
black must have the highest value: Z=0 and white must have the lowest: Z=-1.
This will make DeskProto remove all material around the black logo. Positive
Z-values are not permitted here as the top of the material block is on Z=0. So
enter -1.0 mm (0.04”) for white and 0.0 for black

You now have defined what to machine (the Part). Press Next to continue and
define how to machine it (the Operations).

Wizard page 3 (not present in the Free edition) can be skipped: for this small
relief depth (1 mm) a Roughing operation is not needed. So simply un-check
the box “Use roughing operation” and again press Next.

Wizard page 4 defines the Finishing operation, which cannot be skipped.

For an embossed logo the ideal Cutter is a conical
one with a flat tip. Such cutter is also called “V- ‘
shape cutter”, as it’s shape is a V. For our project |
we selected the cutter called “Conical, side angle 1
30 degrees, diameter 6 mm” from the drop-down {
list. This cutter has a side angle of 30 degrees,
which will result in a 30 degree surface at the
logo’s outer contour. This cutter definition is for a
cutter with a sharp tip. For this application in fact a
conical cutter with a flat tip is better, diameter say 30°
ca 0.2 mm (0.008”), as that will make it possible to
machine a perfectly flat surface around the logo.

Note the difference between the “grinding angle” —H-B R
(as shown in the image) and the “included angle”
that is used by some cutter suppliers. For this cutter the included angle (top
angle) is 60 degrees.

In case the cutter that you have is not present in the drop-down selection list
you can easily add it to the list after entering the Cutter library. After pressing
OK for the warning press Add in the library and enter all cutter details. Use the
Help button for Help. In the Cutter library you can also press Edit to check
(and/or to edit) the exact cutter definition for one of the existing cutters.

Next setting is the Distance between toolpaths. As we just selected a conical
cutter this setting needs some extra care: the distance to be selected must be
smaller than the tip diameter of the cutter. If not than a small ridge of material
(a “cusp”) will remain between each two toolpaths. The tip diameter of our
cutter was 0.2 mm (0.008”), so we selected toolpath distance 0.18 mm
(0.0072”). The smaller this distance, the smoother the result. However of
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course the machining time will increase as well.

When machining in a light material (non-metal) in most cases the default
Speeds need tot be changed. This case is an exception though, because of the
very small tip diameter of this cutter. The diameter of a cutter determines the
actual cutting speed (speed of the cutting edge cutting through the material):
the smaller this diameter, the smaller the actual cutting speed for the same
rotation speed in rpm (Rounds Per Minute). So for this conic cutter it will be
best to select a higher Spindlespeed.

As this tip is very small you may also want to set the Feedrate a bit lower than
default.

The default Strategy (cannot be set in the Free and Entry editions) is Parallel:
the first toolpath is at the front side of the part, from left to right (at constant
Y), next one step along Y and then from right to left back to X=0. Again a step
along Y, etc etc. This is the most simple and straightforward strategy, which
will work OK for this name badge.

As an alternative you can select strategy Waterlines: the toolpaths are much
more complex (and the calculation will take longer), however the result may be
better as the cutter toolpath will follow the outside contour of each character.

Finally press button Calculate to make DeskProto calculate and display the
toolpaths (you can do this again and again to see the results for each strategy).
After calculation DeskProto will show you the Estimated machining time for
this operation (after finishing the wizard you can show this time via the Create
menu). This is an estimation: the exact machining time is influenced by many
factors that DeskProto does not know.

Pressing Next will lead you to the final page of this wizard. Here you can first
check the result that you can expect by pressing button Show Simulation. The
most important button on this page is Write NC-Program file..., which will
open a Save-as dialog to export the toolpaths to an NC file. The file extension
of an NC file differs per machine: DeskProto will automatically use the correct
file type for the machine that you selected when starting this wizard. After that
press the Finish button to close the wizard.

From here you can either read the next half of this lesson, about how to use the
dialog-based interface, or jump to the paragraph called “To the milling
machine™ at the end of this Chapter.

Page 72



Tutorial Lesson 3

Lesson 3B
The XYZ logo, dialog based interface

Start DeskProto (or restart it), in the Start Screen (see the previous lessons)
again check Use samples folder and now select the option Bitmap project
(one of the options in group 'Start new project’). This lesson will show you how
to set all parameters in the Dialog-based interface. Any setting made by the
Wizards (as in Lesson 3A) can also be made in this way.

Load the Bitmap file

image that you want to use. Various image file types are supported:
BPM. JPG, GIF, PNG and TIFF. In DeskProto you can do this using
the command Load bitmap file (located in the File menu), or using the Load
bitmap file button (in the button toolbar). The result will be a File-Open dialog
in which you can browse the file that you want to use.

g The first thing you need to do for a new bitmap project is load the

As you selected 'Bitmap project' in the Start Screen, DeskProto will
automatically have opened this Bitmap-data File-Open dialog for you. Open
sample file XYZlogo.png

This is a very simple bitmap design, as only two colors are present: black and
white, (almost) without any intermediate gray values. So the resulting relief
will be simple as well and show just two Z-levels. Which is fine for this lesson
about basic bitmap machining. As already mentioned before: a low-res version
of the bitmap is displayed in order to have fast 3D graphics. The black of the
bitmap shows as gray because it is displayed as Translucent: otherwise the
toolpaths would later by obscured by the bitmap. You can switch off this
Translucency in the Items Visible dialog (doubleclick on the image to open that
dialog).

You now need to set all parameters for this project, without the guidance
offered by the wizard in Lesson 3A. This Tutorial lesson will explain how.

First the Part parameters will be done: define the Part that we want to machine.
You can open the Part parameters dialog by double-clicking in the tree, on
the line called “Part”. The part parameters that you see now are the settings for
Bitmap: almost (but not completely) equal to the Vector settings and the
Geometry settings used in the previous two lessons. As always in DeskProto:
as all parameters have a suitable default only a few need to be changed for this
project.
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On tab XY Transform you need to set the Dimensions of this part. Just as in
lesson 3A the default size follows the size as set in the file (at 300 DPI): 279.4
x 101.6 mm (11”x 4”). Many more sizing options are present here than in the
wizard. In this lesson we will simply select Custom and enter a size of 100 mm
(4”) for X. The Y size will follow as the aspect ratio is kept: 36.36 mm (ca
1.457).

On tab Z-Settings some changes are needed as well, in order to define the
relief depth. Just as in lesson 3A we will set -1.0 mm (.04”) for white and 0.0
for black: a flat surface at Z = -1 for the background area, and the three
embossed characters 1 mm higher.

The default material block definition (“Use all CAD data”) is OK, and so is the
position of the zero point (right-front-top corner of the block). So you can now
press OK to close the part parameters.

The next step is defining how you want to machine this part. This can be done
in the Operation parameters: in the tree double-click the line “Bitmap
operation” to open the Bitmap Operation Parameters dialog.

Most settings for this simple project are present on the first tab page (General):

As a Cutter we suggest to use a conical cutter: select the cutter called “Conic
engraving tool 30 degrees” from the drop-down list. Also see the image and
the explanation in the previous paragraph.

The Distance between toolpaths needs to be smaller than the 0.2 mm tip
diameter of this cutter, so again we selected 0.18 mm (0.007”). For the
Stepsize we used the same value, which in most cases is a good choice.

Set the Feedrate a bit lower than its default, and Spindlespeed a bit higher,
because of the very thin tip of the cutter that will do the actual work. This
manual cannot give any numbers here as these will be different per machine.
The default values that DeskProto shows for your machine will offer a nice
guideline.

If you prefer a different Strategy you can select one on the Strategy tab: the
small icon images show you what each strategy offers. For this name-badge
either Parallel (which is the default) or Waterlines will be a good choice.

On the other tab pages no changes are needed, so you can close this dialog and
enter your changes by pressing OK Not all tabs are present in the Entry edition,
and the Free edition offers only the General tab.

As you now have set all parameters you can proceed and calculate the
E/ toolpaths, by pressing this button. DeskProto will display them as red

lines. After calculating a dialog will pop up that gives the estimated
machining time — if not then you can find this dialog in the Create menu, with
an option to “Always show this dialog after calculating toolpaths”.
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Some background information:

The image above shows you how DeskProto calculates the relief. Shown are
the rendered Z-Grid and the toolpaths (strategy Crosswise). The two Z-levels
(Z=0 for black and Z=-1 for white) are clearly visible. At the outer contour of
this character you can also see grid-cells with an intermediate Z-level. These
are present as in the original bitmap pixels with an intermediate gray-level
have been added for anti-aliasing (making the outer contour visually smooth).
The toolpaths do not reflect these in-between grid-cells, as the tip of the cutter
cannot reach them because of 30 degree V-shape of the cutter. As a result the
outer contour will be a nicely sloped surface at 30 degrees.

At this point you can optionally display a Simulation of the resulting
part, via Create > Calculate simulation or using the button shown left.

When you are happy with the result you can press button Write NC-
file in order to save this complete toolpath in a file. Select a proper
Name and Location, allowing you to easily find the file again when
you start the machining process.

i =
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To the milling machine

The NC program file that you just created is ready to be sent to the milling
machine, so you are ready to start machining your name-badge. As the way to
do this depends on which milling machine you use, not all necessary
information can be given here: please consult the manuals of your NC milling
machine as well.

We have created toolpaths for a block sized 100 x 36.36 mm (4 x 1.45”). The
block that we will actually use needs to exactly match that size, or be a bit
smaller: if it is too large a ridge of material will remain on one or more sides,
outside the white background area of the bitmap.

As we have not bothered about the block thickness (the Z) DeskProto has used
the min and max Z-value (-1 and 0) and reports a block thickness of 1 mm.

In practice we will use a thicker block: otherwise only three separate characters
would result.

For this job the cutting forces will be very small, so we can easily “clamp” the
material block on the machine using doubly-sided adhesive tape. When using a
clamp, machine vise or similar make sure that the cutter will not collide with
the jaws of the vise.

Load the correct cutter in the machine’s spindle (the V-shaped cutter), and set
the WorkPiece zero point with the tip of the cutter toughing the top of the
material. For X=0 and Y=0 use the point exactly on the corner of the block
when it’s size is exact, if not the set this point just outside the block. We used a
white material with a blue top layer. In order to avoid scratching this blue to
we have set the Z=0 about 0.2 mm above the top of the material block.

Now you can open the NC file in your machine’s control software and start
machining.
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4. VV-Carved sign (vector: special)
Lesson Four

'_ .
Creating a V-Carved sign is a great way to start using DeskProto. Still this is
the fourth lesson in this Tutorial: it has not been made lesson one only because
the first lessons needed to be possible also with the Free edition of DeskProto.
When you have a paid DeskProto license you can also start with this lesson.

This lesson is meant to quickly get you going: it will show how to complete
your first project, without providing much background information. In case
you already have done the earlier lessons please ignore any information that is
double. This lesson is for all paid DeskProto editions: Entry, Expert and Multi-
Axis - the Free edition does not offer V-Carving.

The project is a simple sign: a slab of wood with your name (or your kid’s
name) carved into the wood. You will do this using V-carving: a great tool to
create an impressive result using a simple toolpath.

The CAD-data for this project is a 2D drawing, so a drawing that does not
contain any Z-values. The drawing contains only lines and arcs (vector
information), saved in an SVG file or in a DXF file.
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What is V-Carving

When you machine one groove using a V-shaped cutter (a conical cutter), the
width of the groove will depend on the depth of cut: the deeper the cut, the
wider the resulting \VV-groove.

Assume that you have a 45 degree conical cutter (included angle 90 degrees)
and that the Z=0 is set with the tip of this cutter (a sharp tip) at the top surface
of the material. A toolpath at Z=-1 mm will result in a groove that is 2 mm
wide and a toolpath at Z=-3 mm will make a 6 mm groove.

You can imagine that a 3D toolpath with a varying depth will create a groove
with a varying width. It is even possible to create sharp corners in the resulting
groove, using a toolpath that rises to the surface (Z=0) in a movement at a
certain angle.

V-Carving works very well to machine a text in a nice font: the screenshots
above show the V-Carving toolpath for an "e" character, in font Times New
Roman, and for a 45 degree conical cutter. The varying depth makes sure that
the width of the groove exactly matches the outline of the drawing. Note the
short toolpaths on the right side towards the three sharp inner corners.

More V-Carving options are available in DeskProto:

- a groove with a maximum depth and thus a flat bottom

- removing all material around each character to create raised text

- projecting the toolpaths on the curved surface of a 3D geometry.

As this lesson is just for basic V-Carving those advanced options will not be
explained, you can find more information in the DeskProto Help file.
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Create an SVG file using Inkscape

Inkscape is a widely used free vector graphics editor (open-source), available
for Linux, MacOS and Windows. You can download it from the inkscape.org
website.

This page is not meant as Inkscape tutorial, it only briefly describes the steps to
create an SVG file with your name, to be used in this DeskProto lesson.
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* Start Inkscape and create a New document.
* In the menu on the left select the Text tool (the icon showing an “A”)

* Now the toolbar shows options to select the font to be used and the font size.
We selected “Times New Roman”, font size 144 (for a text of ca 36 mm high).

* Click on the white sheet to start the Text tool, and enter the name that you
want to use. We typed “William”.

* In menu ‘Path’ select ‘Object to path’. This is an important step! It converts
each character to a vector curve along its outline, which is the type of
information that DeskProto needs. Without this step the text would be stored as
a series of characters with a font name: DeskProto cannot convert that
information to vector curves.

* In the File menu select ‘Export’, and then at the right select file format ‘Plain
SVG’, browse to a location, give a filename and press button Export to write
that SVG file.
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Start DeskProto

You can start DeskProto most easily using its program icon on your desktop.
When starting, DeskProto will briefly show its Splash screen. The first time
you start DeskProto an extra dialog will pop up, asking you to select the
machine and the units to be used, see the Installation chapter. After that
DeskProto will show either the Edition select dialog or the Start screen.

The Edition select dialog (as explained earlier, in chapter Installation) is
shown only when you are running the DeskProto Free edition. It asks whether
you want to start the Free edition or want to trial one of the other editions. In
addition buttons are present to either Buy a license or to Activate one. As said:
for this lesson the Free edition can’t be used as it does not offer V-Carving.

This is a DeskProto 8.0 Multi-Axis Edition
Licensed to: Delft Spline Systems, Utrecht
Dealer license:  Not For Resale!

Open existing project Other tasks
Open project Open sample ject

Start new project

Use wizard .

Use dialogs: Recent projects: Visit website:
Vector project (20) C:\ProgramD. .. rotiol Read tutorial (web)
Geometry project {3D) C:\ProgramDat,..\DpBeerTray.dp] | View tutorial videos (web)
Visit user forum {web)

Bitmap project (relie C:\ProgramData'Desk. .. \Bottle. dpj
C:\Program. .. \DpPictureFrame.dpj
0:\Projektien. .. \BBtoken-DP8. dpj

fi
-

The Start Screen (shown above) will make life easier for you as it offers
shortcuts to the most common tasks: starting a new project in various ways,
opening an existing project, using one of the samples, reading or viewing one
of the Tutorials.

[] Use samples folder

Click on option ‘Use wizard’ to start the wizard.

If the Start screen does not appear you can open it via the File menu.
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D2 Which Wizard? b

3

[2] Machine to be used:

150 plain G-o_odgs -mm ~
[?] Type of miling:

() Basic Vector machining (20)
() Basic Geometry machining (307

() Basic Bitmap machining (relief)

The first wizard page offers two settings.

Check if the correct machine is shown, and if not select it from the list. More
information about this setting has been given in Lesson 1.
Select the first wizard: ‘Basic Vector machining’ and press Next.

D2 What to machine? X

1 2
T

1_;_. Vector data file:

| |I Browse... I

Now load the SVG file that you just created in Inkscape. It will immediately
be drawn on the DeskProto screen.

In case you DeskProto shows the error “This vector file is empty (or the
entities in this file are not supported)” you have forgotten the important step
‘Object to Path” in Inkscape.

For Scaling select the option to show the Dimensions of your text, and check it
it will fit on the piece of material that you want to use (which of course needs
to be a bit larger). If not: here you can enter the dimensions that you need. We
did not apply scaling: the size of 164 x 36 mm (or 6.4 x 1.4 inches) was OK. It
was OK for both units, as the SVG file includes information about the units.

Rotation is not needed for this design (this would be a rotation round the Z-
axis).
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|i| Z settings (relative to top of Material blodk):

Free movement height {"pen up”) 5.0 mm

Machining depth ("pen down™) 3 mm
For V-Carving this is the {optional) depth —_—
limitation,

The Z-settings need some explanation, as for V-Carving the Machining depth
value has a different use than for the other strategies. As explained above, for
V-Carving the actual machining depth varies: it is calculated from the width of
the groove and the cutting angle of the V-cutter. For V-Carving the Machining
depth that you enter here will be used as the maximum depth: if the calculated
depth is larger the groove will have a flat bottom at that max depth.

We entered a value of -8. This is a guessed value: we do not expect that the
calculated grooves will reach that depth. The aim is a groove without a flat
bottom. For the Free movement height (for positioning movements) the
default value of 5 mm is OK.

Press Next to continue to the next wizard page.

2 Material X

[7] Dimensions of material block:
[T 250.0
ETIIE
Z(20.0
(O Bounding box of vector data mm
@ Custom Detail settings...

For V-carving the dimensions of the block need to be larger than the bounding
box of these vector curves. So select ‘Custom’ and enter a larger block size.
We used a block of 250x80 mm, 20 mm thick (ca 10 x 3 x 0.5 inch)

This third wizard page may also include an option to set the Workpiece zero
point (that depends on which DeskProto edition you are working with). If so
then the default setting is OK: use the left-front-top corner of the block. On
your screen it is indicated by the blue ‘orientator’ cube. That position will also
be used when the zero-point option is not present in the wizard.

Press Next to continue to the next wizard page.
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| D2 Milling X

1 2 e
= SO

P

‘;, Cutter: |
Conical, side angle 45 degrees, D & mm o rJ \ ‘]
Cutter library. .. ‘J‘ ::::'-:
|
EI Speeds:
Feedrate 1000 mm fmin
Spindlespeed 10000 rpm

\il Toolpath type and Strategy:
() profiing () Pocketing €@

Use machining depth as depth limit -

Stepaver (when needed) 5 %o

Add deanup operation. ..

For V-Carving a conical cutter (a “V-cutter’) with a sharp point is needed. We
selected the “Conical, side angle 45 degrees, D 6 mm’. It is important to know
that DeskProto uses the side angle in its cutter definition. Some cutter
manufacturers use the included angle (or top angle), which is twice the side
angle. So the 45 degree angle cutter that we selected has an included angle of
90 degrees.

The Feedrate and Spindlespeed that you can use depend on the machine that
you are working with: different machines can have completely different
capacities. So we cannot advise you about which values to use. In most cases
the default values that DeskProto suggests for your machine will be fine.

Select toolpath type ‘V-Carving’. This is possible only when you first have
selected a conical cutter.

The first two default sub-settings are fine for this first project:

‘Use machining depth as depth limit” and a Stepover of 5 %.

When V-Carving the width of the groove determines how deep the cutter will
travel (the maximum depth of the unrestricted toolpath is shown in the Vector
parameters dialog). Setting a Depth limitation is required, as the tip of the
cutter may not come below the bottom of the material. You now use the
machining depth (that you have just set to -8 mm) as depth limitation. When
this maximum depth is reached DeskProto will machine a horizontal surface at
that Z-height, using pocketing toolpaths.

The Stepover sets the toolpath distance between these pocketing paths, as
percentage of the cutter’s shaft diameter (not of the tip diameter, as in most
cases you will use a cutter with a sharp tip).
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Because of the sharp tip the resulting horizontal surface will not be flat and
smooth. You can fix that using button Add cleanup operation... This will add
an extra operation with a flat cutter to make this bottom really flat. As this V-
carving won’t have a flat bottom this extra operation is not needed now.

Support tabs are not needed for V-Carving.

Roughing may be needed, depending on the power of your machine. We
selected “Use maximum for this cutter” (3 mm, ca 0.12 inch), resulting in just
one toolpath for each groove. The maximum depth for this design is 2.735 mm
(0.11 inch).

The default setting is more careful: a custom layer height of 1.5 mm (ca 0.06
inch). The cutter then will go down in two passes (layers).

\ L1 LA 11\ \ 4 Ll L\
B L e NI = -

Finally you can make DeskProto calculate the toolpaths: button Calculate.
When you have done so you will also see an estimation of the total machining
time for this toolpath.

Press next to reach the final page of this wizard.
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nf: Send to Machine ;4

o ® 4

[2] Part and Operations to be machined:

i P s\

%2 Vector operation

E‘ Calculate toolpaths:

i Show toolpaths

E‘ Calculate a simulation of the resulting part:
i Show simulation |

E‘ Save toolpaths to NC-program file on disk:

| Write NC-Program fil... |

Here you can show the toolpaths (in case you have not done that on the
previous page), show a simulation (our simulation is shown on the first page of
this lesson) and finally write the NC program file.

As in the first step you selected your machine, this file will be in the correct
format for your machine. So you can now go to your machine: clamp your
material block, mount your V-cutter, set the zero point with the tip of the cutter
on the left-front-top corner of the block and start machining !

This is the result: a good-looking sign, CNC machined in a few minutes.
We used an old piece of oak, and our actual machining time was 2 minutes
(feedrate 15 mm/sec).
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5. Bottle (geometry: two halves)
Lesson Five

In this fifth lesson you will make a more thorough acquaintance with geometry
machining in DeskProto. This bottle cannot be created by machining from one
side, so the bottle will be milled in two separate halves, to be combined to
make a complete model (alternative methods are rotary machining and two-
sided machining, see the next lessons). This lesson is for all DeskProto
Editions, and will use the Dialog-based interface.

The geometry was modeled in a CAD package called SIPSURF (no longer
available). Only the outside geometry has been modeled: it is a massive (solid)
bottle. Both the bottle and the cap are present in the same STL file.
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Start a New Project

In DeskProto three types of project are available: Vector project, Geometry
project and Bitmap project. The only difference between these types is which
Operation is present (as first operation): in a \ector project a \ector operation
is present, etc. For this lesson you need a Geometry project: create one using
the command File > New Project > New Geometry Project. One of these
three project types is the default project (shown in the File menu in bold),
simply pressing the New button on the toolbar will create a project of this
default type.

Now use Load Geometry File... (File menu) or use the Load Geometry button
to load the geometry file for the Bottle. It is located in the DeskProto Samples
folder: just as in the previous lessons you can use the checkbox in the Start
Screen to easily find that location.

Select sample file Bottle.stl (inch users choose Bottle_inch.stl). Note that
Windows may hide the extension *.STL’ and/or call the file a “Certificate Trust
List”. You can ignore that false information and just open the file.

In the project file (that can be saved later) a reference to this geometry file
Bottle.stl will be included, through which this file will be found and loaded
automatically the next time the project is opened.

Check the geometry

The first thing to do after loading a geometry file is to check the geometry:
make sure you indeed see a perfume bottle, and check if its orientation and its
size are correct.

An easy way to check the orientation is to use a predefined Views Layout:
View menu >> Layout... In this dialog select one of the options on the right
side that show T/F/R/Def, in order to see four views: Top, Front, Right and
Default (3D). You can see that the bottle is standing ‘upright' its largest
dimension is along the Z-axis. Since the cutting tool will come from the
positive Z direction, the model cannot be machined as it is now. You need to
change the orientation (rotate), and in a moment we will show you how.

The dimensions can be checked using the button Part Information: the button
on the DeskProto toolbar with the yellow [ i ], tab Geometry. For this file the
dimensions should show a part of ca 54 x 29 x 86 mm: a nice perfume bottle,
which (after rotating) will fit the working area of your milling machine. For
inch users the dimensions should be OK as well (2.12 x 1.14 x 3.4 inch)

Now set the Views layout back to one view only. The Part Information dialog
may remain open when working with DeskProto.
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Edit Project parameters

What has to be done now is entering the parameters. When opening a new
project DeskProto already gave default values to all parameters, however some
of these will have to be changed for this specific model.

In the Parameters Menu you will see that three groups of parameters are
present: the 'Project parameters', the 'Part parameters' and the 'Operation
parameters'. Only one Project is present, in which a number of Parts can be
defined. Each Part in turn can contain one or more Operations. This is shown
in a tree-like structure, as is clearly visible on the left part of your screen. The
standard Windows name for this figure is in fact the Project Tree.

File Edit View Parameters Create Opti

| 0 &R
Project Tree 4

#% Untitled

v 'y 4'; Part

{ Geometry cperation

In the Parameters menu select Project Parameters. Much easier is to simply
double-click the project line (first line, still called ‘Untitled’) in the tree. The
Edit Project Parameters dialog box that will pop up does not contain many
parameters: on tab General it shows the ‘Filepath’, the name of the Machine
and the names of all Parts.

The Filepath field for this project will be empty as the project file (*.dpj) has
not yet been saved. In the Tree you can see that the new project does not yet
have a name: it is called 'Untitled’. When you save the project for the first time
you can enter a name, that will be used both for the file and for the project tree.

The Machine that has been selected should be the correct machine, as when
first starting DeskProto you have selected your machine as default. If not you
can select a different machine for this project here. The default machine can be
changed in the Default Project Parameters (Options menu).

A Part is machined in one fixation of the material block. In case you need
more than one part you can add new parts here. For many projects (like in the
previous lessons) one part is sufficient. For more complex models more than
one part needs to be milled: like for an electric drill you will separately mill the
right side and the left side, to be glued together later. For this bottle however
both parts are equal, so in the software one part is sufficient.
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The other tab pages allow you to load and unload more CAD files, and to set
Chaining settings. For now just ignore these other tab pages: you can leave the
dialog box using the Cancel button

Edit Part Parameters.

Each part has its own set of parameters, to be set in the Part Parameters dialog.
Just as with the project parameters it is easiest to open this dialog by double
clicking its line in the Tree.

Part Parameters define the geometry to be machined. The Part Parameters
are presented using a number of Tab pages. In the Free edition and the Entry
edition not all tab pages and not all options on each page are present.

Earlier in this lesson, when viewing the geometry, we already concluded that
the bottle geometry was not correctly orientated. You will do so now: the
geometry rotation is one of the part parameters.

The first Tab page (General) does not need any changes for this project. If you
like you can change the name of the part, though that does not effect the
toolpaths. The number of operations does not need to be changed: one
operation is sufficient here.

D% part Parameters - 'Part’ et

General Transform Material Support Ambient Zero-point  Simulation

1. Scale 2. Mirror 3. Rotation

[ 1n¥-Z plane (invert X) X |sl degrees

[ 1n %7 plane {invert ¥) ¥ 0.0 degrees
7 10 7 1n x-¥ plane (invert Z) z |00 degrees
Uniform 4, Inverse milling 0. Center
@ i [ Male to female [ center geometry

Scale factors =
e - == pr_

(O pimensions {mm)

j{L,.

Cancel Apply Help

For this bottle model we need to set parameters both on the second tab
(Transform) and on the third (Material). The Transform Tab shown above
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makes it possible to change the size and orientation of the geometry. For this
bottle (as said) the orientation is not correct: enter a rotation of -90 degrees
around the X-axis, and see what happens after pressing Apply. The orientation
of the geometry should be correct now. When the part is too large for your
machine a rotation of 90 degrees round the Z-axis may be useful as well (for
most milling machines the X-axis is the longest).

Using the Apply button is not needed: pressing OK also causes an implicit
Apply. Still it can be handy in order to quickly see what happens: if this is not
what you need you can enter a different number without needing to reopen the
dialog. On Apply both the drawing and the dimension shown in the Part
Information dialog will be updated.

The other parameters on the Transform tab are OK and will not be covered in
this lessen. For more information on these parameters see the Help pages
and/or the Reference manual.

You should clearly understand the difference between rotating the geometry
and rotating the view:

Rotating the geometry will change the model that is created. You can see on
the screen that the geometry rotates while the green XYZ axes-cube (the
orientator) remains the same. The milling tool comes from the positive Z-axis
direction, so because of the rotation a different side of the geometry will be
milled.

Rotating the View does not affect the model, it only changes the picture on
your screen (the camera position). You can see on the screen that both the
geometry and the orientator rotate identically, so the position of the geometry
relative to the milling machine remains unchanged.
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D2 part Parameters - 'Part’ >

General Transform Material Suppert Ambient Zero-point  Simulation

Material block definition

Boundaries
(O Use all CAD data
Minimum Maximum

() Use whole geometry
(@) Use upper half of geometry

(O set custom size
() set custom boundaries EJI R e 5 e
Display translated coordinates

Set graphically...

The area to be machined can also be limited per operation.

Cancel Apply Help

The third Part Tab is Material, and for this part the default (Use all CAD data)
needs to be changed. The geometry of the complete bottle has been loaded.
However, using a three axis milling machine this complete geometry cannot be
machined in one part: the cutter cannot reach the lower half. As stated before
the model will be machined in two separate halves, so we now want to
calculate toolpaths for half a bottle.

DeskProto uses a rectangular block of material, that can be defined by its
minimum and maximum vales for X, Y and Z. The default the material block
includes all CAD data: it is the exact bounding box around the data (vector,
geometry and bitmap) that you have loaded. Making the material block smaller
means excluding some of the CAD data. We want to machine half a bottle,
which is easy as it is a predefined option: select option 3: “Use upper half of
geometry”. You can see that the Minimum Z will change to -14.44 (for inch
users -0.57”), and that the orange block on the drawing will change when you
press Apply. Of course you can ignore the warning “The geometry seems to
(partly) fall outside the Material Block”.

Next press OK to exit this dialog.

Three notes on the Material block:

1. All values for the material block are shown in transformed coordinates (so
after the changes as defined on the Transform tab), not in the original geometry
coordinates. After these transformations one more change will be applied: the
Translation, to be specified on tab Zero-point (in the Free edition and the Entry
edition this tab page is not present, still this translation is applied). By default
DeskProto will show the translated coordinates here: the coordinates as used
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on the milling machine. You can instead use the transformed coordinates by
un-checking the box “Display translated coordinates”.

2. When you select one of the Custom options for the material block you can
define any rectangular block, either by entering the size or by entering X, Y
and Z Boundary values. Easier still is to define the block using the mouse,
which is possible via the button “Set graphically...”.

3. You can of course also make the material block larger than the default
bounding box, in case the actual block that you will be using is larger.

Edit Operation Parameters.

The Operation Parameters dialog can be reached most easily by double
clicking it’s line in the Tree. Alternative methods are the Parameters menu and
the context menu (visible after right clicking in the Tree). The Operation
Parameters are the actual milling parameters, so the settings for the
machining process. Most important settings are the Cutter and the Precision,
which can both be found on the first tab page: General.

ne Geometry Operation Parameters - 'Geometrie bewerking' >

General Strategy Roughing Area Borders Movement Advanced

Mame Geometrie bewerking
Cutter Ball nose, radius 3 = diameter 6 mm o Library...
Precision Speed
Distance between toolpaths 0.67 (dfg} ~|mm Feedrate 25.0 mm/fsec
Stepsize along toolpath 0.67 {(dfg}y ~|mm Spindlespeed | 10000 rpm

The predsion values will be rounded to:  {d=diameter of cutter) / (odd number)

Cancel Apply Help

For this dialog as well: in the Free editions and the Entry edition not all tab
pages are present, nor all options on each tab page.

Which Cutter is best depends on the geometry of the model. The perfume
bottle has a freeform outer surface, for which a ball nose cutter (tip of the
cutter is half a sphere) gives the best surface quality. The bottle also contains
some small details, so a thin cutter is needed. We suggest to use a ball nose
cutter of 4 mm diameter (Radius of the ball nose is 2 mm). For inch users the
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suggested cutter is the 1/8" ball nose cutter, so with a radius of 1/16”. You can
choose a cutter by its name using the black arrow button (combo-box) at the
right of the current cutter name.

To see all dimensions of a cutter you need to open it in the Library of Cutters,
in the Options menu. In this library you can define a new cutter, or modify an
existing cutter to match your real tool.

Equally important are the Precision parameters. They determine the accuracy
of the model, and also the time needed for both calculating and machining. For
a first rough prototype of the bottle the default value of D/9 will be OK, where
D is the Diameter of the cutter. For a nice smooth final model a smaller value
is needed.

The meaning of Distance between toolpaths (also called Stepover) and
Stepsize along toolpath has been explained in the previous geometry lesson. It
is recommended to enter equal values for both settings, though for special
cases you can experiment with different values for these two parameters.

DeskProto offers predefined values for the Precision parameters. These are
dependent on the cutter dimensions, and make sure that the DeskProto
algorithm achieves the maximum possible accuracy. You are free to enter other
values as well, however, DeskProto will always round your value to the nearest
value that equals "Diameter of cutter / odd humber".

The default Feedrate (traveling speed of the cutter) and Spindle speed (rotation
speed of the tool in rpm) will in most cases be correct as well. Optimal values
depend on the type of material you want to cut, and when cutting light
materials these values are not critical. The units that you see for the Feedrate
can be set in the Preferences.

In this lesson we will simply skip all other Operation Tabs, as suitable default
values are present, and press OK to close this dialog. More about the other
parameters is explained in the next lessons, in the Reference manual and in the
Help file.

Calculate Toolpaths

Start the calculations by pressing the button Calculate Toolpaths. Alternative
methods are: Create >> Calculate Toolpaths, Create >> Write NC Program
(which detects that the toolpath has to be calculated first), and View >> Items
Visible (in this dialog box you can make the Toolpath active in order to start
the calculations). Calculation will be quick, and the resulting toolpaths will be
drawn in red lines.

After calculating a dialog will pop up that gives a (rough) estimation of the
machining time for your current settings. If not you can call it via “Estimate
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Machining Time” in the Create menu (in that case the “Always show”
checkbox had not been checked). Note that the estimation is indeed rough: see
the Help file for more information on why it is rough and on how you can
calibrate it.

You will see (in case you used the cutter that was just suggested) that two
different horizontal layers of cutter movements have been calculated: the first
at level Z = -13 mm (0.4”), the second at the final depth. These are Roughing
layers: the maximum layer height for this 4 mm ballnose cutter is 13 mm:
cutting length 15 minus R 2. (for the 1/8” ballnose it is 0.34”), while the bottle
half is higher. DeskProto detects that the cutter cannot cut this depth in one go,
and inserts an intermediate layer to be machined first.

Important: in the Free edition this extra layer is not present, as this edition
does not support Roughing. So take care: when your model is too high for the
cutter, users of the Free edition need to run the same NC file more than once:
first with the zero point defined above the block, and then each next time with
the zero point a bit lower until you have machined the complete part.

You will also see some dashed lines in gray, going over the geometry at a fixed
Z-level. These are positioning movements in Rapid mode, for instance from
the end of layer 1 (maximum Y) to the start of layer 2 (minimum Y). When the
optimization option Sort (on the Movement tab, not present in the Entry
edition) has not been checked many extra positioning movements will be
present in the second layer.

Note: attentive readers will have noticed that the toolpaths go below the
minimum Z-value of the material block. To clearly see this: draw a side view
and compare the orange line of the block to the red lines of the toolpath. The
explanation is that when using a ballnose cutter it needs to travel the Radius of
the tool below the bottom of the part (so in this case 2 mm deeper). This is
needed in case of (almost) vertical walls, which otherwise could not be
machined completely. This is of course very important to remember when
starting the milling machine, we will come back on it later.

In fact the use of layers as just mentioned is a type of Roughing functionality,
which you had not selected. However this basic Roughing is always present
(except as said in the Free edition): for the first operation DeskProto does not
allow the cutter to go deeper than it’s cutting length.

You can now save the NC program file and continue with paragraph “To the
milling machine™, or you can add an extra Roughing operation first.
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Optionally add a Roughing Operation

Roughing is quickly removing most of the excess material, using ‘rough’
settings (a large Distance between the toolpaths). When several layers are
needed this is much quicker than doing all layers with the fine toolpath
distance needed for finishing. A second advantage is that when finishing after a
roughing operation the cutter does not need to remove much material, so it will
not vibrate and the result will be a very smooth surface for the resulting part.
As said before: roughing is not possible in the Free edition of DeskProto.

In order to add roughing to the toolpaths in DeskProto you will need to add an
extra Operation to your part. The first operation then can be used for roughing
and the second for finishing. It is of course most efficient to use a thick cutter
for roughing as that can remove material quicker than a thin cutter. However,
in this case the material that needs to be removed is not much, so you can
simply use the same cutter for both operations. The advantage obviously is that
you then need not change cutters halfway the project. Unless of course you
have a machine with Automatic Tool Changer (ATC), then this advantage does
not count.

So first you need to Add an Operation. This can be done by right clicking the
line “Part” in the Project Tree and then selecting Add Geometry Operation in
the context menu. Or as an alternative you can Add or Copy Operations in the
Part parameters dialog.

The new Operation’s line in the Tree is automatically set in edit mode, so you
can change it’s name from “Geometry operation [#1]” to “Roughing”. If this
did not work then right click on the operation’s line and choose Rename. Next
you can use the same action to rename “Geometry operation” to “Finishing”.
These operation names are not used in the NC file, still using proper names is
recommended to remember your intentions.

Now the sequence of the operations is wrong: roughing of course needs to be
done before finishing. You can fix this in the Part parameters: using the black
arrow buttons called “Move” on Tab page General you can change the
sequence of the operations. In order to do this you have to select an operation
(make its line blue) first. Alternative is to use the context menu in the Project
Tree for one of the Operation lines, which will offer the options Move up and
Move down.

Note that after this change the toolpaths for Operation Finishing will still show
the layers. These had been switched on automatically because it was the first
operation, however now it is the second one so layers are no longer needed.
Open the Operation parameters for this operation (double-click it’s line in the
Tree), on tab page Roughing uncheck the option “Use” for Layers, close the
dialog with OK. The toolpaths then will be recalculated, now without layers.
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ne Geometry Operation Parameters - 'Geometry cperation’ >

General Strategy Roughing Area Borders Mowvement Advanced

Layers Other options
first Skin thickness

[] ramping angle

Layer height
() Use maximum for this cutter
@ Custom

5.5 mm ﬂ:—-‘_“‘m [] Protect vertical surfaces
[ complete all layers per island m

5.0 degrees

Cancel Apply Help

Next you can set the parameters for the Roughing operation. Open the
Operation Parameters dialog for this operation. On tab General you can select
the correct cutter, as said before you can select the same 4 mm diameter
ballnose cutter (or 1/8”) as used for finishing. Then you can add the actual
roughing parameters, on tab page Roughing:

- The Layer height thickness can be fine-tuned: select Custom and enter a
value. For light materials like foam or tooling board you can enter 5.5 mm
(0.22”) to have three layers that are about equal (16.44 / 3.0). For stronger
materials like perspex or metal you will need to use a smaller value.

- You can set the Skin (to be removed during finishing) at 0.5 mm (0.02”). The
skin is an allowance of extra material that remains present around the pary.
Any damages that may result of the roughing toolpath will be in this skin, to be
removed when finishing.

- Ramping concerns how the cutter travels to the first point that needs to be
machined. Standard the cutter first travels to the correct XY and then just
vertically plunges down into the material, moving along Z. When ramping this
vertical movement is replaced by a declining movement (see the illustration in
the dialog), for which you can set the gradient angle. This will make cutting
much easier than in a pure drilling movement, especially when machining
metal.

Do not forget to also choose new Precision values (tab General): both the
Toolpath distance and the Stepsize can be set to D/3 (1.67 mm or 0.055”), in
order to quickly remove the material.

Here again attentive reader may need some in-depth information: the dialog
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mentions D/3 for the 1.67 mm value, while the cutter has a diameter of 4 mm.
What happens is that after setting a Skin DeskProto will calculate using a
Virtual cutter, that is the Skin thickness larger in all directions. You are
welcome to again forget this detail as this will be done fully automatically.

Now you can press OK and then again use the command Calculate Toolpaths
to also have the Roughing toolpaths calculated. The resulting view will be
rather a mess of lines. It is easy to make it less confusing: in the Project Tree
you see a yellow light bulb on each line. Clicking the light bulb for an
Operation will make it gray (the light is “switched off”): this will make that
operation invisible. So it is easy to view only the roughing toolpaths (make
finishing invisible) or only the finishing paths.

Three more detail settings can finally be used to fine-tune the results.

1. For Roughing it is more efficient to choose a different Strategy (second tab
page of the operation parameters): when you select strategy Block instead of
Parallel the toolpaths will proceed form the outside of the block to it’s center..

2. When Finishing it is not needed to again machine the flat area around the
bottle model: the material there has already been removed, and this Ambient
area does not need to be finished. On the Advanced tab page of the Operation
parameters you can select “Skip hor. Ambient”. You will see the difference
immediately after pressing OK.

3. On the Movement tab of the Operation parameters for Roughing you can
reduce the Feedrate for high chiploads. This is a great option: it will make
the cutter move slower when it has to machine at it’s full width. Normally the
cutter removes only a thin slice of material (its thickness being one toolpath
distance), however for the first toolpath or when entering a hole in the part it
has remove much more material: a high chipload. DeskProto can automatically
detect these situations and then reduce the feedrate to the percentage given
here. For roughing in tooling board you can set this to 30 to 50%, for materials
like perspex or aluminum even lower.

At this point you may want to draw a Simulation (Create >> Show simulation),
in order to check if the (simulated) resulting part is indeed what you expect.
When you first calculate it for Roughing and then for Finishing you can see the
result after both steps in the process.

Finally you can save the NC program file. Note that when both operations use
the same cutter (and both are visible) DeskProto writes one combined NC
program file. When you have selected different cutters DeskProto will write
two separate files (unless your machine has an Automatic Tool Changer). You
can also force separate NC files by making one of both operations invisible
before saving.
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To the milling machine

After writing the NC program file you can send it to the machine to create half
a bottle. In the previous lessons you have learned how to fix the block of
material and where to locate the WorkPiece zero point (the 0,0,0 position). For
this bottle model the process is almost the same, though a new trick will be
introduced to get two halves that exactly make a complete bottle.

The plan is to (twice) machine exactly half a bottle. The flat bottom surface of
the block will be the plane of symmetry, to be used to join both halves.
Fixturing the block faces the same problems as described in Lesson 2: the
cutter will cut on all sides of the model, and the tip of the (ballnose) tool will
come below the bottom of the block and may damage your machine’s
working table. The solution is the same as in Lesson 2: use a slab of
wasteboard below the block, and connect both using a few screws from below.
See the illustration below.

—Z=0.0
Z=-14.44

Note: in case of a light type of material like PUR-foam screws are not needed:
now you can use double-sided adhesive tape to attach your block to the
wasteboard and to fix them on the machine table.

Make sure that:

- the lower block (the wasteboard) has its top plane and bottom plane exactly
parallel.

- the top block has a really flat bottom surface (needed for gluing the two parts
afterwards).

- the screw tips in the upper block are well within the portion of the part that
will remain after all milling is done. Otherwise either the prototype will fall off
during the milling (in case the screws are completely outside), or the outer
surface of the prototype will be damaged (in case the screws are too long and
their tips are machined off).

Now you can fix the blocks on the machine, and enter the (0,0,0) position. For
X and Y this is done just as in Lesson 2, for the Z this is different. While in the
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previous lessons you entered Z=0 on the top of the block, now you start with
the bottom of the block (which is the symmetry plane of the bottle). Position
the tip of the tool on the same height as the bottom of the block. From there go
up 14.44 mm (for inch users: 0.57”) and set the Z=0 level there. You can read
this value 14.44 from in the DeskProto Part Information dialog box: Tab
'‘Material' shows that the minimum Z of the prototype is -14.44 (the symmetry
plane) and that the maximum Z is 0.

The Z-level of the actual top of the block is not important now: it is OK as long
as it is not below Z=0. Obviously it must not be too high either, as the cutter
must be able to remove the extra material above the model top.

In case your block really is too high you can deal with that in DeskProto, by
setting the maximum Z dimension of the Material block for this part to a
higher value.

Remember that when using the Free edition it may be needed to start with a
zero point above the top of the block as no roughing layers are present.

Now start cutting and create half a bottle. Repeat the complete milling
operation using the same NC program to get a second half. Glue the halves
together and your model will be ready !
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6. Venus (geometry: rotary axis)
Lesson Six

In the sixth lesson you will learn how to create toolpaths for a rotation axis: an
extra device on your CNC milling machine that lets the material block rotate
during machining. It is also called Fourth axis or A-axis, and it looks like the
spit on your barbecue. This lesson of course only is useful in case you have a
machine with such 4th axis. Rotation axis machining is available only in the
DeskProto Multi-Axis edition.

A model will be created of the famous Venus of Milo statue (The Louvre,
Paris), or in fact of her head only. The geometry has been scanned with a
Minolta 3D scanner, and was exported as polygon data. We may use this
geometry data by courtesy of Minolta Corporation in the USA. Because of its
size (7 Mb) the file venus.stl is not included in the standard DeskProto setup.
You can download the STL file from the DeskProto website.
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Start a New Project

This sixth lesson will again start with creating a new Geometry project and
after that take all the steps needed to go from geometry file to NC file. Only
the steps that differ from the previous lessons will be explained. In addition to
following this lesson you can use the Rotation axis milling Wizard to show
you all steps to be taken. You can also view the Rotary tutorial videos on the
DeskProto website.

The geometry file that you have to load is called Venus.stl. This file is not
present in the Samples folder, you will first have to download it from
www.deskproto.com The file is only available in mm, so inch users will have
to scale down with factor 0.03937 (Part parameters, tab Transform) — though
probably a smaller factor will be needed in order to create a scale model.

Load the file via Load Geometry file (button or File menu command).

The rotation axis on most machines is parallel to the X direction, and it is
officially called the A-axis. You can tell DeskProto that your machine has a
rotation axis by editing the machine definition in the Library of machines
(Options menu): Press button ”Rotation axes...” and in the Rotary machine
settings check “Has rotation axis”. On one side of the axis the rotary table’s
vise or chuck holds the block, often on the other side a tail-stock is available to
support its far end.

DeskProto also supports machines with the rotation axis parallel to Y. For such
machine you can check the option “Has 4™ axis parallel to Y” in the Rotary
machine settings mentioned in the previous paragraph. This will make
DeskProto ‘swap’ the X and the Y on your machine. You will see a second
Orientator on your DeskProto screen, showing the orientation of the
coordinates on your ‘swapped’ machine. All user input needs to be done in the
DeskProto orientation, the NC output will be in your machine’s orientation.
This sounds complicated, however you will get used to it real soon. As always:
use the Help button for help.

When you view the Venus geometry after loading, first thing that you will
observe is that the geometry is not orientated correctly. The most logical
rotation axis for a head is the line from neck to top (so a vertical line when
standing upright). This line now is along the Y-axis instead of along X as
needed, so you will have to rotate the geometry minus 90 degrees around Z.

When you check the part’s dimensions (Part Information dialog) you will see
that the part is very large: the unscaled geometry is 284 x 421 x 315 mm. So it
probably won’t fit inside the working area of your machine (DeskProto will
pop up an error when you try to write the NC file). You will have to scale
down, the scale factor depending the part size your prefer — and of course on
your machine’s dimensions.
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So open the Part parameters dialog, and on page Transform set the correct
Rotation and the correct Scale. Instead of scaling factors you can also enter the
desired dimensions here. Note that the dimensions are shown as they are
before rotation: the Transform options are applied in the sequence as
indicated by the numbers (0, 1, 2, 3, 4) in this dialog. So the highest dimension
of this Venus geometry will be for Y, just as in the STL file: the 90 degree
rotation is applied later.

In this lesson you will use Continuous Rotation machining, where the part
rotates during machining. DeskProto will then produce XZA toolpaths: only
the X, Aand Z axes are used. The Y-axis does not move: the cutter needs to be
positioned exactly above the rotation axis when starting to machine (Y=0.0),
and remains there all the time.

The alternative use of a rotation axis is Indexed machining. Here plain XYZ
toolpaths are applied, from different sides, with an A-rotation in-between.
DeskProto supports indexed machining in the wizard called One or more sides,
automatic rotation (The “N-sided wizard”). That wizard will automatically
generate a number of parts: one part for each side to be machined.

Use the Rotation axis

The next thing that needs to be done is to check the option Use Rotation axis
(XZA paths). This option can be found on the first Tab of the Part Parameters
dialog box. Of course this option is active only in case you have selected a
machine with such optional 4™ axis. This means that in the DeskProto machine
definition it must have been configured (obviously your actual machine must
have one too). So if this option is grayed out then go to the machine library
(Options menu) to fix this in the machine definition. In case this option is not
present at all then you are probably not using the Multi-Axis edition of
DeskProto.

Do not confuse a rotary axis with a lathe: on a CNC machine with rotation axis
the cutter rotation provides the cutting movement, the part rotates only for
positioning purposes. On a lathe the cutter does not move: the cutting
movement is provided by the part that rotates at high speed.

When you check the option Use Rotation axis a message will pop up. It tells
you that a few parameters will automatically be changed to accommodate
rotation axis machining. Most of these parameters will be discussed below.
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Center geometry:

- AR

After switching on the Rotation-Axis and pressing OK you will see that the
area to be machined (drawn in green lines) has become a cylinder. The material
block (drawn in orange lines) still is rectangular, but for rotation axis
machining the area to be machined is a cylinder, defined using a min and max
rotation angle and using a min and max radius.

DeskProto also supports a cylinder shape material block for rotary machining:
in order to use such block you need to check the option “Use cylindrical
material block” on the Material tab of the Part parameters.

After the scaling down that you just applied the part is small enough for yuor
machine, however the material block that DeskProto calculated is far too large.
See the illustration above. The geometry is rotated round the “real” X-axis in
CAD coordinates (so the axis at position Y=0, Z=0). For the Venus STL file
this rotation axis is located outside the geometry, so a very large block will
result and cause this second size error.

In DeskProto an extra option is present to solve this: on the Transform Tab of
the Part Parameters check the option Center geometry. This will result in the
rotation axis being placed though the centerpoint of the part. Now the material
block drawn on screen will be the one that you need.

Still a different rotation size error may be given here, mentioning that it is
impossible to rotate the part as it would collide with the machine's working
table. On your machine the rotation axis will be located above the working
table, and the diagonal of the material block may not be larger than the
distance between table and rotation axis. Otherwise of course the block cannot
rotate. This distance can be set in the machine definition (Library of machines),
in the Advanced settings.
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An important issue is the position of the WorkPiece Zero point. When
rotation axis machining you can select the X-position of the zero point as usual
(tab page Zero-point), however the Y cannot be changed (Y is not used) and for
the Z fewer options are available. We have seen that in practice two different
conventions are used for Z: the workpiece zero point can be either exactly on
the rotation axis (so inside the block) or on the top surface of the block. So for
Z you can choose between “Make top of block zero”, setting the Z=0 at the
outside surface of the block, and “None” which will set the Z=0 exactly on the
rotation axis.

As said in the message-box just mentioned DeskProto has already set the Z
Translation to None: Z=0 is with the tip of the cutter on the rotation axis (the
convention most used). The result can be seen in the Part Information dialog
(with “Use translated coordinates” checked), and also (easier) in the position of
the blue cube (the “Orientator on the WorkPiece zero point”) on your screen.
Make sure to set this WP zero point on your machine accordingly: an incorrect
setting may damage part, cutter and/or machine !' When setting the zero point
on the top of a cylinder block make sure to do so at Y=0, and when doing this
on the top of a rectangular block make sure that the block is at A=0 with a
horizontal top surface.

Three more parameters have been changed automatically.

In the Part parameters the default Support tabs have changed. For rotary
machining two cylinder support tabs are used: extra material left and right, to
connect the block to the rotation axis unit on the left and to the tail-stock on the
right. As the Venus geometry has one flat side (now on the left) and is
sufficiently stable to be machined without tail-stock such tabs are not needed
for this project.

The Area to be machined (Operation parameters) has been set to “Use
material block above rotation axis”. When rotating the geometry the actual
content of this “upper half” will change all the time, so this setting will cover
the complete part (at least for most geometries).

The Borders (Operation parameters) have been set to ‘No extra’, for all
operations. You can find this parameter on the Borders tab of the Operation
parameters. Its normal value is ‘Extra for cutter’, as normally all outside
surfaces of the model need to be machined. For rotation axis machining the
part needs to remain connected to the rotation axis unit and to the tail-stock. So
the outside surfaces left and right may not be machined, which is achieved by
this setting. Note that when you use support tabs the borders may remain set to
Extra for cutter.

When the rotation axis is used, in the resulting NC file the Y-coordinates (in
mm or inch) are replaced by A-coordinates (in degrees). Note that DeskProto
replaces Y by A, so what you do in fact remains three axis machining. In
DeskProto you can choose to use either XYZ (normal) or XAZ (rotary);
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DeskProto will not use all 4 axes simultaneously. Nevertheless DeskProto
offers you full 3D use of the A-axis: not just wrapping some flat 2D toolpath
(sized 360 mm) around a cylinder by simply replacing Y by A, but real 3D
toolpath calculations around a 3D CAD geometry.

The use of an A-axis also influences the Min and Max settings of the Material
block. For XYZ machining these values simply define the outer limits of the
block. For rotation axis machining this is different.
Three block shapes are available:

e Cylindrical, centered

*  Rectangular, centered

*  Rectangular, eccentric

For each block shape the available settings are different:

Min and max X values work the same as for XYZ machining, for all
three block shapes.

® Min and max Y values for a centered rectangular block have
opposite values (only the Ymax can be set). For an eccentric block
both Ymin and Ymax can be set, for a cylinder block Y can’t be set.

® Min and max Z values for a centered rectangular block have
opposite values (only the Zmax can be set). For an eccentric block
both Zmin and Zmax can be set, for a cylinder block Z can’t be set.

®*  The R-values can be set only for a cylinder block (for a rectangular
block they show the diagonal of the block). A Min R above 0.0 will
result in a doughnut shaped block, R values below 0.0 are not
permitted.

The Min and Max settings for the Area to be machined are different as well,
though these are the same for all three block shapes.
®*  Minand max X values work the same as for XYZ machining.
®  Minand max Y values and Z values cannot be set.
*  The R-values by default will have been set to “Use material block
above rotation axis”, as just explained. For a Custom area a Min R
above 0.0 will result in a doughnut shaped area, a Min R below 0.0
will result in toolpaths below the rotation axis.
® The A values have to be set in degrees between O and 360,
permitting you to machine a wedge-shaped area (a piece of pie)
instead of machining all around the block.

In review, in order to prepare the Venus geometry for machining the following
settings have been made:

- Load geometry Venus.stl

- Check “Use rotation axis”

- Rotate -90 degrees around the Z-axis

- Check “Center around rotation axis”

- Scale down the geometry until it fits in your machine.
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Fine-tune the parameters

Basically the DeskProto parameters can be used for rotation axis machining
exactly as they are for standard XYZ machining. A few exceptions though,
which will be explained in this paragraph.

As said before, all parameters concerning the A-axis are in degrees instead of
in mm. This does not apply to the precision settings though: for toolpaths in the
X-direction the Distance between toolpaths should be in degrees, for toolpaths
in the Y (A)-direction the Stepsize should be in degrees.

However, as degree values are difficult to imagine, DeskProto hides these, and
asks for values in mm or inch instead. These will be converted to degrees at
maximum radius of the Area to be machined, so at the outside of the cylinder,
after which DeskProto will internally use the degree values. This means that
the actual mm values that are used will in most cases be smaller than the values
that you entered, as most movements are closer to the rotation axis. Very close
to the rotation axis the steps in mm would become very small: DeskProto will
then automatically skip some of the steps.

With 3-axis XYZ machining the tool cannot mill the bottom side of the part, as
during machining the part will remain resting with its bottom on the working
table. For rotation axis machining the part fixturing is more complicated: it is
possible to completely cut your model loose from the machine, making it fall
down during machining. The resulting model then would both be damaged and
unfinished. DeskProto will take care that this does not happen, by assuring that
some connection will remain present between the rotary table and the model,
or rather by popping up an error dialog if such connection is not present.

A valid connection can be accomplished in several ways. For models with a
flat side, like the Venus head in this case, you can make sure that this complete
side surface remains un-machined (and thus connected to the rotation axis
vise). This can be done, as explained above, by switching off the borders
(Operation parameters, tab Borders).

Next you can decide what to do with the right side (top of the Venus head):
machine it or not, depending on whether you want to use a tail-stock or not.
You can do so by changing the max X value of your material block. Which is
in fact a trick to manually add a ‘border area’ at that one side only.

Without such flat surface you may want to define two support tabs (when
rotation axis machining has been selected the default supports will be two
cylinders).

For this Venus lesson :
- switch off the Borders to keep the left side connected to the rotary chuck.
- do not use support tabs
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- do not use the tailstock: only the left side is stable enough for this small part.
- make the Material block’s Max X a bit larger to allow the cutter to
completely machine the head even with the Borders switched of (in fact you
then manually add a border on that side).

4

]

b Em E3
ROTATE PAN I00M

When rotation axis machining the minimum Z boundary of the Area to be
machined requires extra attention. As just said: the Z-min has been set to 0.0
(choice “Use material block above rotation axis”), as for most geometries the
cutter does not need to travel lower than the rotation axis.

This is not true for all geometries though: for instance when machining an
empty box, see the illustration above. It will be clear that for such geometry the
cutter needs to travel below the rotation axis in order to machine the inside of
the box, so to a Z-level below 0. Thus, you have to set a Min Z value below
Z=0. In such cases take special care then when setting the workpiece zero point
on your machine: this has to be done VERY accurately, or you will see marks
(a ridge) where the toolpaths cross the Z=0 level. Reason is a small error (for
instance 0.2 mm for Y=0) will be present on the other side of the rotation axis
when the cutter travels below 0, resulting in a ridge of 0.4 mm high.

The screenshot also illustrates the presence of undercuts for rotation axis
machining. Undercuts are areas where the cutter cannot reach. For XYZ
machining the cutter cannot reach the bottom side of an object. For rotation
axis machining this is different: see the three toolpath lines (in red) drawn in
the picture above. Only the X, Z and A axis will move: the Y-position is
constant, with the cutter positioned exactly above the rotation axis. This means
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that the cutter cannot completely empty the box: it simply cannot reach two of
the vertical walls on the inside of the box. The V-shaped toolpaths that are
drawn illustrate this. For this geometry it will be better to machine from two
sides, using 3-axis toolpaths for each side. The rotation axis then is used
between these two operations: indexed machining.

Finally: perhaps you want to use toolpaths in the A-direction, combined with
either conventional or climb machining. This way the rotation axis can remain
rotating in the same direction (for instance from 0 degr. to 360, next 360 to
720, etc). This is possible only when in the machine definition (Options menu)
the option “A-values may exceed 360” has been checked. Then the axis will
keep rotating in the same direction. Unless of course the milling direction is set
to Meandering (Operation Parameters, tab Movement), in which case the
machine will keep cutting in both rotation directions.

When this option (A-values may exceed 360) is not checked (as not all
machines support this) then for Climb or Conventional machining after each
toolpath the cutter will move up to Zfree safe height and travel back to 0
degrees to start the next toolpath. In fact the same as what happens with XYZ
machining.

A great extra feature is the Helix option: a checkbox for strategy Parallel
(Operation parameters, tab Strategy). This checkbox is active only for
toolpaths around the A-axis and when continuous rotation is in one direction
(as described above) has been configured. Without this option checked the
toolpath will complete a full 360 degree rotation with a constant X (only A and
Z vary), move X to the next toolpath, complete the next toolpath at constant X,
etc. With the Helix option checked both the X and the A coordinate keep
progressing all the time, so the complete part will be machined with one
continuous movement (X, A and Z varying). This will be faster, produce a
smoother movement and solve any backlash problems for X and/or A.

When combining continuous rotation with roughing layers a disadvantage is
that Sorting becomes quite ineffective, as most sorting optimizations require a
meander toolpath direction. So our advice is not to use the helix when
roughing layers are present.

This was a lot of background information on rotation axis machining (thanks
for your attention!), most of which is in fact not needed to complete this Venus
model but may prove to be useful later.

When you new calculate toolpaths the result will look like the paths in the
picture above, depending on your choices for scaling, cutter, precision, etc.

Page 109



Desk Proto Tutorial

I
a

e =

AOTATE 0 fd

The picture shows a Roughing operation. You can clearly recognize a series of
circle toolpaths forming a cylinder: the first layer. For this rectangular block
the layer depth is taken from the corner of the block. The gray dashed lines are
the positioning movements in the lower layers, skipping any area that has
already been machined. The bottom surface (left side) of the statue remains un-
machined: this provides the connection with the rotation axis.
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An optional next step is to show a simulation: the image above shows the
simulation for the roughing toolpaths in the previous image. As for this
roughing operation the toolpath distance is large, the cups between the
toolpaths in A direction are clearly visible in the simulation.

Just as for plain XYZ machining it is advised to first do a Roughing operation
and after that a Finishing operation. The rotation axis wizard will do so
automatically for you. For more information you can watch the Venus tutorial
videos on the DeskProto website.

To the milling machine

Again it will be clear that the instructions given here cannot be very accurate,
as a detailed set of instructions would be different per machine. Still a number
of appropriate general remarks can be given.

First you have to set the WorkPiece zero point. With the default translation
settings this will be on the left side of the cylinder block (X=0), with the tip of
the cutter exactly on the rotation axis (Y=0, Z=0). A=0 is important as well
when you are using a rectangular block

Setting X=0 and A=0 is easy: move or rotate to the correct position and tell the
machine to use that as zero. Setting Y and Z is more difficult as it is not easy to
see if the tip is exactly on the correct location. Some machines offer a
calibration help, like a horizontal surface at the correct Z-value. If not you can
try to visually find the zero positions as accurately as you can. That will be OK
for this Venus statue, however insufficiently accurate when for your part the
cutter needs to travel below Z=0.

A good help to accurately set Y=0 and Z=0 is to machine a small calibration
cylinder: fixture some material, mount a flat tipped cutter, and switch the
spindle motor on. Then move the cutter to Y=0 and Z=+10 (after having set the
zero point roughly) and next perform a full rotation (A 0 to 360 deg). The
result will be that you have machined a cylinder. Now measure the diameter of
the cylinder: it should be 20 mm. If it is not then you can correct your Z=0
position accordingly. Say it is 21.4 mm: 1.4 too much, meaning that the current
Z=0is 0.7 mm too high.

You can then use the same cylinder to calibrate Y=0: let the cutter touch the
cylinder both on the front side and on the back side and write down both
‘touching' Y-values. They should be opposites: identical but for the minus sign.
If not, then correct your Y=0 accordingly.

This is a lot of work: the bright side is that you need to do this only once: the
same zero point will be valid for a next job as well.

Note that with this zero position you must take care not to let the cutter move
to the workpiece zero point - which is a standard command on many machines:
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this will damage your cutter and/or your material as this point is inside the
block!

In case you have used translation method “Make top of part zero”, the Z=0
needs to be with the tip of the cutter touching the top of the material block.
Now it is critical that the block has exactly the correct dimensions: otherwise
the resulting part will be too thick or too thin. When touching the top of a
cylinder block the cutter has to be at Y=0, and when toughing a rectangular
block the top surface has to be completely horizontal.

Next you will have to fixture your material block, using the available options
of your rotation axis, like a 3-jaw chuck, pins on a circular plate or a drill-head.
Use the tail-stock with a centering pin on the opposite side if one is available,
as this makes the stability of the model much better. Not for this Venus model
though: we have set the toolpaths to completely machine the top of her head.
For machining rings (in wax, for investment casting) you have to use some
special fixturing tool, or use a hollow wax bar that can be fixtured in a 3-jaw
chuck.

A detail that you need to check only once is the Rotation direction of your A-
axis: will it rotate clockwise or counterclockwise for a positive value of A. We
have found that no clear standard direction exists: each manufacturer makes his
own choice. So the DeskProto default will be correct for about half of the
machines. If not the resulting part then will be a mirrored image of the CAD
file. You can correct this in the DeskProto postprocessor: Options > Library of
postprocessors > OK on warning > select your post and press Edit > Tab
Movement > add a minus sign to the value in edit box “Factor” in column A.

Many controllers have problems in setting the correct Feedrate when rotation
axis machining, as the rotation speed that is needed to achieve a certain linear
speed depends on the distance between the cutter and the rotation axis.
DeskProto offers two special options for the rotary feedrate: in the
postprocessor you can configure DeskProto to use “Inverse time Feedrate” or
“Angular Feedrate” for rotary movements. For more information about this see
the Help file and the FAQ on the DeskProto website.
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Finally: before starting the NC program file from DeskProto, do make sure that
your cutter is positioned on Y=0. As said in fact DeskProto remains 3-axis
CAM software, so the XZA toolpath file from DeskProto does not contain any
Y movement command. Y has to be correct before starting.

The machining process will look like the photo above. Note the cylinder form
created by the first layer. After machining you can remove the remaining block
on both sides using a simple saw or band-saw

A picture of
the result :
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7. Cellphone (geom: two-sided)
Lesson Seven

The seventh lesson is about machining a model from two sides. In DeskProto
this is easy, as the Two-Sided Milling Wizard will guide you through this
complete process. Because of this wizard this lesson does not need to show all
details: it will only illustrate and explain what the wizard will ask you.

The two-sided milling wizard is not available in the DeskProto Free edition
and Entry edition.

The example used is the front panel of an old cellphone. It is not from an
existing phone, but has been specially modeled for this lesson by John Brock
of Robert McNeel & Associates, using the Rhino 3D CAD software that
McNeel manufactures. Also the rendered picture above is courtesy of Robert
McNeel & Associates.

The cellphone STL is a large file (8 Mb), so it is not included in the standard
DeskProto Samples. You can download the file from www.deskproto.com
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Two-sided machining

In this seventh lesson you will use DeskProto’s Two-Sided Milling Wizard to
correctly set all parameters needed to machine a part from two sides. The
wizard is meant to be very easy to use, even self-explaining, so in theory this
lesson is completely superfluous. Still in practice the process is quite complex:
so we felt that illustrating and explaining what you will need to do will make
things easier.

Start the DeskProto wizard, to be found via the Start screen or via the File
menu. Take care to start the 'normal’ wizard: the “custom wizard” is meant for
some special applications. On the first screen (called “Which wizard”) select
the wizard named Advanced Geometry: Two sides, manual flip.

The alternative for two-sided machining is using a rotation axis for an
automatic flip. Advantages of the manual flip are that no rotation axis is
needed, and that the block is more stable as it lies on the machining table.

This wizard is a sequence of 7 pages, as indicated by the icons on top. In
addition to this first page (which wizard), these are:

2 What to machine

3 Material and Support

4 Roughing

5 Finishing

6 Contouring

7 Send to machine.

Generally speaking, when milling a model from two sides the problem is the
second side: how to fixture the model, and how to do this in the correct
orientation for that side, at a position that matches the WorkPiece Zero point.
The DeskProto Wizard solves this by using an over-sized material block, so
large that a complete frame remains present around the part. Four small bridges
are added to keep the part connected to this frame, called Support tabs. These
can be manually removed later. See the illustration above. This frame makes it
easy to re-fixture the model for the second side, and the wizard also uses the
frame to set a repeatable workpiece zero point.
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The two-sided Wizard

On page What to machine (Page 2) first load the geometry file Cellphone.stl.
Note that this file is not installed during setup. You will first have to download
the file from www.deskproto.com. The file is only available in mm, so inch
users will have to scale down by a factor of 0.04 (more exactly 0.03937). Load
the file using the Browse button on this wizard page.

Two more options are offered on this wizard page: Scaling and Rotating. For
metric users Scaling is not needed as well (unless of course you want to make
a scale model). As said inch users have to apply a scaling factor of 0.03937
(uniform scaling). For the Cellphone the Orientation may remain as default,
with the top surface on top: rotating the geometry is not needed. Note the light
yellow question mark icon, left of each question: position the cursor on this
icon to get help on the question. The Wizard tooltip that will pop up also tells
you where that same setting can be found in the dialog based interface (so
without the wizard).

Page Material and Support (Page 3) will add the support tabs (as explained
above) and will set both the Material block and the Area to be machined. The
wizard will select ‘Default support tabs’ in order to add four tabs, at the
minimum and maximum X and Y values of the part. The thickness of these
tabs depends on the size of your model, their length depends on your default
cutter (the tab must be long enough for the cutter to move around the model).
When you later select a thicker cutter the wizard will warn you about that. For
more control you can also select Custom and use the Detail settings button to
define your own support tabs.

The Dimensions of the material block are set by the wizard: both right and
left 25 mm (1") is added to the size of geometry + supports, on the front and
back sides 10 mm (*2") (You can change the size of these additions in the
Preferences). On the right and left side the frame is made wider as there extra
room is needed for the clamps to fixture the block on the machine. The wizard
only allows you to change the Z-dimension here: the block’s thickness. The
value that you enter has to exactly match the actual block thickness, otherwise
the two sides won’t match correctly. In practice this is easy, as most materials
will be delivered in slabs of an exact thickness. The X and Y dimensions of the
physical block may have some oversize.

The Milling depth is in fact the setting “Minimum Z” for the Area to be
machined (Operation parameters). The same depth will be used for all
operations. Default depth is halfway down the block: for the cellphone
geometry a higher depth value is needed in order to completely machine the
geometry. Do not forget to change a custom depth after changing the block
thickness, as the depth is relative to the top of the block. Dimensions and depth
will be drawn on screen as line drawings: orange lines for the block, green
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lines for the area to be machined (updated after pressing the Apply button).

We used a slab of tooling board of 25 mm thick, and set the milling depth to 17
in order to completely machine the part from both sides. You can change the
drawing to a side-view and then in the wizard press Apply to check if the
milling depth setting is correct.

Page Roughing (Page 4) offers the setting for the Roughing operation. The
first is the Use checkbox: roughing is optional, and you can skip this operation
by un-checking this box.

Which Cutter to choose is an optimization between many factors:

- cutting speed (a larger cutter can remove material more quickly)

- geometry characteristics (for freeform surfaces use a ballnose cutter, for
horizontal and vertical surfaces use a flat tipped cutter).

- surface quality (a larger ballnose cutter will create a smoother surface)

- small details (for small inner radii a small cutter is needed)

- height of the model (small cutters are short)

- use the same cutter for all operations or accept a tool change.

For this cellphone part we have used a 3 mm ballnose cutter (radius 1.5 mm),
for all operations, in order to avoid a toolchange. 3 mm diameter is sufficient
for most details here, and the cutter is long enough to machine the complete
model. For inch users a 1/8 inch diameter ballnose will be a good choice.

The Precision (horizontal Distance between toolpaths) together with the Layer
height (how deep the cutter may sink into the material) determine how much
material is removed per toolpath. The default values of D/5 for precision and D
for layer height (D is the cutter diameter) will be OK for wood and tooling
board. The default Speeds will do as well. For light materials (foam, light
wood) precision D/3 will do, for materials like perspex and aluminum smaller
values will be needed. You will have to find your own optimal values.

The default Block strategy is the optimal roughing strategy for most
geometries, as it will minimize the number of positioning moves during the
lower layers.
The default Skin thickness is 10% of the cutter diameter, and the default
Layer height is 100% of the cutter diameter. In most case these values will be
OK as well.

The field for Estimated machining time is empty: the estimation will be
shown after you have calculated the toolpaths using the Calculate button.

Wizard pages Finishing (Page 5) and Contouring (Page 6) are very similar to
the Roughing page just discussed. Of course without the Roughing parameters
Skin and Layer height. Also a different Strategy has been selected. You will use
a much lower precision value than for Roughing.
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The illustration above shows the Finishing toolpaths for Side 1. In this drawing
you can clearly see that the support tab is not cut off, so the part remains
connected to the frame. The wizard has accomplished this by skipping the
‘Ambient area’: the area around the part.

The roughing operation though has machined this ambient area, in order to
create space for the chips. The Area to be machined has been set to custom,
with the min and max limits for X an Y copied from “Use geometry area”
(otherwise the complete block would be done), and the min Z limit defined by
the machining depth that you set. As the Borders have the default setting
“Extra for cutter” the cutter can freely move around the part, except where the
support tabs forbid this.

The final page of the Wizard is Send to machine (Page 7). It will show you
the project tree that has been created: two parts (Side#1 and Side#2) with three
operations each. The difference between the two parts is a 180 degree rotation
round the X-axis, just as you will later rotate (flip) the block on the machine. In
case you want you can rename any of the names after a slow double click on
its line in the Tree.

In this wizard two buttons are available to Save the NC program file: one for
each part. Choose file-names that indicate which side of the part it is for.
Buttons to directly send the toolpath to the machine are visible only if that
option has been configured (in the Preferences). These can of course only be
used when your machine supports this option. The Send to machine option is
not present in the versions for MacOS and for Linux.
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The Report file that you can write is special for this wizard. The report will list
all information that is needed on the milling machine to correctly process these
two NC program files. This will be explained in detail in the last paragraph.
For now just open this file and print / save it as you will need it later.

Fine-tune the parameters

You have now finished the Wizard and created two NC program files, so you
are ready to start your milling machine and create the model. Still it is
important for you to know that at this point, after having finished the Wizard, it
is still possible to edit any parameter setting that the wizard has made, and
even to add any special parameter setting that could not be done in the wizard.
Of course after any change you will have to again write the NC program
file(s). If you do not need any changes you can skip this paragraph and
continue with the next: “to the milling machine”.

The wizard has created three operations for each side. You may want to add
one or more additional geometry operations. For instance a Detailing operation
with a very small tool (diameter 0.8 mm or 0.03") for the microphone and
speaker slits. In these extra operations you can change the Area to be machined
to Freeform, and select two small areas to be machined. A next addition may
be useful for the second side: adding an operation with a flat tool (2 mm
diameter), as the inside geometry contains many sharp inner corners.

When adding operations you have to be careful: in the new operation the Area
to be machined may not be larger than the area of the existing operations. The
best way to add an operation is by Copying an existing operation.

In the Part parameters you must not change the size of the material block, as
this size is needed to exactly match both sides and set the WorkPiece zero
point. This WP zero point will be the same for all operations in the part. The
support tabs may be changed, though then all NC files need to be calculated
and saved again. Obviously the support tabs for both sides must exactly match,
and to avoid any differences DeskProto has selected the option “Use tabs of 1st
part” in the second part.

The Simulation that DeskProto offers for a two-sided project is a separate
simulation for each side. A combined simulation, showing the result when both
sides have been machined, is not (yet) possible.
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To the milling machine

Normally, it does not really matter where on the machine’s working table your
block of material is located as you can freely choose the workpiece zero point.
It also does not matter whether or not the block is exactly lined up with the
machine’s axes (as the block will have some oversize). For two-sided milling
this is different, as for the second side both position and orientation of the
block must exactly match position and orientation of the first side.

For this aim this DeskProto wizard proposes use a ruler, mounted on the
machine's working table, exactly parallel to the machine’s X-axis. See the
illustration below: the long purple ‘horizontal’ bar is parallel to X, with an end-
stop at the left side of the ruler. An easy way to create ruler and end-stop is to
simply machine them using manual control: that way they are sure to be
parallel, and their positions are exactly known.

o

The WorkPiece zero point for the NC program files has to be set at the point
where ruler and end-stop meet (the cross-hairs in the illustration above), the
Z=0 set with the tip of the tool touching the top of the block. As said this is for

both sides: the WP zero point remains the same after turning the block upside
down for the second side.

After machining the first side, you have to machine two reference planes, on
the block’s back and left side: the two red lines in the illustration above. The
reference plane on the left is on position X =0, so at the exact position of the
end-stop, and needs not be along the complete side (which would not be
possible because of a clamp). The reference plane on the back is on a Y
position as specified in the Report file that you just saved, and needs to be
machined along the entire back edge of the part. It needs to be bit deeper than
the ruler is thick.

You can machine both reference planes using manual control (mind the radius
of the cutter when doing so!). DeskProto does not machine these reference
planes automatically, as it does not know where you have placed your clamps.
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For instance for a cutter of 6 mm diameter: move the cutter to X=-3 and a
suitable Z, and then move the Y to machine a flat plane on the left side of the
block. Next move the cutter to the prescribed Y-position + 3 mm (cutter radius)
and move the X to machine a reference plane along the complete backside of
the block.

After machining these reference planes you can loosen the clamps and take the
block off, turn it upside down (“flip” the block), press these two reference
planes against ruler and end-stop, and again fasten the clamps. This makes sure
that the block is exactly lined up with the machine, and is exactly at the correct
position.

As alternatives to the Ruler /Reference plane method just described, several
other methods are available to correctly position the block after turning upside-
down. For instance using Reference Pins on the machining table, and drilling
holes to exactly fit these positioning pins, with the zero point exactly halfway
these two pins. Or a rotation axis with a 180 degree rotation around X. The
Two-Sided Milling Wizard can be used with any of these positioning methods,
as long as they result in the block having the same position before and after
turning upside-down

Below you can see a few illustrations that show this process for the Cellphone
model.

In this illustration the first side of the cellphone is being machined. Note the
dark brown ruler in front and left, and the two clamps right and left used to fix
the block. The cutter currently is machining the second layer.
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Before loosening the clamps, first you have to machine two reference planes
on the left and on the back, as shown here. This is why some oversize is
needed on the back side of the block. Also the left side of the block needs to be
a bit inclined to have some excess material (body) to be machined.

The second side now can be machined using the same workpiece zero point:
the toolpaths will exactly match.
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The resulting cellphone front cover: fresh from the machine, without any extra
work done. Note the two machined reference planes and the support tabs
(bridges): both clearly visible. The frame and tabs have to be removed
manually: some sanding will be needed where the support tabs were attached
to the model. The rest of the model will already be smooth enough.
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8. DP bottle (vector: advanced)
Lesson Eight

The lessons so far have all been about Vector data or Geometry data or
Bitmap data. A very nice feature of DeskProto is that you can combine two or
three data types in the same project. For instance use vector toolpaths to
machine some details in a geometry project.

DeskProto even allows you to let two data types interact: both vector toolpaths
and bitmap reliefs can be projected on a 3D geometry. In this lesson the 2D
DeskProto logo will be projected on the 3D bottle geometry that was used in
lesson 5.

The lesson starts with some background information on vector data and
toolpath types for vector data.
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Vector data files

For vector data files DeskProto supports the DXF format, the EPS (or Al)
format and the SVG format. Engineering software will typically generate DXF
files, while graphics software in most cases only can export EPS (postscript).
SVG has been developed to be used on websites. For all three file types only a
subset is supported:

The DXF subset includes point, line, polyline, LW polyline, arc, circle, ellipse
and spline.

The EPS subset includes point, lineto, curveto and moveto.

The SVG subset includes line, rect, circle, ellipse, polyline, polygon,
elliptical_arc, cubic_bezier and quadratic_bezier

DeskProto will convert arcs and splines to polylines, as arc movements in the
NC code (G2 and G3) are not (yet) supported.

Vector files in most cases are 2D files, so they will not contain any Z
coordinates. DeskProto will draw such 2D curves at the top of the block, also
when for that part you have set the Z=0 at a different height (this is different
from previous DeskProto versions). The machining depth that you enter for the
toolpaths is calculated from the top of the block.

It is also possible to open a DXF file containing 3D vector curves. In that case
when you load the file DeskProto will ask you whether or not you want to use
these vector Z-values. If yes, the Z=0 in the vector file will be aligned with the
Z=0 of your Geometry data, and the machining depth that you enter for the
toolpaths will be calculated relative to the Z-values in the vector curve. The
result will be a 3D toolpath.

The decision whether or not to use the vector data Z-values can also be made
later: in the project parameters, tab Vector.

DeskProto offers four toolpath types: Profiling, Pocketing, V-Carving and
Drilling. The first two have been covered in Lesson 1, V-Carving in lesson 4,
Drilling has not yet been mentioned. In the Vector operation parameters you
can select curves for each toolpath type:

Profiling will accept all curves in the vector data, except points.

Pocketing will only accept curves that are closed (contours).

V-Carving will only accept curves that are closed (contours).

Drilling will accept: points (centerpoint of the hole to be drilled), “+” signs
(two lines that each have the cutter diameter as length, intersecting at the
centerpoint) and circles that have (almost) the same diameter as the selected
cutter.
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Combining 2D vector data with 3D geometry data

In the previous lessons you have seen that the Part parameters are used to
define what will be machined: scale, orientation, etc. The available parameters
to achieve this are a bit different for each of the three data types, for instance
rotating round X and Y is not supported for vector data. So the Transform tab
offers different options for vector en for geometry. What to do when both data
types are present ?

DeskProto has solved this by showing two sets of settings: Vector settings and
Geometry settings, which will be shown in this lesson (if bitmap data is present
the Bitmap settings are the third set that is present).

For this project we need two types of CAD data: Vector data for the DeskProto
logo, and a Geometry for the perfume bottle.

I@ First load the Vector file: sample file 2D_DeskProtoLogo.dxf

Next load the Geometry file: the same file Bottle.stl that we have also
used in Lesson 5.

You will see that the block of material (the orange lines) will be exactly large
enough to include all CAD data, and that the vector curves are displayed at the
top surface of the block.

4

The X and Y position of both datasets matches their positions in the original
CAD file. For the bottle the zero point in CAD (and also in STL) is located on
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its centerline, and for the logo it is located on it’s base-line just left of the letter
D. The Z=0 in CAD is located below the bottle, in DeskProto you can display
this zero point by checking “Untranslated zero point” in the Items visible
dialog (though in the above view it will be hidden below the bottle geometry).

The WorkPiece zero point in DeskProto (the blue “orientator” cube) is not the
same as this untranslated zero point because in the Part parameters (tab Zero-
point) an automatic translation is made to move the CAD data to “Positive
X&Y for material block™ and “Top of block zero”.

D2 part Parameters - 'Part’ X

Show tebpages for: (@) Vector settings
D Geometry settings

General Transform Material Zero-point  Simulation

When you now open the Part Parameters dialog you will see that above the
row of tabs a new “Radio button” option has been added: you now can choose
to show the tabpages either for the Vector settings or for the Geometry settings.
Some of the tabs are equal for both settings, like tab General and tab Zero-
point), other tabs are different (like Transform). The Geometry settings also
include more tab pages than the Vector settings.

The options on tab Transform can be used to position both datasets relative to
one another, as will be shown in the next paragraph.

A nice detail is that vector machining can also be used with rotation axis
machining: the 2D vector drawing then will be wrapped around the 3D
cylindrical block of material, like a label around a jar of marmalade. That way
it is easy to engrave for instance a name on the round sockle of a bust that you
have machined. DeskProto also offers an option to not wrap the vector curves,
which can be used if the vector data already is 3D.

Projecting 2D curves on a 3D geometry

As you have seen in Lesson 1, DeskProto’s vector toolpaths can be used to
engrave 2D text on a flat surface. This lesson will show you how to engrave on
a curved surface. This will be done using a nice feature of a DeskProto Vector
operation: the option “Project vector curves on 3D Part geometry”. When you
check this option the resulting Machining level (Z-value) will not be relative to
the top of the block (so at a constant Z-level), but instead it will be applied
relative to the Z of the part-geometry at that location. The result will be that the
vector curves are indeed projected on the 3D geometry.

You have just loaded Vector file 2D_DeskProtoLogo.dxf (the DeskProto logo)
and the Geometry file Bottle.stl (the perfume bottle). In this paragraph you will
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learn how to engrave this logo on the bottle’s front surface.

Open the part parameters and select the Geometry settings. On tab Transform
enter a Rotation around X of -90 degrees, and on tab material select “Use
upper half of geometry”. After each change you can use the Apply button to
see what happens. Ignore the message that no curves have been selected, we
will come to that in a moment.

Next select the Vector settings. The DeskProto logo is too large for the bottle,
S0 it needs to be scaled down. On tab Transform enter a Scale factor of 0.5
(Uniform checked, so both for X and for Y). The next step is to correctly
position the logo over the bottle. This is called “panning” the vector data over
the geometry data, and a nice Align option is present to make this easier. Select
a Top view (the first of the 8 cube buttons on the toolbar) to properly see the
position of the logo. Now on the same tab Transform, under Panning, use the
button “Align to...”. In the Align Vector Data dialog select “Center” both for X
and Y, select Geometry data to align with and press OK. In the Part Parameters
press either Apply or OK to see the new position of the logo.

The DeskProto logo is nicely centered over the geometry. If needed you can
now fine-tune. Perhaps a bit smaller is better: you can change the scale (after
that you will need to again align). And the position could perhaps best be a tiny
bit to the right (to visually compensate for the large D) and a bit lower on the
bottle (to engrave only on the front surface, not on the shoulder). It is easy to
play around by changing the two Panning values and then pressing Apply.
When Scale and position are OK press OK to close the Part parameters.

To machine this part you will need one or more Geometry operations and one
Vector operation. How to configure the Geometry operations (roughing and
finishing, or finishing only if you prefer that) has been covered in the previous
lessons, please go there if you need help in doing so.

Adding Operations can be done by right-clicking on the line Part in the Tree,
and then selecting “Add Vector/Geometry/Bitmap operation”. Add operations
to create a Part with one (or two) Geometry Operations and one Vector
Operation, and then enter the Geometry operation parameters that you prefer.

Now open the Vector Operation parameters dialog. All geometry inside the
logo’s contour lines needs to be removed, which is called Pocketing, so on tab
“Pocketing” select All for select curves, and Offset as strategy. It will be clear
that you need a small cutter to fit inside the curves, so select a 1 mm diameter
cutter (ballnose or flat tip). Press OK to close the Vector Operation parameters
dialog, make the Geometry operation(s) invisible by clicking on the yellow
lamp buttons in the tree, and press button Calculate toolpaths (in case asked:
Yes, only the visible operations).

You will now see the logo will not be completely machined: no (red) toolpath
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lines are present in the smaller logo sections, as even this small cutter is too
thick to fit in the pocket there. You can of course select a smaller cutter,
however you will soon see that for this project a 0.5 mm diameter cutter (or
smaller) is needed: very, very thin !

Best solution is to use a conical cutter. Also called V-cutter, as the tip looks
like a V. This VV must have a flat tip, as otherwise pocketing is not possible. The
only conical cutters with a flat tip that are standard available are the
123WaxRing cutters. Select for instance cutter “Conic 123waxRing cutter (20
degr incl)”. You also need to change the Stepover, on tab Pocketing, under
Strategy detail settings. Default Stepover is 50% (of the shaft diameter),
changing that to 5% will fill the logo with toolpaths, very close to one another.

In a top-view the toolpaths that you now have may look OK, however when
seen from a different viewpoint it is clear that they are not: all toolpaths still
are at a constant Z-level. Again open the Vector Operation parameters, now
open tab page Z-settings. Here as machining depth set -0.3 mm (-0.01"), check
“Project vector curves on 3D Part geometry” and as Calculation precision
set 0.1 mm (ca 0.004”).

Now the toolpaths should be OK to engrave the logo.

On your screen they will be invisible though, as they are below the surface of
the bottle geometry. Switching off “Geometry, rendered” in the Items visible
dialog will make the toolpaths visible. You can now save the NC file(s) and
start cutting.

The image above has been tricked: we have set the machining level to +0.1
mm, in order to make a picture with toolpaths and geometry both visible (these
paths are of course not useful for machining).
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The projection used is vertical, which will distort the 2D logo: a circle
projected on a tilted surface will become an oval.

On these tilted surfaces the logo may also be distorted by the cutter's thickness.
DeskProto will project the 3D shape of the cutter on the 3D geometry, and
when projecting on tilted surfaces the outside of the cutter will touch the
geometry before the center of the cutter does. The cutting depth is set from this
first contact, so not for the center of the cutter.

For fonts that have sharp corners in each character (for instance Times New
Roman) the best engraving results can be achieved using V-Carving: see lesson
4 in this Tutorial.
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9. Lithophane (bitmap: advanced)
Lesson Nine

Creating lithophanes is a great application of DeskProto’s bitmap machining
feature. In this lesson we will explain what a lithophane is, and how you can
easily create one using DeskProto. We used a famous portrait by Dutch painter
Johannes Vermeer: Girl with a Pearl Earring (a public domain work of art,
downloaded from commons.wikimedia.org).

DeskProto can convert the 2D bitmap information in this photo to a 3D relief
and then calculate toolpaths over this geometry.

The second subject of this advanced bitmap lesson is about combining a
bitmap relief with a 3D geometry. Again the sample perfume bottle will be
used, and in this lesson the relief of a shell will be added to the bottle’s front
surface.
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Lithophanes
A lithophane is a work of art created in a thin slab of translucent material (a

sort of “milk glass”). The front-side of the lithophane is shaped in a relief, and
when illuminated from the back side a clear image in black&white will

become visible.
7
o
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Lithophane:

The above image explains how this works: the thinner the material, the more
light can come through. The material can be a sheet of (for instance) 3 mm
thick white plastic (PE, PVC, Corian, ...). In DeskProto it is very easy to
convert any photo to the relief that is needed for this visual effect. You will see
that the results are truly amazing, and that this will allow you to create unique
bespoke presents. On the DeskProto website you can view video tutorials
about machining lithophanes to see some nice results.

Creating a Bitmap project

In Lesson 3 you have already seen how you can create a bitmap project.
However the image used there was very simple, resulting in a relief with only
two Z-levels (black and white). We will now use a digital photo, resulting in a
much more detailed relief.

Next press button “Load Bitmap file” (or select that in the File menu)
to load the photo that you want to use. We downloaded the image
Meisje_met_de_parel.jpg (the name of the painting in Dutch) and before
loading it in DeskProto we reduced the resolution from the original 4095x4794
pixels to 1024x1199 pixels, later-on we will explain why. You can of course
use any photo that you like!

a In the File menu select “New Project” >> “New Bitmap Project”.
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A rough preview of the photo will be shown on the graphics screen. By
rotating the view you can check that it is a pure 2D picture: one flat surface at
constant Z-level. Only the color (gray value) of the pixels in the bitmap varies.
For Bitmap files DeskProto supports BMP, GIF, JPG, PNG and TIF files. Color
pictures are automatically converted to gray values (“black & white” pictures)
as for the conversion to Z-levels gray values are needed.

Bitmap Operation parameters

Next you need to set the DeskProto parameters, as always on two levels: in the
Part parameters you define the part, so what you want to machine, and in the
Operation parameters you define how you want to machine it. The Operation
parameters need to be set first, as for a bitmap these can affect the part size
(this will be explained below). Don’t worry if you get a warning that the part is
too large, we will fix that later.

So please now open the Bitmap Operation parameters. The most important
parameters are present on the first tab: General. For a lithophane you need a
small Cutter, or at least one with a small tip, so that the small details in the
image can be machined. We used a special cutter for this application: a
tapered cutter (conical shape) with a small ball tip. The small tip is needed for
the details, the ball shaped tip for a good surface quality, and the conical shape
allows to immediately machine at full depth (so without roughing layers).

We selected the tapered ball end cutter in the list of default cutters: “Tapered
D6 Angle5 TipBallD1 mm”, with a 1 mm tip radius (for inch users “Tapered
D1/4 Angle5 TipBallD0.04 inch™, tip radius 0.04”). Tapered cutter are offered
by many suppliers, it is easy to add the cutter that you have to DeskProto’s
library of cutters.

When you do not have such tapered cutter you can also use a small ballnose,
like a 2 mm diameter ballnose cutter. Depending on the cutting length of this
cutter it may then be needed to apply a roughing operation first.

We selected our tapered ball end mill and the set both the Distance between
the toolpaths and the Stepsize along the toolpath to 0.09 mm (D/65, ca 0.004”).
For our machine we left the Feedrate to it’s default value, and set the
Spindlespeed a bit higher because of the very small tip of the cutter.

Two more further settings in the bitmap operation are needed:

- on tab Area we selected “Use bitmap area”, as the material block that we
want to define (see below) is larger than the bitmap, and only the bitmap area
needs to be machined.

- on tab page Movement we set the Feedrate for high chiploads on 25%, in
order to protect the cutter during the first toolpath (machining at the full width
of the cutter).
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Part parameters (Bitmap settings)

Next open the Part parameters, and go to tab “XY Transform”. The options
shown are not the same as in a geometry project: these are the Bitmap settings.
As you can see in the image below our bitmap is sized 1024 x 1199 pixels,
which at 72 DPI (Dots per Inch) results in 14.22 x 16.66 inch, or 361 x 423
mm). Too large for our small machine, so DeskProto already displayed a Part
Size error, and in the tree two error icons are visible (this happens only in case
your machine is too small for this part).

DP Part Parameters - 'Part’ et

General XY Transform 7 Settings Material Ambient Zero-point Simulation

1. Bitmap dimensions 2. Panning
(®) Use DPI from bitmap file (72 DPI) % 0.0 e
(0 Use custom DPI 72 DPI v 0.0
(0 Calculate from precision on ¥ =1
pixel size : path distance, T .

using operation:

Bitmap operation (0. 10 mm) . i
- Bitmap resolution

O Custom X %: 1024 pixels (W)

¥ 1199 pixels (H)
Keep aspect ratio

Cancel Apply Help

For the size (Bitmap dimensions) you can select one of four options. Options
DPI from bitmap file, Custom DPI and Custom will be clear, just as the
checkbox “Keep aspect ratio” If not then please use the Help button for more
information. The two edit fields after Custom will show the resulting
dimensions, for any of the dimensioning options.

The option “Calculate from precision” needs some explanation: it delivers the
best results, however it is not easy to understand.

In DeskProto toolpaths are calculated using the Z-grid: a rectangular grid of
XY positions, with a Z-value for each grid-cell. The Precision (the Distance
between paths and the Stepsize along path, that we have just set to 0.09 mm)
sets the size of each grid cell. This Z-grid resembles the bitmap grid of pixels:
the bitmap grid also is a rectangular matrix of XY positions, now with a color-
value for each position.

The option “Calculate from precision” on scale 1 : 1 makes both grids equal:

Page 136



A

Tutorial Lesson 9 ,.

the bitmap will be scaled to make one pixel exactly match with one cell in the
Z-grid, The two grids thus are perfectly aligned. A different ratio can be chosen
to align both grids at a different interval. Aligning the grids is important to
prevent “Moire patterns’: when the grids are not aligned then (for instance)
after a series of 10 Z-grid cells with 4 pixels per cell, one cell with 5 pixels will
follow, repeating every 10 cells. This will cause visible “ripples” in the
resulting relief. Selecting option Calculate from precision (with a proper ratio
to achieve the desired size) will prevent this.

When using this option Calculate from precision you need to realize that when
you later change the precision, the size of the resulting relief will automatically
change as well ! This is why in this lesson the Operation parameters needed to
be set before the Part parameters.

For our portrait lithophane we used “Calculate from precision” and kept the
ratio to 1:1 (one pixel in one Z-grid cell, so each pixel sized 0.09 mm), which
made the Dimensions of the relief 94.5 x 110.7 mm (ca 4 x 4.5 inch).

Panning gives you the option to position the bitmap in 3D space. This will be
needed only when you combine a bitmap with a 3D geometry, for now you can
just leave it on O, 0.

On the third Tab page of the Bitmap settings, called “Z Settings” you can set
the Z-values to be used for the relief. The meaning of the fields Z-value for
White and Z-value for Black will be clear after the explanation in the first
paragraph of this lesson. Which Z-values need to be used of course depends
on the material that you want to use: some experimenting will be needed to
find out what material thicknesses will result in ‘black’ and ‘white’ when
illuminating your material from the back.

For our lithophane we used a sheet of 3 mm (0.12”) thick *Corian’ ® material.
We found that the material thickness for the resulting relief needs to be 0.5 mm
for white and 2.75 mm for black. So as Relief depth we entered -2.5 mm (-
0.1”) for white and -0.25 mm (-0,01") for black.

Finally the size of the Material block needs to be set. On tab Material you see
that the default option “Use all CAD data” has been selected. Change that to
Custom size, and enter the size of your material. We used a block of 120 x 140
mm, as said 3 mm thick.
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Converting 2D bitmap data to a 3D relief

The conversion is in fact very simple: each pixel has a gray value, which can
be black, white or some in-between shade of gray. This gray value will be
converted to a Z-value. You have just defined Z-levels for black and for white,
all in-between Z-levels will be calculated automatically. This is called
Gray-value to Z-height conversion.

At this point we can explain why we reduced the resolution of the original
image for this lithophane project. As said we now used a width of 1024 pixels,
and made the pixel size equal to the Precision (size of one Z-grid cell). The
first test that we machined was done using the original image (4095 pixels
wide), setting the size on “Calculate from precision” on 1:4, which resulted in
the same dimensions of the part.

Original image, with  First lithophane 1:4, Second lithophane
cracks in the paint thick black lines 1:1, much better.

The Vermeer painting is quite old (made in the 17th-century), and so the paint
is cracked (“Craquelure”) resulting in a pattern of very thin black lines over the
painting. In this first test for each Z-grid cell 16 pixels (4x4) were used. As
each Z-grid cell is filled with the highest Z-value found within, just one of
these 16 pixels being dark (the very thin crack) caused the complete Z-grid cell
to have a high Z and thus be dark in the lithophane. See the image above: the
crack lines that were very thin in the original image became much thicker in
the lithophane, making the result unacceptable. The next version used
“Calculate from precision on 1:1” and was much better.

The photo that you use will not be a painting so won’t display Cracquelure,
still for any photo a size on scale 1:1 will give the best result in the small
details. When you reduce the resolution of an image in a graphics program the
new pixel will get some intelligent average of the combined pixels as new
color value: better than the highest Z-level that DeskProto applies. Something
that we need to work on for a next DeskProto version....
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One of the first ideas that may come into mind for Gray-value to Z-height
conversion is to use a nice photo of your friend and convert that to a 3D relief
that resembles the 3D original. We have to disappoint you by explaining that
the result will not be great. Imagine for instance a frontal picture of a face, with
the sun shining from one side. One side of the nose will be light, the other side
will be dark (shadow). The resulting relief will not resemble the original nose.
Or image the difference between a white man with black hair and a black man
with white hair. The resulting relief may be OK for your application, however
do not expect it to be a copy of the real face. Lithophane reliefs will be fine
though.

To the milling machine

You now can calculate the toolpaths, write the NC file and send it to you
milling machine in order to mill the lithophane. The WorkPiece zero point is at
the left-front corner of the material block, at the top of the block, as is usual in
DeskProto.

A simulation is not very interesting for a lithophane, as the resulting relief
looks very strange (see below). It makes sense only when used as lithophane:
illuminated from the back side.

The image above shows how it looks on the DeskProto screen (for our Vermeer
painting). The block of material in orange, with the workpiece zero point in
blue. The green lines indicate the area to be machined, which is exactly the
bitmap size. Almost all toolpaths are hidden below the bitmap, only on the
front (bottom of the portrait) some red toolpath lines are visible.
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The resulting lithophane, in 3 mm thick white Corian. Beautiful !
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Relief and result

The actual relief that is machined for a lithophane looks very strange. The
above lithophane has been machined using exactly the same settings as used in
the previous paragraphs. The relief shows deep canyons (grooves) at the left,
which become white stripes in the two pullovers, and high mountains in the
faces for the dark eyes and dark areas in the mouth. Below the same sheet of
plastic is shown, now illuminated from behind. The photo results in a sharper
lithophane than the painting in the previous paragraph.

The photo that was used for this lithophane is a stock photo: portrait of a twin
brother and sister (source: Nationale Beeldbank / Gertjan Hooijer, 2009).

Page 141



Desk Proto Tutorial

Combining a bitmap with a 3D geometry

This subject will be covered only briefly, as most actions that are needed have
already been explained in this Tutorial. The objective of this last bitmap
example project is to create a perfume bottle (also used in lessons 5 and 8) with
a shell relief on the side of the bottle. Please do the following:

Start a New Geometry Project
Load the Sample geometry Bottle.stl (or Bottle_inch.stl)
(the samples can be easily found via the Start Screen)
Load the Sample bitmap file Shell1.jpg
Part parameters, geometry settings:

Rotate the bottle -90 degrees round X

Set the Material block to Use upper half of geometry.

The image above should be similar to what you now see on your screen. Next
step is to correctly scale and position the shell image. That will be easiest when
you select a top-view (press the first of the series of cube icons in the toolbar).
Now again open the Part parameters, and select the Bitmap settings. Open tab
page XY Transform to scale and position the bitmap.

To set the bitmap dimensions the option “Calculate from precision” that we
used for the lithophane) is not enabled: no bitmap operation is present and thus
the precision is not yet available. So you can use either a Custom DPI or a
custom size. We applied a custom size of 34 mm for X, resulting in 30.75 mm
for Y (in inches 1.3” resp 1.1759”). Press Apply to see the result.

For the bitmap position the panning values need to be set. We started with the
“Align to...” button: select Center twice, and align with Geometry data. Press
OK, and next again press Apply to see the result. For X the position is OK, for
Y it is not: the panning value for Y of 31.70 (1.2654”) is too high. Change it as
you like, pressing Apply to see the result. We used 22.0 (0.95”) to continue.
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Proceed to tab page Z-settings to define the relief height. We want to create a
positive relief: added on top of the bottle’s front surface. So as Z-value for
black we set 0.0 (nothing to be added for the pure black background of the
image), and as Z-value for white we set 1.5 mm (0.06”). Finally the option
“Project bitmap relief on 3D part geometry” on this tab page needs to be
checked. When you now close a Part Parameters a message will pop up to
warn you that positive Z values are used for the bitmap relief. We will come
back on this later.

When you now calculate the toolpaths you will see that only the bottle is
machined: no shell relief is present. Reason is that in this project only a
Geometry Operation is present, where we need a Bitmap Operation. So add a
Bitmap operation and again calculate toolpaths. Now the shell relief will
indeed be visible. So in fact it would have been easier to start this lesson with
creating a “New Bitmap project” instead of a new Geometry project. Still for
this Tutorial it is important that you learn about the difference. The Geometry
operation may not be used as it would remove all material needed for the shell
relief (for a negative relief this would not be a problem).

You now see toolpaths for both operations. In most cases the default settings
for a Geometry operation and for a Bitmap operation are equal, and thus most
of the toolpaths will overlap. One difference is the shell relief, and a second
difference is that the bitmap operation will machine a smaller area: the
shoulders, top and bottom of the bottle are not machined. Fix this by changing
the Borders settings in the Bitmap operation parameters: instead of “No extra”
(which is OK when machining only the bitmap) you now need to select “Extra
for cutter” in order to machine the complete bottle. Now the only difference is
the shell relief. You can now delete the Geometry operation (right mouse click
on it’s line in the tree and select Remove).

One more important problem needs to be fixed: the top of the relief is missing,
see the above screenshot (the bitmap has been deselected in the Item visible
dialog). This is what the warning that DeskProto just gave you was about. As
Material block we have set the “Upper half of geometry”, however on top of
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the geometry we have added a relief (positive Z-values). As a result the part
now is higher than the block of material, and all toolpaths outside the material
have been skipped. To fix this problem open the Part parameters, tab Material,
and change the selected size from “Use upper half of geometry” to ”"Custom
boundaries”. Now make the value for the maximum Z 1 or 1.5 mm higher (1
mm or 0.04” is sufficient, as the relief is not projected on the highest part of the
geometry).

The part to be machined now has been defined, and you can proceed and select
the operation parameters that you need: cutter, precision, strategy, etc. You also
can decide either to use one operation or to use Roughing and Finishing.
Remember that in all cases you need to use Bitmap operations.
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This last picture shows a simulation of the machined bottle.
Meant for a perfume that will surround you with the scent of a fresh sea
breeze...
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10: Dice (five-axis machining)
Lesson Ten

The Multi-Axis edition of DeskProto can generate toolpaths for Five-Axis
machining. This is quite complicated matter though, and it involves much more
work than using the fourth axis (which was covered in Lesson 6).

For five-axis jobs DeskProto offers indexed machining: machine from one side
using three-axis machining (X, Y and Z), then rotate A and B to a next
orientation, again complete a three-axis operation, and so on. The number of
orientations and their rotations may be freely chosen.

The geometry used for this lesson is a partial die, as one of the six sides is
missing. The geometry files Die-5axisVideo.stl and Die-5axisVideo_inch.stl are
present in the DeskProto Samples folder, just as the two project files for this
die: Die-5axis.dpj and Die-5axis_inch.dpj On the DeskProto website you can
also find a tutorial video that explains this project.

It will be clear that this lesson cannot be applied by users of the Free edition,
the Entry edition or the Expert edition.
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Five-Axis CNC milling machines

What makes five-axis machining difficult is the fact that so many different
configurations of these 5 axes are possible. Machines are available for many of
these configurations as well.

The theory is simple: a five-axis machine has three linear axes, called X, Y and
Z, and also two of the three possible rotation axes, which are A (rotation
around X), B (rotation round Y) and C (rotation round Z). So only three
combinations are possible: XYZAB, XYZAC and XYZBC.

90 degrees rotation of the part. 90 degrees rotation of the cutter.
The rotations however can be applied in two ways: the orientation of the
cutting tool can rotate or the part can rotate. For a linear movement it does
not matter whether the part moves or the cutter, for rotation it makes a big
difference.

In addition the sequence matters: a (linear) X-axis built on top of an Y-axis will
give the same results as Y on top of X, the results however for an A-axis built
on top of a B-axis will be completely different from when B is built on A.

The DeskProto Five-Axis option is meant for machines where the material
block rotates and the cutter orientation remains vertical. Only rotation axes
A (rotation round X) and B (rotation round Y) are supported. Such machines
are called Trunnion-style 5-axis machines. So machines where the cutter can
be tilted (swivel head) are not supported.

It is also needed that the A and B rotation axes intersect, so that they have a
common point: the center of rotation for both axes.

Rotation commands are used to make a different side of the geometry face
upwards, and for that side plain XYZ machining is used. For each side in
DeskProto a new Part is made, with the rotations set in the Part parameters
(rotate round X and Y). The A and B rotation commands written in the NC file
need to achieve the same rotation on the machine.
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Distance between rotation axis and geometry

A next detail to be considered is the location of the two actual rotation axes (so
the center of rotation). That is important as it determines the position of the
geometry after the rotation.

5-Axis achine 1 (Roland DWX-50, 5-Ais machine 2 Isel Iéuromod 45
for dental applications). with DSH-S rotation axis).

You can imagine the different behavior of the two machines shown above.

The machine on the left has it's rotation center in the centerpoint of the
material block (a round disk of material, to machine dental crowns). So a
rotation will not change the location of the centerpoint of this block.

The machine on the right has it's rotation center (far) below the block of
material. It is even below the working table of the vertical rotation axis (so the
cutter may never go there). A 90 degree rotation of the horizontal axis will
change the position of the block in the machine's working area.

It is of course very important that in DeskProto this same center of rotation is
used for the part rotations: the toolpaths need to match the block’s new
position. The center of rotation that DeskProto uses is the zero point of the
CAD data that have been loaded. This means that DeskProto will rotate around
the three main axes (XYZ) as present in the STL-data. You can show this CAD
zero point on the DeskProto screen by checking “Untranslated zero-point” in
the Items visible dialog.

For the above machine on the left this will be easy: the CAD zero point will
also have been set in the centerpoint of the material block. However, for the
machine on the right the CAD zero point will not match the machine’s zero
point. You cannot use the translation option in the Part parameters to fix this, as
that translation is applied after the rotation.

The trick that DeskProto offers to solve this is to translate the CAD data when
loading the STL file. This can be done in the Project parameters. Button
“Transform...” on tab Geometry will open the Geometry Transformation
dialog. Here you can set all transformations to be applied when loading the
geometry data. Each STL file can have its own set of transformations.
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l25.0f

73.00
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This drawing shows the two rotation axes of the machine that was mentioned
on the previous page (the image on the right). The distance between the point
of rotation and the clamping plane of the machine vise (in the orientation as
shown this is a vertical distance) is 73 mm. The CAD zero point of the die is in
the center of the die: 25 mm above its base. To make sure that the cutter won’t
his the vise an extra margin of 7 mm is added. This make the distance between
the CAD zero point and the machine’s zero point 105 mm (73 + 25 + 7).

W) Geometry Transformation d

Transformations only for this geometry file. Can be used to position the contents
of this file relative to all other CAD data.

1. Scale 2. Mirror
X [ 1n ¥-Z plane (invert x)
¥ 10 [ 1n%-Z plane (invert ¥)
Z10 [ 1n X-¥ plane (invert 2)
Uniform
(@) Scale factors

() Dimensions {mm)

3. Rotation

Preview Cancel Help

This means that the zero points needs to be translated 105 mm along Z when
loading the CAD data. As just said this can be done in the Geometry
Transformation dialog.

This is of course just an example: if such translation is needed it will be a
different value for any other machine. For inches the calculation is the same.

4. Translation
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For the actual 5-axis project it is imperative to set the Translation to None for
all three axes (Part parameters, tab Zero-point). Otherwise the DeskProto
translation will invalidate the positions that just had been carefully arranged.

The image above shows the result: the zero point (so the center of rotation) is
located on the correct position. As the Translation has been set to None the
positions of the blue orientator (Workpiece zero point) and the gray orientator
(Untranslated zero point) are identical, making the gray cube invisible.

As a result now the rotations done in DeskProto and done on the machine will
have exactly the same effect, and the toolpaths will be executed at the correct
location.

Configuration of the two rotation axes

Finally you need to check the configuration of the axes on your machine, and
also the orientation that is present on your machine for a rotation angle of 0.0
degrees. The result of course needs to match what you see in DeskProto.

DeskProto follows the 1SO standard that the A-axis is parallel to (rotates
around) X, and the B-axis rotates around Y. On some machines this is the other
way round.

The rotations in the DeskProto Part parameters are done in the order XYZ:
first the rotation round X is applied, then the rotation round Y.

This matches machines with a B-axis built on top of the A-axis: the Part
parameter rotation round X will be used for the A-axis rotation and the part
rotation round Y will be used for the B rotation. The B-rotation then also will
be applied “on top of” the A-rotation.
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For the Roland machine shown on the previous page (left image) the rotation
values in DeskProto and on the machine are the same: zero degrees rotation for
X and'Y matches zero degrees for A and B.

Other machines may have different rotary axis zero positions. You may need
to experiment to find the correct A and B rotation values to match the rotations
round X and Y as set in the Part Parameters. This is for instance true for the
Isel machine shown on the previous page, where a rotation of 0.0 degrees for
the main rotation axis gives the second axis a vertical orientation. So this
machine needs a 90 degree command on the main axis to match the 0.0 degree
position in the DeskProto Part parameters.

Rotation direction of the two axes

Just as with 4-axis machining you will need to check the Rotation direction of
your rotation axes: will they rotate clockwise or counterclockwise for positive
values of A and B. We have found that no clear standard direction exists: each
manufacturer makes his own choice. If your machine and DeskProto rotate in
opposite directions you can correct this in the DeskProto postprocessor:
Options > Library of postprocessors > OK on warning > select your post and
press Edit > Tab Movement > add a minus sign to the value in edit box
“Factor” in column A and/or column B.

Defining the A and B rotation commands

As said before, in DeskProto the rotations of the geometry are set in the Part
parameters (transform tab): rotations round X and round Y.

In addition rotation commands need to be defined for the NC program file, to
make the 5-axis machine perform the same rotations. This can be done in the
Start/End settings for each Operation: Operation parameters, tab Advanced,
button Settings for Start/End.

See the illustration below.
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D Operation Start/End Settings X

Before operation commands After operation commands
[ user defined
Move Z-axis to  |150.0 mm [ ] Rapid Move Z-axisto  |150 mm [ ] Rapid
Move Y-axis to mm  [] Rapid Move Y-axisto | 100 mm  [] Rapid
Move X-axis to D mm [ Rapid Move X-axis to EI mm  [] Rapid

[ user defined

Move A-axis to  |0.0 degr. [] Rapid [ Move A-axis to degr. Rapid
Move B-axis to degr. [] Rapid [] Move B-axis to degr, | | Rapid
[ User defined [ User defined

WARNING:

You need to be very careful here, these extra movements may damage your part, cutter and for machine.

Cancel Help

Here a series of commands can be defined to be added to the NC file at the
start of the operation (the before commands), and a series to be added at the
end (the after commands). In the illustration above, at the start of the operation
the A-axis is moved to 0.0 degrees, and the B-axis to 90.00 degrees. At the end
of the operation no rotations are set: that will be done in the next operation.

Very important is that values are entered for X, Y and Z to send the cutter to a
safety retract position before the rotations start. For many machines this is
absolutely needed to prevent a collision between the rotation axis hardware and
the cutter. Such collision will damage your part, and perhaps also the cutter
and/or the machine. So take care !

The commands in this dialog are executed in the order as shown in the dialog:
so first the Z-axis will moves (up), then Y will move, next X, and finally the
rotations will be done.

Movement commands for A and B can be entered only in case the machine
definition used for this part indeed has these two axes defined (button
“Rotation axes...”). If not then these fields will have been grayed out.

Chaining the operations

Finally all operations (from several parts) can be combined in one Chain,
allowing the export of one combined NC program file. Chaining can be done
on the Chaining tab of the Project parameters, see the illustration below.
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ne Project Parameters - 'Die-5axis’ X
General Vector Geometry Bitmap Chaining  Advanced

Create Remove

Chain  |Chain 1 w

Unchained operations Chained operations

L. (Side 1 (AD B0)) -> Geometry operat
Lo (Side 2 (AD B90)) -> Geometry opera
Za (Side 3 (AS0 BSD)) -» Geometry oper
da (Side 5 (A180 B30)) -> Geometry ope
Zee (Side 4 (A270 BOD)) -> Geometry ope

Cancel Apply Help

The illustration shows this dialog for sample project Die-5axis.dpj

You can see that one chain is used, containing all (five) operations. They have
been added to the chain using the arrow buttons in the center of the dialog
(these buttons are activated after creating a chain). For more information about
the use of this dialog please use the Help button.

In this sample project you can also check all other settings:

- five parts, one for each side, with appropriate rotation values.

- the Start/End commands that have been used for each operation.

- the material block and the area to be machined for all parts and all operations
- for the circular strategy the custom Center needed to be set for each operation
Be careful when using the NC data generated by this project on your machine:
as said for your machine the settings may need to be completely different.

Anyway: the result of your own project should be one or more NC files that
can be sent to your 5-axis machine. The file(s) will make the machine do the
complete job: orient the part, machine one side, rotate to the next orientation,
machine, and so on. You can of course also use Roughing and Finishing
operations.

When more than one cutter is used, then for a machine with an Automatic Tool
Changer (ATC) the result will be one NC file, for other machines several files
will be written (a new file after each toolchange).
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DeskProto's Five Axis Sample project

The theory in the preceding paragraphs will now be illustrated by some
pictures from the real world. These pictures were made by DeskProto user
Robert Zeinecker from Germany, on his Isel Euromod 45 machine with Isel
DSH-S rotation axis: thanks !

Below we will illustrate the steps in this process.

The first step was to very accurately set the WorkPiece zero point: with the tip
of the cutter on the exact spot where the A-axis and the B-axis intersect. This
lesson does not show how this is done. You can measure using a gauge, as
shown in the photo. Or you can for instance machine a sample cylinder with a
roughly set zero point, measure the result and then correct the zero point to
make it exact.

On the rotation table a vise has been used, the height of this vise was also
accurately measured: The result was used to calculate the translation when
loading the STL data, as described above. Note that a small distance (between
zero point and base plane) is best: the larger the distance, the more any
deviation in the zero point will be visible in the result.

The configuration of the two rotation axes on this machine is not standard.
The long axis is the B-axis, which on this machine is parallel to X. The round
platform that can rotate is the A-axis: in the orientation as shown (B=0) it is
parallel to Z (so should in fact be called C-axis).

A B-rotation of 90 degrees will make this axis parallel to Y. The machine then
indeed has an A-axis and a B-axis, only these two have been switched
(compared to DeskProto and to standard conventions).
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The photo above shows the first part ("Top”), the only part with the B-axis at 0
degrees. The blue cube is a PS foam block, clamped in a black machine vise.

Some experiments were needed to find out which rotations in DeskProto
matched which rotations on the machine. For this machine it was needed to
reverse the rotation direction for both A and B, as you can see in the table
below. As the two axes on the machine have been switched, the X part
rotations in DeskProto relate to the B-rotations for the machine. The result was
that the following five combinations of rotation values have been used:

in DeskProto on machine:
Part Top X0.0,Y0.0 A0.0,B0.0
Part Front X-90.0, YO0.0 A0.0,B90.0
Part Left X-90.0, Y 90.0 A-90.0,B90.0
Part Back X-90.0, Y 180.0 A-180.0,B90.0
Part Right X-90.0, Y 270.0 A-270.0,B90.0

The rotation values for DeskProto have been set as Rotations in the Part
parameters for the five parts, the values for the machine as “Move-to” Start
commands in the Operation parameters. Here also movement commands for Z
and for Y have been used to move the cutter to a Safety retraction point
before rotating.

As said, the Translation has been set to None for all axes in all parts.

And finally Chaining has been used to connect all operations to one combined
NC program file.

Important to repeat: the rotation values shown are for the machine used in this
project: for your machine different values will be needed !
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The pictures above show: the milling of sides one (Top), of side three (Left),
and the result when all five sides have been completed. Look at the three green
“orientator” cubes for the three axis directions in these pictures.
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Note 1: Reversing the rotation direction can also be achieved in the
postprocessor (Tab Movement, make field “Factor” negative for that axis).

Note 2: Creating a five-axis project is quite complicated and also error-prone
(it is easy to forget one of the settings or make a typing error). It may be handy
to create a Template project (project without geometry) for five-axis
machining on your machine. That project should contain all rotation settings,
start-commands, end-commands and Chaining, but no geometry and no
settings for the material block and the areas to be machined. Then for five-axis
machining you can open the template project, load a geometry and save the
project under a new name.

A Five Axis Sample car model

The cube project as described in the previous paragraph was just meant as a
teaching help. Once you have mastered this project and have configured
DeskProto to work with your five-axis machine, you can of course start with a
real project.

So did Robert Zeinecker, and he machined a great car model: an Austin Healey.
Below you can see a few pictures: more can be found on the DeskProto
Gallery at www.deskproto.com (section scale models). Including a video that
shows the actual machining process.

The car body geometry in CAD.
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And the same toolpaths on the machine.
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,m____.._'..mg .

It is also possible to use angles other than 90 degrees, as shown above for
detailing the dashboard of the car model.
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The resulting model, after finishing all sides. Here indeed five-axis machining
was needed to create this superb car model.
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